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Notice
While reasonable efforts have been made to assure the accuracy of this document, Motorola, Inc. assumes no liability resulting
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right to revise this document and to make changes from time to time in content hereof with no obligation to notify any person
of revisions or changes. Motorola, Inc. does not assume any liability arising out of the application or use of any product,
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directly or by implication, estoppel, or otherwise, any license under the copyrights, patents or patent applications of
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Foreword

Scope of manual

This manual is intended for use by cellular telephone system
craftspersons in the day-to-day operation of Motorola cellular system
equipment and ancillary devices. It is assumed that the user of this
information has a general understanding of telephony, as used in the
operation of the Public Switched Telephone Network (PSTN), and is
familiar with these concepts as they are applied in the cellular
mobile/portable radiotelephone environment. The user, however, is not
expected to have any detailed technical knowledge of the internal
operation of the equipment.

This manual is not intended to replace the system and equipment
training offered by Motorola, although it can be used to supplement or
enhance the knowledge gained through such training.

Text conventions

The following special paragraphs are used in this manual to point out
information that must be read. This information may be set-off from the
surrounding text, but is always preceded by a bold title in capital letters.
The three categories of these special paragraphs are:

NOTE Presents additional, helpful, non-critical information that you can
use.
Bold-text notes indicate information to help you avoid an
undesirable situation or provides additional information to
help you understand a topic or concept.

CAUTION Presents information to identify a situation in which equipment
damage could occur, thus avoiding damage to equipment.

WARNING Presents information to warn you of a potentially hazardous
situation in which there is a possibility of personal injury.
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The following typographical conventions are used for the presentation of
software information:

� In text, sans serif BOLDFACE CAPITAL characters (a type style
without angular strokes: i.e., SERIF versus SANS SERIF) are used to
name a command.

� In text, typewriter  style characters represent prompts and the
system output as displayed on an operator terminal or printer.

� In command definitions, sans serif boldface characters represent those
parts of the command string that must be entered exactly as shown and
typewriter  style characters represent command output responses
as displayed on an operator terminal or printer.

� In the command format of the command definition, typewriter
style characters represent the command parameters.

Changes to manual

Changes that occur after the printing date are incorporated into your
manual by Cellular Manual Revisions (CMRs). The information in this
manual is updated, as required, by a CMR when new options and
procedures become available for general use or when engineering
changes occur. The cover sheet(s) that accompany each CMR should be
retained for future reference. Refer to the Revision History page for a list
of all applicable CMRs contained in this manual.

Receiving updates

Technical Information Products and Services (TIPS) maintains a
customer database that reflects the type and number of manuals ordered
or shipped since the original delivery of your Motorola equipment. Also
identified in this database is a “key” individual (such as Documentation
Coordinator or Facility Librarian) designated to receive manual updates
from TIPS as they are released.

To ensure that your facility receives updates to your manuals, it is
important that the information in our database is correct and up-to-date.
Therefore, if you have corrections or wish to make changes to the
information in our database (i.e., to assign a new “key” individual),
please contact Technical Information Products and Services.

MOTOROLA, INC.
Technical Information Products and Services

Phone: 
Within U.S.A. and Canada  800-872-8225. . . . . 
Outside of U.S.A. and Canada  +1-847-435-5700. . 
FAX:   +1-847-435-5541. . . . . . . . . . . . . . . . . . . . . . 

Reporting manual errors

In the event that you locate an error or identify a deficiency in your
manual, please take time to write to us at the address above. Be sure to
include your name and address, the complete manual title and part
number (located on the manual spine, cover, or title page), the page
number (found at the bottom of each page) where the error is located,
and any comments you may have regarding what you have found. We
appreciate any comments from the users of our manuals.
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24-hour support service

If you have any questions or concerns regarding the operation of your
equipment, please contact the Customer Network Resolution Center for
immediate assistance. The 24 hour telephone numbers are:

Arlington Heights, IL 800-433-5202. . . . . . . . . . 
Arlington Heights, International +1-847-632-5390. . 
Cork, Ireland 44-1793-565444. . . . . . . . . . . . . . . . . 
Swindon, England 44-1793-565444. . . . . . . . . . . . . 
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FCC Requirements

Content

This section presents Federal Communications Commission (FCC)
Rules Parts 15 and 68 requirements and compliance information for the
SC�4812T/ET/ET Lite series Radio Frequency Base Transceiver
Stations.

FCC Part 15 Requirements

Part 15.19a(3) - INFORMATION TO USER

NOTE This device complies with Part 15 of the FCC Rules. Operation
is subject to the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including
interference that may cause undesired operation.

Part 15.21 - INFORMATION TO USER

CAUTION Changes or modifications not expressly approved by Motorola
could void your authority to operate the equipment.

15.105(b) - INFORMATION TO USER

NOTE This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment
OFF and ON, the user is encouraged to try to correct the
interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

- Consult the dealer or an experienced radio/TV technician for
help.
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FCC Part 68 Requirements

This equipment complies with Part 68 of the Federal Communications
Commission (FCC) Rules. A label on the GLI3 board, easily visible
with the board removed, contains the FCC Registration Number for this
equipment in the format < US: IHEXDNANGLI3-1X>. If requested,
this information must be provided to the telephone company.

FCC Part 68 Registered Devices

Device FCC Part 68 ID

Group Line Interface (GLI3) * US: IHEXDNANGLI3-1X

Cisco Model 1900-27 US: 5B1DDNDN0006

ADC KENTROX Model 537 US: F81USA-31217-DE-N

* NOTE: The BTS equipment is always equipped with the GLI3, < US:
IHEXDNANGLI3-1X>, and may be used in conjunction with one or
both of the listed registered CSU devices, or another registered CSU
device not listed above.

The telephone company may make changes in its facilities, equipment,
operations, or procedures that could affect the operation of your T1. If
this happens, the telephone company will provide advance notice so that
you can modify your equipment as required to maintain uninterrupted
service.

If this equipment causes harm to the telephone network, the telephone
company will notify you in advance that temporary discontinuance of
service may be required. If advance notice is not practical, the telephone
company will notify you as soon as possible. Also, you will be advised
of your right to file a complaint with the FCC if you believe it is
necessary.

If you experience trouble operating this equipment with the T1, please
contact:

Global Customer Network Resolution Center (CNRC)
1501 W. Shure Drive, 3436N
Arlington Heights, Illinois 60004
Phone Number: (847) 632-5390

for repair and/or warranty information. You should not attempt to repair
this equipment yourself. This equipment contains no customer or
user-serviceable parts.

Changes or modifications not expressly approved by Motorola could
void your authority to operate this equipment.
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General Safety
Remember! . . . Safety
depends on you!!

The following general safety precautions must be observed during all
phases of operation, service, and repair of the equipment described in
this manual. Failure to comply with these precautions or with specific
warnings elsewhere in this manual violates safety standards of design,
manufacture, and intended use of the equipment. Motorola, Inc. assumes
no liability for the customer’s failure to comply with these requirements.
The safety precautions listed below represent warnings of certain dangers
of which we are aware. You, as the user of this product, should follow
these warnings and all other safety precautions necessary for the safe
operation of the equipment in your operating environment.

Ground the instrument

To minimize shock hazard, the equipment chassis and enclosure must be
connected to an electrical ground. If the equipment is supplied with a
three-conductor ac power cable, the power cable must be either plugged
into an approved three-contact electrical outlet or used with a
three-contact to two-contact adapter. The three-contact to two-contact
adapter must have the grounding wire (green) firmly connected to an
electrical ground (safety ground) at the power outlet. The power jack and
mating plug of the power cable must meet International Electrotechnical
Commission (IEC) safety standards.

Do not operate in an explosive
atmosphere

Do not operate the equipment in the presence of flammable gases or
fumes. Operation of any electrical equipment in such an environment
constitutes a definite safety hazard.

Keep away from live circuits

Operating personnel must:

� not remove equipment covers. Only Factory Authorized Service
Personnel or other qualified maintenance personnel may remove
equipment covers for internal subassembly, or component
replacement, or any internal adjustment.

� not replace components with power cable connected. Under certain
conditions, dangerous voltages may exist even with the power cable
removed.

� always disconnect power and discharge circuits before touching them.

Do not service or adjust alone

Do not attempt internal service or adjustment, unless another person,
capable of rendering first aid and resuscitation, is present.

Do not substitute parts or
modify equipment

Because of the danger of introducing additional hazards, do not install
substitute parts or perform any unauthorized modification of equipment.
Contact Motorola Warranty and Repair for service and repair to ensure
that safety features are maintained.
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Dangerous procedure
warnings

Warnings, such as the example below, precede potentially dangerous
procedures throughout this manual. Instructions contained in the
warnings must be followed. You should also employ all other safety
precautions that you deem necessary for the operation of the equipment
in your operating environment.

WARNING Dangerous voltages, capable of causing death, are present in this
equipment. Use extreme caution when handling, testing, and
adjusting.
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Revision History

Manual Number

68P09255A61- 4

Manual Title

1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x 

Version Information

The following table lists the manual version, date of version, and
remarks on the version. Revision bars printed in page margins (as shown
to the side) identify material which has changed from the previous
release of this publication.

Version
Level

Date of Issue Remarks

1 Mar 2002 DRAFT Manual submitted for engineering markup

2 Apr 2002 PRELIMINARY

3 Jul 2002 DV&V REVIEW

4 Aug 2002 PRELIMINARY: Incorporate comments from DV&V and engineering.
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Patent Notification
Patent numbers

This product is manufactured and/or operated under one or more of the
following patents and other patents pending:

4128740 4661790 4860281 5036515 5119508 5204876 5247544 5301353
4193036 4667172 4866710 5036531 5121414 5204977 5251233 5301365
4237534 4672657 4870686 5038399 5123014 5207491 5255292 5303240
4268722 4694484 4872204 5040127 5127040 5210771 5257398 5303289
4282493 4696027 4873683 5041699 5127100 5212815 5259021 5303407
4301531 4704734 4876740 5047762 5128959 5212826 5261119 5305468
4302845 4709344 4881082 5048116 5130663 5214675 5263047 5307022
4312074 4710724 4885553 5055800 5133010 5214774 5263052 5307512
4350958 4726050 4887050 5055802 5140286 5216692 5263055 5309443
4354248 4729531 4887265 5058136 5142551 5218630 5265122 5309503
4367443 4737978 4893327 5060227 5142696 5220936 5268933 5311143
4369516 4742514 4896361 5060265 5144644 5222078 5271042 5311176
4369520 4751725 4910470 5065408 5146609 5222123 5274844 5311571
4369522 4754450 4914696 5067139 5146610 5222141 5274845 5313489
4375622 4764737 4918732 5068625 5152007 5222251 5276685 5319712
4485486 4764849 4941203 5070310 5155448 5224121 5276707 5321705
4491972 4775998 4945570 5073909 5157693 5224122 5276906 5321737
4517561 4775999 4956854 5073971 5159283 5226058 5276907 5323391
4519096 4797947 4970475 5075651 5159593 5228029 5276911 5325394
4549311 4799253 4972355 5077532 5159608 5230007 5276913 5327575
4550426 4802236 4972432 5077741 5170392 5233633 5276915 5329547
4564821 4803726 4979207 5077757 5170485 5235612 5278871 5329635
4573017 4811377 4984219 5081641 5170492 5235614 5280630 5339337
4581602 4811380 4984290 5083304 5182749 5239294 5285447 D337328
4590473 4811404 4992753 5090051 5184349 5239675 5287544 D342249
4591851 4817157 4998289 5093632 5185739 5241545 5287556 D342250
4616314 4827507 5020076 5095500 5187809 5241548 5289505 D347004
4636791 4829543 5021801 5105435 5187811 5241650 5291475 D349689
4644351 4833701 5022054 5111454 5193102 5241688 5295136 RE31814
4646038 4837800 5023900 5111478 5195108 5243653 5297161
4649543 4843633 5028885 5113400 5200655 5245611 5299228
4654655 4847869 5030793 5117441 5203010 5245629 5301056
4654867 4852090 5031193 5119040 5204874 5245634 5301188
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Chapter 1

Introduction
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Optimization Manual: Scope and Layout

Scope of This Document

This document provides information pertaining to the optimization and
audit tests of Motorola SC 4812T Base Transceiver Subsystem (BTS)
equipment frames equipped with trunked high-power Linear Power
Amplifiers (LPAs) and their associated internal and external interfaces.

This document assumes the following prerequisites:

� The BTS frames and cabling have been installed per the BTS Frame
Installation manual, which covers the physical “bolt down” of all SC
series equipment frames, and the SC 4812T CDMA BTS Installation
manual, which covers BTS specific cabling configurations.

In most applications the same test procedure is used for all equipment
variations. However, decision break points are provided throughout the
procedure when equipment specific tests are required.

NOTE As the Code Division Multiple Access (CDMA) Local
Maintenance Facility (LMF) capability comes on-line,
applicable LMF based procedures will be incorporated.
Eventually, only the CDMA LMF platform will be supported as
the recommended customer method of interfacing with and
servicing the SC series BTS equipment.

We at Motorola Technical Education & Documentation have strived to
incorporate into this document the many suggestions and inputs received
from you, the customer, since the inception of the SC product line. At
the same time, we have tried to insure that the scope of the document
targets both the novice and expert site technician and engineer with
the information required to successfully perform the task at hand. If
in some areas, the manual seems to cover the test in too much detail (or
not enough detail) we hope you will keep this in mind.

1
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Document Composition

This document covers the following major areas.

� Introduction, consisting of preliminary background information (such
as component and subassembly locations and frame layouts) to be
considered by the Cellular Field Engineer (CFE) before optimization
or tests are performed.

� Preliminary Operations, consisting of pre-power up tests, jumper
configuration of BTS sub-assemblies, and initial application of power
to the BTS equipment frames. Download of all BTS processor boards,
and LPAs.

� Optimization/Calibration, consisting of downloading all BTS
processor boards, LPA verification, radio frequency (RF) path
verification, Bay Level Offset (BLO) calibration, and Radio
Frequency Diagnostic System (RFDS) functions and calibration

� Acceptance Test Procedures (ATP), consisting of automated ATP
scripts executed by the LMF and used to verify all major transmit
(TX) and receive (RX) performance characteristics on all BTS
equipment. Also generates an ATP report.

� Optional manual performance tests used to verify specific areas of site
operation or to verify regulation compliance. These tests are typically
used to isolate faults down to the module level and information
necessary to better understand equipment operation.

� Site turnover after ATP is completed.

� Appendices that contain pertinent data sheets that are filled out
manually by the CFE at the site, Pseudorandom Noise (PN) Offset
information, an optimization/ATP matrix , output power data tables,
CDMA operating frequency programming information, manual test
setup information, procedures for verifying that the Voltage Standing
Wave Ratio (VSWR) of all antennas and associated feed lines fall
within acceptable limits, procedures for downloading ROM and RAM
code, and procedures for performing in-service ATP.

1
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CDMA LMF Product Description

The CDMA LMF is a graphical user interface (GUI) based LMF. This
product is specifically designed to provide cellular communications field
personnel the vehicle to support the following CDMA BTS operations:

� Installation

� Maintenance

� Calibration

� Optimization

Graphical User Interface Overview

The LMF uses a GUI, which works in the following way:

� Select the device or devices.

� Select the action to apply to the selected device(s).

� While action is in progress, a status report window displays the action
taking place and other status information.

� The status report window indicates when the action is complete and
displays other pertinent information.

� Clicking the OK button closes the status report window.

Command Line Interface Overview

The LMF also provides Command Line Interface (CLI) capability.
Activate the CLI by clicking on a shortcut icon on the desktop. The CLI
cannot be launched from the GUI, only from the desktop icon.

Refer to the LMF CLI Commands, R15.x manual for a complete
explanation of the CLI commands and their use.

Online Help

Task oriented online help is available in the CDMA LMF by clicking on
Help from the menu bar.

1
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Purpose of the Optimization

Why Optimize?
Proper optimization and calibration assures:

� Accurate downlink RF power levels are transmitted from the site.

� Accurate uplink signal strength determinations are made by the site.

What Is Optimization?
Optimization compensates for the site-specific cabling and normal
equipment variations. Cables that interconnect the BTS and Duplexer
assemblies (if used), for example, are cut and installed at the time of the
BTS frame installation at the site. Site optimization guarantees that the
combined losses of the new cables and the gain/loss characteristics and
built-in tolerances of each BTS frame do not accumulate, causing
improper site operation.

Optimization identifies the accumulated loss (or gain) for all receive and
transmit paths at the BTS site, and stores that value in a database.

� The RX path for the starter frame starts at the ancillary equipment
frame RFDS RX directional coupler antenna feedline port, through the
ancillary equipment frame RFDS RX directional coupler antenna
feedline port, through the RX input port on the top of the frame,
through the bandpass filter, Combiner Input/Output (CIO) card,
Multicoupler Preselector Card (MPC), and additional splitter circuitry,
ending at a CDMA Channel Processor (C-CCP) backplane Broad
Band Transceiver (BBX) slot in the C-CCP shelf.

NOTE In this manual, all version of the BBX, MCC, and GLI usable in
this BTS are generically identified as BBX, MCC, or GLI unless
otherwise specified.

� The RX path for the expansion frame starts at the ancillary equipment
frame RFDS RX directional coupler antenna feedline port, through the
ancillary equipment frame RFDS RX directional coupler antenna
feedline port, through the RX input port on the top of the starter
frame, through the bandpass filter and CIO card, out the expansion
port at the top of the starter frame, through the expansion cable to the
expansion port on the expansion frame, through the Expansion
Multicoupler Preselector Card (EMPC) and CIO, ending at a BBX slot
in the C-CCP shelf.

� The TX path starts at the BBX, through the C-CCP backplane slot,
travels through the LPA/Combiner TX Filter and ends at the top of the
RFDS TX directional coupler antenna feedline port (CDMA), installed
on the ancillary equipment frame.  If the RFDS option is added, then
the TX path continues and ends at the top of the RFDS TX directional
coupler antenna feedline port installed in the ancillary equipment
frame.  The TX paths are identical for the starter and expansion
frames.

These values are factored in by the BTS equipment internally, leaving
only site specific antenna feed line loss and antenna gain characteristics
to be factored in by the CFE when determining site Effective Radiated
Power (ERP) output power requirements.

1
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Each C-CCP shelf BBX board is optimized to a specific RX and TX
antenna port. (One BBX board acts in a redundant capacity for BBXs
1-12, and is optimized to all antenna ports.) A single value is generated
for each path, thereby eliminating the accumulation of error that would
occur from individually measuring and summing the gain and loss of
each element in the path.

When to Optimize

New Installations

After the initial site installation, it must be prepared for operation. This
preparation includes verifying hardware installation, initial power-up,
download of operating code, and Clock Synchronization Module (CSM)
verification.

Next, the optimization is performed. Optimization includes performance
verification and calibration of all transmit and receive RF paths, and
download of accumulated calibration data.

After optimization, a series of manual pre-ATP verification tests are
covered that address alarm/redundancy tests.

After manual pre-Acceptance Test Procedure (pre-ATP) verification
tests, a series of manual ATP CDMA verification tests are covered using
the actual equipment set up. An ATP is also required before the site can
be placed in service.

Site Expansion

Optimization is required after expansion of a site.

Periodic Optimization

Periodic optimization of a site may also be required, depending on the
requirements of the overall system.

Repaired Sites

Refer to Appendix C for detailed basic guideline tables and detailed
Optimization/ATP Test Matrix outlining the minimum tests that must be
performed anytime a BTS subassembly or RF cable associated with it is
replaced.

1
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Abbreviations and Acronyms
Table 1-1 identifies the equipment related abbreviations and acronyms
used in this manual.

Table 1-1: Abbreviations and Acronyms

Acronym Definition

AMR Alarm Monitor Reporting

ATP Acceptance Test Procedure

BBX Broadband Transceiver

BBX2 Broadband Transceiver, 2nd Generation supports
IS-95A/B

BBX-1X Broadband Transceiver, 3rd Generation supports
IS-95A/B  and cdma2000 1X

BLO Bay Level Offset

BTS Base Transceiver Subsystem

CBSC Centralized Base Station Controller

CCD CDMA Clock Distribution

CDMA Code Division Multiple Access

CE Channel Element

CHI Concentration Highway Interface

CIO Combiner Input/Output

CLI Command Line Interface

CM Channel Module

CNEOMI Common Network Element Operation and
Maintenance Interface

CSM Clock Synchronization Manager

CSM-I Clock Synchronization Manager, 1st Generation
CSM card hardware version

CSM-II Clock Synchronization Manager, 2nd Generation
CSM card hardware version

DRDC Duplexer/RX Filter/Directional Coupler

EMI Electromagnetic Interference

EMPC Expansion Multicoupler Preselector Card

FRU Field Replaceable Unit

GLI Group Line Interface,

GLI2 Group Line Interface, 2nd Generation card
hardware version

GLI3 Group Line Interface, 3rd Generation card
hardware version for packet backhaul

GPS Global Positioning System

HSO High Stability Oscillator

HSOX High Stability Oscillator Expansion

I&Q In-phase and Quadrature
. . . continued on next page

1
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Table 1-1: Abbreviations and Acronyms

Acronym Definition

ISB Inter Shelf Bus

LFR Low Frequency Receiver

LMF Local Maintenance Facility

LORAN LOng RAnge Navigational

LPA Linear Power Amplifier

MCC Multi-Channel CDMA

MCC8E/24E Multi-Channel CDMA, 8/24 Channels; 2nd
Generation supports IS-95A/B

MCC1X-16/48 Multi-Channel CDMA, 16/48 Channels; 3rd
Generation supports IS-95A/B  and cdma2000
1X

MGLI Master Group Line Interface

MM Mobility Manager

MMI Man Machine Interface

MPC Multicoupler Preselector Card

MSC Mobile Switching Center

OMCR Operations Maintenance Center - Radio

PDA Power Distribution Assembly

PN Pseudo-random Noise

RF Radio Frequency

RGD Remote GPS Distribution

RGPS Remote GPS

RSSI Received Signal Strength Indicator

SBPF Single Bandpass Filter

SCAP SC (Super Cell) Application Protocol

SNMP Simple Network Management Protocol

STRAU SC (Super Cell) Transcoder/Rate Adaption Unit

SU Subscriber Unit

TCH Traffic Channel

TRDC Transmit Receive filter/Directional Coupler

TSI Time Slot Interchanger

UTC Universal Time Coordinates
 

1
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Required Test Equipment

Policy

The LMF is used in conjunction with Motorola recommended test
equipment and is part of a “calibrated test set”. To ensure consistent,
reliable, and repeatable optimization test results, only recommended test
equipment supported by the LMF must be used to optimize the BTS
equipment.

NOTE During manual testing, you can, of course, substitute test
equipment with other test equipment models not supported by
the LMF, but those models must meet the same technical
specifications.

The customer has the responsibility of accounting for any measurement
variances and/or additional losses/inaccuracies that can be introduced
as a result of test equipment substitutions. Before beginning
optimization or troubleshooting, make sure that the test equipment
needed is on hand and operating properly.

Test Equipment Calibration

Optimum system performance and capacity depend on regular equipment
service, calibration, and characterization prior to BTS optimization.
Follow the original equipment manufacturer (OEM) recommended
maintenance and calibration schedules closely.

Test Cable Calibration

Equipment test cables are very important in optimization. Motorola
recommends that the cable calibration be run at every BTS with the test
cables attached. This method compensates for test cable insertion loss
within the test equipment itself. No other allowance for test cable
insertion loss needs to be made during the performance of tests.

Another method is to account for the loss by entering it into the LMF
during the optimization procedure. This method requires accurate test
cable characterization in a shop. The cable should be tagged with the
characterization information prior to field optimization.

Equipment Warm-up

After arriving at the a site, the test equipment should be plugged in and
turned on to allow warm up and stabilization to occur for as long as
possible. The following pieces of test equipment must be warmed-up for
a minimum of 60 minutes prior to using for BTS optimization or RFDS
calibration procedures.

� Communications Test Set

� Rubidium Time Base

� Power Meter

1
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Test Equipment Specifications

Test equipment specification requirements for the test equipment (or
configuration of test equipment) used to make up the general test
equipment (DVM, etc) are given in the following paragraphs.

LMF Hardware Requirements

Motorola recommends an LMF computer platform that meets the
following requirements:

� Notebook computer

� 266 MHz (32-bit CPU) Pentium processor

� Windows 98SE or Windows 2000 operating system

� 128 MB RAM for Windows 98SE; 256 MB RAM for Windows 2000

� 4 GB internal hard disk drive

� CD ROM drive

� 3 1/2 inch floppy drive

� Color display with 1024 x 768 pixel resolution and capability to
display more than 256 colors

� Serial port (COM 1)

� Parallel port (LPT 1)

� PCMCIA Ethernet interface card (for example, 3COM Etherlink III)
with a 10Base-T-to-coax adapter

Test Equipment List

The following pieces of test equipment are required during the
optimization procedure. Common assorted tools like screwdrivers and
frame keys are not listed but are still required. Read the owner’s manual
on all of the following major pieces of test equipment to understand their
individual operation prior to use in optimization.

NOTE Always refer to specific OEM test equipment documentation for
detailed operating instructions.

Ethernet LAN Transceiver
� PCMCIA Ethernet Adpater + Ethernet UTP Adapter: 3COM Model -

Etherlink III 3C589B

1
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10BaseT/10Base2 Converter
� Transition Engineering Model E-CX-TBT-03 10BaseT/10Base2

Converter

- or -

� Transition Engineering Model E-CX-TBT-03  10BaseT/10Base2
Converter

NOTE Xircom Model PE3-10B2 or equivalent can also be used to
interface the LMF Ethernet connection to the frame.

3C-PC-COMBO  CBL
� Connects to the 3COM PCMCIA card and eliminates the need for a

10BaseT/10base2 Converter.

RS-232  to GPIB Interface
� National Instruments GPIB-232-CT with Motorola CGDSEDN04X

RS232 serial null modem cable or equivalent; used to interface the
LMF to the test equipment.

� Standard RS-232 cable can be used with the following modifications
(see Figure 1-1):

- This solution passes only the 3 minimum electrical connections
between the LMF and the General Purpose Information Bus (GPIB)
interface. The control signals are jumpered as enabled on both ends
of the RS-232 cable (9-pin D).  TX and RX signals are crossed as
Null Modem effect. Pin 5 is the ground reference.

- Short pins 7 and 8 together, and short pins 1, 4, and 6 together on
each connector.

Figure 1-1: Null Modem Cable Detail

5
3
2
7
8
1
4
6

GND
RX
TX

RTS
CTS

RSD/DCD
DTR

GND
TX
RX
RTS
CTS
RSD/DCD
DTR

ON BOTH CONNECTORS
SHORT PINS 7, 8;
SHORT PINS 1, 4, & 6

9-PIN D-FEMALE 9-PIN D-FEMALE

5
2
3
7
8
1
4
6 DSR DSR

FW00362

Man Machine Interface (MMI) Interface Kit (Motorola part
number CGDSMMICABLE219112)

This cable is used to connect the LMF to the BTS.

1
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Communications System Analyzer

The communication system analyzer is used during optimization and
testing of the RF communications portion of BTS equipment and
provides the following functions:

(1) Frequency counter
(2) RF power meter (average and code domain)
(3) RF Signal Generator (capable of CDMA modulation)
(4) Spectrum Analyzer
(5) CDMA Code Domain analyzer

The following communication system analyzers are currently supported
by the LMF:

� HP8921A/600 Analyzer - including 83203B CDMA Interface,
manual control system card, and 83236A/B Personal communication
Interface (PCS) Interface for 1700/1900 MHz BTS.

� Advantest R3465 Analyzer - including R3561L Test Source Unit

� CyberTest Communication Analyzer

� Hewlett-Packard HP 8935 - with option 200 or R2K for 1X TX and
with Agilent E4432B Signal Generator for 1X FER

� Advantest R3267 Analyzer - including R3562 Test Source Unit

� Agilent E4406A Analyzer - including E4432B Test Source Unit

GPIB Cables
� Hewlett Packard 10833A or equivalent; 1 to 2 meters (3 to 6 feet) long

used to interconnect test equipment and LMF terminal.

Power Meter

One of the following power meters is required with the HP8921 and
Advantest analyzers:

� Hewlett Packard Model HP HP437B with HP8481A power sensor

� Gigatronics 8541C with model 80601A power sensor

Timing Reference Cables
� Two BNC-male to BNC-male RG316 cables; 3.05 m (10 ft.) long.

Used to connect the communications analyzer to the front timing
reference of the CSM cards in the BTS frame.

Digital Multimeter
� Fluke Model 8062A with Y8134 test lead kit or equivalent; used for

precision dc and ac measurements, requiring 4-1/2 digits.
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Directional Coupler
� Narda Model 30661 30 dB (Motorola part no. 58D09732W01)

1900 MHz coupler terminated with two Narda Model 375BN-M
loads, or equivalent.

� Narda Model 30445 30 dB (Motorola Part No. 58D09643T01 )
800 MHz coupler terminated with two Narda Model 375BN-M loads,
or equivalent.

RF Attenuator
� 20 dB fixed attenuator, 20 W (Narda 768-20); used with 1.7/1.9 GHz

test cable calibrations or during general troubleshooting procedures.

RF Terminations/Loads
� At least three 100-Watt (or larger) non-radiating RF

terminations/loads.

Miscellaneous RF Adapters, Loads, etc
� As required to interface test cables and BTS equipment and for

various test set ups. Should include at least two 50 Ohm loads (type
N) for calibration and one RF short, two N-Type Female-to-Female
Adapters.

LAN Cable
� BNC-to  BNC 50 ohm coaxial cable [.91 m (3 ft) maximum] with an

F-to-F adapter, used to connect the 10BaseT-to-coaxial adapter to
the BTS LAN connector.

High-impedance  Conductive Wrist Strap
� Motorola Model 42-80385A59; used to prevent damage from

Electrostatic Discharge (ESD) when handling or working with
modules.

Optional Equipment

NOTE Not all optional equipment specified here will be supported by
the LMF in automated tests or when executing various measure
type command line interface (CLI) commands. It is meant to
serve as a list of additional equipment that might be required
during maintenance and troubleshooting operations.

Frequency Counter
� Stanford Research Systems SR620 or equivalent. If direct

measurement of the 3 MHz or 19.6608 MHz references is required.

Spectrum Analyzer
� Spectrum Analyzer (HP8594E with CDMA personality card) or

equivalent; required for manual tests.

Local Area Network (LAN) Tester
� Model NETcat 800 LAN troubleshooter (or equivalent); used to

supplement LAN tests using the ohmmeter.
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Span Line (T1/E1) Verification Equipment
� As required for local application

Oscilloscope
� Tektronics Model 2445 or equivalent; for waveform viewing, timing,

and measurements or during general troubleshooting procedure.

2-way  Splitter
� Mini-Circuits  Model ZFSC-2-2500 or equivalent; provides the

diversity receive input to the BTS

High Stability 10 MHz Rubidium Standard
� Stanford Research Systems SR625 or equivalent - required for CSM

and Low Frequency Receiver/High Stability Oscillator (LFR/HSO)
frequency verification.

Itasca Alarms Test Box
� Itasca CGDSCMIS00014 - This test box may be used as a tool to

assist in the testing of customer alarms.
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Required Documentation

Required Documents

The following documents are required to perform optimization of the
cell site equipment:

� Site Document (generated by Motorola Systems Engineering), which
includes:

- General Site Information

- Floor Plan

- RF Power Levels

- Frequency Plan (includes Site PN and Operating Frequencies)

- Channel Allocation (Paging, Traffic, etc.)

- Board Placement

- Site Wiring List

- CDF files (bts-#.cdf and cbsc-#.cdf)

� BTS Frame Installation Manual; 68P09226A18

� 1X SC 4812T BTS Hardware Installation; 68P09255A60

� Demarcation Document (Scope of Work Agreement)

� CDMA LMF Operator’s Guide; 68P64114A78

� CDMA RFDS Hardware Installation manual; 68P64113A93

� CDMA RFDS User’s Guide, 68P64113A37

� LMF CLI Commands, R16, 68P09253A56

� Equipment Manuals for non-Motorola test equipment

Intended Reader Profile

The information in this manual set is intended for use by the cellular
communications craftsperson(s) in the initial installation and
configuration, as well as the day-to-day operation and maintenance of a
BTS.

The user of this information has a general understanding of telephony, as
used in the operation of the Public Switched Telephone
Network (PSTN), and is familiar with these concepts as they are applied
in the cellular and maintenance mobile/portable radiotelephone
environment.

The user also needs a working knowledge of the computer platform
operating system being used (Windows 98  or Windows 2000 ).

1
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BTS Equipment Identification

Equipment Overview

The Motorola SC 4812T BTS can consist of the following equipment
frames:

� At least one BTS starter frame

- +27 V BTS (see Figure 1-2)

- -48 V BTS (see Figure 1-3)

� Ancillary equipment frame (or wall mounted equipment)

� Expansion frames

- +27 V BTS (see Figure 1-4)

- -48 V BTS (see Figure 1-5)

Ancillary Equipment Frame Identification

NOTE Equipment listed below can be wall mounted or mounted in a
standard 19 inch frame. The description assumes that all
equipment is mounted in a frame for clarity.

If equipped with the RFDS option, the RFDS and directional couplers
are the interface between the site antennas and the BTS or Modem
frame. The RFDS equipment includes:

� Directional couplers

� Site receive bandpass/bandreject filters

� RFDS

Logical BTS

The BTS software implements the logical BTS capability. Previously, all
BTS frames co-located at a single site had to be identified in the
network with separate and distinct BTS ID numbers. In the Logical BTS
feature, all frames located at a single BTS site are identified with unique
Frame ID numbers (Frame ID Numbers 1, 101, 201, 301) under a single
(site) BTS ID number. A logical BTS can consist of up to four
SC 4812T frames.When the LMF is connected to frame 1 of a logical
BTS, you can access all devices in all of the frames that make up the
logical BTS. A logical BTS requires a CDF file that includes equipage
information for all of the logical BTS frames and their devices and a
CBSC file that includes channel data for all of the logical BTS fames.
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Logical BTS Numbering

The first frame of a logical BTS has a -1 suffix (e.g., BTS-812-1 ).
Other frames of the logical BTS are numbered with suffixes, -101 , -201 ,
and -301  (e. g. BTS-812-201 ). When you log into a BTS, a FRAME
tab is displayed for each frame. If there is only one frame for the BTS,
there is only one tab (e.g., FRAME-282-1 ) for BTS-282. If a logical
BTS has more than one frame, there is a separate FRAME tab for each
frame (e.g. FRAME-438-1 , FRAME-438-101 , and FRAME-438-201
for a BTS-438  that has three frames). If an RFDS is included in the
CDF file, an RFDS tab (e.g., RFDS-438-1)  is displayed.

Actions (e.g., ATP tests) can be initiated for selected devices in one or
more frames of a logical BTS. Refer to the Select devices help screen for
information on how to select devices.

C-CCP  Shelf Card/Module Device ID Numbers

All cards/modules/boards in the frames at a single site, assigned to a
single BTS number, are also identified with unique Device ID numbers
dependent upon the Frame ID number in which they are located. Refer to
Table 1-2 and Table 1-3 for specific C-CCP Shelf Device ID numbers.

Table 1-2: C-CCP Shelf/Cage Card/Module Device ID Numbers (Top Shelf)

Frame Card/Module ID Number (Left to Right)
#

Power
(PS-1)

Power
(PS-2)

Power
(PS-3)

AMR
- 1

GLI2
-1

MCC BBX BBX-
R

MPC/
EMPC

- 1

1 - - - 1 1 1 2 3 4 5 6 1 2 3 4 5 6 R1 -

101 - - - 101 101 101 102 103 104 105 106 101 102 103 104 105 106 R101 -

201 - - - 201 201 201 202 203 204 205 206 201 202 203 204 205 206 R201 -

301 - - - 301 301 301 302 303 304 305 306 301 302 303 304 305 306 R301 -

Table 1-3: C-CCP Shelf/Cage Card/Module Device ID Numbers (Bottom Shelf)

Frame Card/Module ID Number (Left to Right)
#

HSO/
LFR

CSM
-1

CSM
-2

CCD
A

CCD
B

AMR
- 2

GLI2-
2

MCC BBX SW MPC/
EMPC

- 2

1 - 1 2 - - - 2 2 7 8 9 10 11 12 7 8 9 10 11 12 - -

101 - 101 102 - - - 102 102 107 108 109 110 111 112 107 108 109 110 111 112 - -

201 - 201 202 - - - 202 102 207 208 209 210 211 212 207 208 209 210 211 212 - -

301 - 301 302 - - - 302 102 307 308 309 310 311 312 307 308 309 310 311 312 - -
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Figure 1-2: +27 V SC 4812T BTS Starter Frame
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Figure 1-3: -48 V SC 4812T BTS Starter Frame
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Figure 1-4: +27 V SC 4812T BTS Expansion Frame
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Figure 1-5: -48 V SC 4812T BTS Expansion Frame
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BTS Frame Description
The BTS is the interface between the span lines to/from the Cellsite Base
Station Controller (CBSC) and the site antennas. This frame is described
in three sections:

� The top interconnect plate where all connections are made.

� The upper portion of the frame which houses circuit breakers, cooling
fans, and the C-CCP shelf.

� The lower portion of the frame which houses the LPA fans, LPAs, and
TX filter/combiners.

� The -48 V version of the BTS also has a section below the LPAs
containing a power conversion shelf that supplies power to the LPAs.

Use the illustrations that follow to visually identify the major
components, that make up the Motorola SC 4812T BTS frame.

Top Interconnect Plate (see Figure 1-6 or Figure 1-7)
All cabling to and from the BTS equipment frames is via the
interconnect panel on the top of each frame. Connections made here
include:

� Span lines

� RX antennas

� TX antenna

� Alarm connections

� Power input

� LAN connections

� GPS input or Remote Global Positioning System (RGPS) on the Site
I/O Board

� Remote Global Positioning System Distribution (RGD)

� LORAN-C Low Frequency Receiver (LFR) input

� Expansion frame connection

� Ground connections

� RJ-45 Pass-through Connectors

C-CCP  Shelf (see Figure 1-10)
� C-CCP  backplane and cage

� Power supply modules

� CDMA clock distribution (CCD) boards

� CSM and HSO/LFR boards

� Alarm Monitoring and Reporting (AMR) boards

� GLI cards (may be GLI2 or GLI3)

� MPC/EMPC boards
- MPC - starter frame only
- EMPC - expansion frames

� Switch card

� MCC boards (may be MCC8E, MCC24, or MCC-1X)

� BBX boards (may be BBX2 or BBX-1X)

� CIO boards
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PA Shelves (see Figure 1-11 or Figure 1-12)
� LPA cages

� LPA trunking backplanes

� Single Tone Linear Power Amplifier (STLPA, or more commonly
referred to as “LPA”) modules

� LPA fan modules

� LPA Combiner Cage (+27 V BTS)

� TX filter combiners or bandpass filters

-48  V Power Conversion Shelf (see Figure 1-15)
� Power conversion backplane and shelf

� Power conversion boards

� Power conversion alarm card

� Fan modules

� Power distribution assembly

� Air plenum
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Frame Module Location & Identification
Figure 1-6: +27 V SC 4812T Starter Frame I/O Plate
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Figure 1-7: -48 V SC 4812T Starter Frame I/O Plate
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Figure 1-8: +27 V SC 4812T Expansion Frame I/O Plate
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Figure 1-9: -48 V SC 4812T Expansion Frame I/O Plate
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Figure 1-10: SC 4812T C-CCP Shelf
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Figure 1-11: +27 V SC 4812T LPA Configuration - 4 Carrier with 2:1 Combiners
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Figure 1-12: -48 V SC 4812T LPA Configuration - 4 Carrier, 3-Sector with 2:1 Combiners
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Sector Configuration

There are a number of ways to configure the BTS frame. Table 1-4
outlines the basic requirements. When carrier capacity is greater than
two, a 2:1 or 4:1 cavity combiner must be used. For one or two carriers,
bandpass filters or cavity combiners may be used, depending on
sectorization and channel sequencing.

Table 1-4: BTS Sector Configuration

Number
of carriers

Number
of sectors

Channel
spacing

Filter requirements

1 3 or 6 N/A Bandpass Filter, Cavity Combiner
(2:1 or 4:1)

2 6 Non-adjacent Cavity Combiner (2:1 Only)

2 6 Adjacent Not supported in single frame

2 3 Non-adjacent Cavity Combiner (2:1 or 4:1)

2 3 Adjacent Bandpass Filter

3,4 3 Non-adjacent Cavity Combiner (2:1 or 4:1)

3,4 3 Adjacent Cavity Combiner (2:1 Only)
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NOTE In Table 1-5, BBXs may be BBX2s or BBX-1Xs.

Table 1-5: Sector Configurations

Config Ref. No. Description

3-Sector/2-ADJACENT  Carriers - The configuration below maps TX with optional 2:1 cavity
combiners for 3 sectors/2 carriers for adjacent channels. Note that 2:1 cavity combiners are used (6
total).

1 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

N/A N/A N/A BBX-4 BBX-5 BBX-6 2

6-Sector/2-NON-ADJACENT Carriers - The configuration below maps TX with 2:1 cavity
combiners for 6 sectors/2 carriers for non-adjacent  channels.

2 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 BBX-4 BBX-5 BBX-6 1

BBX-7 BBX-8 BBX-9 BBX-10 BBX-1 1 BBX-12 2

3-Sector/2-NON-ADJACENT Carriers - The configuration below maps TX with 2:1 cavity
combiners for 3 sectors/2 carriers for non-adjacent  channels.

3 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

BBX-7 BBX-8 BBX-9 N/A N/A N/A 2

3-Sector/4-ADJACENT Carriers - The configuration below maps TX with 2:1 cavity combiners
for 3 sector/4 carriers for adjacent channels.

TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

4 BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

BBX-7 BBX-8 BBX-9 N/A N/A N/A 2

N/A N/A N/A BBX-4 BBX-5 BBX-6 3

N/A N/A N/A BBX-10 BBX-1 1 BBX-12 4

3-Sector / 2-ADJACENT Carriers - The configuration below maps TX with bandpass filters for
3 sectors/2 carriers for adjacent channels.

5 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

N/A N/A N/A BBX-7 BBX-8 BBX-9 2

3-Sector/3 or 4-NON-ADJACENT Carriers - The configuration below maps TX with 4:1
cavity combiners for 3 sectors/3 or 4 carriers for non-adjacent  channels.

TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

6 BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

BBX-7 BBX-8 BBX-9 N/A N/A N/A 2

BBX-4 BBX-5 BBX-6 N/A N/A N/A 3

BBX-10 BBX-1 1 BBX-12 N/A N/A N/A 4

6-Sector/1-Carrier - The configuration below maps TX with either bandpass filters or 2:1 cavity
combiners for 6 sector/1 carrier.

7 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 BBX-4 BBX-5 BBX-6 1

1
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Figure 1-13: +27 V SC4812T LPA Configuration with Combiners/Filters
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Figure 1-14: -48 V SC4812T LPA Configuration with Combiners/Filters
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Figure 1-15: -48 V BTS Power Conversion Shelf
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Figure 1-16: CDMA (COBRA) RFDS Layout
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Preliminary Operations: Overview

Introduction

This section first verifies proper frame equipage. This includes verifying
module placement, jumper, and dual in-line package (DIP) switch
settings against the site-specific documentation supplied for each BTS
application. Next, pre-power up and initial power-up procedures are
presented.

Cell Site Types

Sites are configured as Omni with a maximum of 4 carriers, 3-sectored
with a maximum of 4 carriers, and 6-sectored with a maximum of 2
carriers. Each type has unique characteristics and must be optimized
accordingly. For more information on the differences in site types, please
refer to the BTS/Modem Frame Hardware Installation manual.

CDF

The Cell-site Data File (CDF) contains site type and equipage data
information and passes it directly to the LMF during optimization. The
number of modem frames, C-CCP shelves, BBX boards, MCC boards
(per cage), and linear power amplifier assignments are some of the
equipage data included in the CDF.

NOTE Be sure that the correct bts-#.cdf  and cbsc-#.cdf  files are used
for the BTS. These should be the CDF files that are provided for
the BTS by the CBSC. Failure to use the correct CDF files can
cause system errors. Failure to use the correct CDF files to log
into a live (traffic carrying) site can shut down the site.

Site Equipage Verification

Review the site documentation. Match the site engineering equipage data
to the actual boards and modules shipped to the site. Physically inspect
and verify the equipment provided for the BTS or Modem frame and
ancillary equipment frame.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.
After removal, the card/module should be placed on a conductive
surface or back into the anti-static shipping bag.
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Initial Installation of Boards/Modules

Follow the procedure in Table 2-1 to verify the initial installation of
boards/modules.

Table 2-1: Initial Installation of Boards/Modules

Step Action

1 Refer to the site documentation and install all boards and modules into the appropriate shelves as
required. Verify they are NOT SEATED at this time.

NOTE
On 800 MHz systems, the Switch Card has a configuration switch that must match the site
configuration (see Figure 2-1).

2 As the actual site hardware is installed, record the serial number of each module on a “Serial Number
Checklist” in the site logbook.

Figure 2-1: Switch Card
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Setting Frame C-CCP Shelf Configuration Switch

The backplane switch settings behind the fan module nearest the breaker
panel should be set as shown in Figure 2-2.

The switch setting must be verified and set before power is applied to the
BTS equipment.

Figure 2-2: Backplane DIP Switch Settings - SC 4812T
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Pre-Power-up  Tests

Objective

This procedure checks for any electrical short circuits and verifies the
operation and tolerances of the cellsite and BTS power supply units prior
to applying power for the first time.

Test Equipment

The following test equipment is required to complete the pre-power-up
tests:

� Digital Multimeter (DMM)

CAUTION Always wear a conductive, high impedance wrist strap while
handling the any circuit card/module to prevent damage by ESD.

Cabling Inspection

Using the site-specific documentation generated by Motorola Systems
Engineering, verify that the following cable systems are properly
connected:

� Receive RF cabling - up to 12 RX cables

� Transmit RF cabling - up to six TX cables

� GPS

� LFR

NOTE For positive power applications (+27 V):

� The positive power cable is red.

� The negative power cable (ground) is black.
For negative power applications (-48 V):

� The negative power cable is red or blue.

� The positive power cable (ground) is black.
In all cases, the black power cable is at ground potential.
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DC Power Pre-test (BTS Frame)
Before applying any power to the BTS frame, follow the procedure in
Table 2-2 while referring to Figure 2-3 and Figure 2-4 for  +27 V
systems or to Figure 2-5 and Figure 2-6 for -48 V systems to verify
there are no shorts in the BTS frame DC distribution system.

Table 2-2: DC Power Pre-test (BTS Frame)

Step Action

1 Physically verify that all DC power sources supplying power to the frame are OFF or disabled.

2 On each frame:

� Unseat all circuit boards (except CCD and CIO cards) in the C-CCP shelf and LPA shelves, but
leave them in their associated slots.

� Set C-CCP shelf breakers to the OFF position by pulling out power distribution breakers (labeled
C-CCP 1, 2, 3 on the +27 V BTS C-CCP power distribution panel and labeled POWER
1,4,5,2,6,7,3,8,9  on the -48 V C-CCP power distribution panel).

� Set LPA breakers to the OFF position by pulling out the LPA breakers (8 breakers, labeled 1A-1B
through 4C-4D  - located on the C-CCP power distribution panel in the +27 V BTS or on the
power conversion shelf power distribution panel in the -48 V BTS).

3 Verify that the resistance from the power (+ or -) feed terminals with respect to the ground terminal on
the top of the frame measures > 500 Ω (see Figure 2-3).

� If reading is < 500 Ω, a short may exist somewhere in the DC distribution path supplied by the
breaker. Isolate the problem before proceeding. A reading > 3 MΩ could indicate an open (or
missing) bleeder resistor (installed across the filter capacitors behind the breaker panel).

4 Set the C-CCP (POWER) breakers to the ON position by pushing them IN one at a time. Repeat
Step 3 after turning on each breaker.

NOTENOTE
If the ohmmeter stays at 0 Ω after inserting any board/module, a short probably exists in that
board/module. Replace the suspect board/module and repeat the test. If test still fails, isolate the
problem before proceeding.

5 Insert and lock the DC/DC converter modules for the C-CCP shelf and into their associated slots one
at a time. Repeat Step 3 after inserting each module.

� A typical response is that the ohmmeter steadily climbs in resistance as capacitors charge, finally
indicating approximately 500 Ω.

! CAUTION
Verify the correct power/converter modules by observing the locking/retracting tabs appear as follows:

-  (in +27 V BTS C-CCP shelf)

-  (in -48 V BTS C-CCP shelf)STPN4045A
PWR CONV  CDMA RCVR

STPN4009
PWR CONV  CDMA RCVR

6 Insert and lock all remaining circuit boards and modules into their associated slots in the C-CCP shelf.
Repeat Step 3 after inserting and locking each board or module.

� A typical response is that the ohmmeter steadily climbs in resistance as capacitors charge, stopping
at approximately 500 Ω..

7 Set the LPA breakers ON by pushing them IN one at a time.
Repeat Step 3 after turning on each breaker.

� A typical response is that the ohmmeter will steadily climb in resistance as capacitors charge,
stopping at approximately 500 Ω..

. . . continued on next page
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Table 2-2: DC Power Pre-test (BTS Frame)

Step Action

8 In the -48 V BTS, insert and lock the DC/DC LPA converter modules into their associated slots one at
a time.
Repeat Step 3 after inserting each module.

� A typical response is that the ohmmeter steadily climbs in resistance as capacitors charge, finally
indicating approximately 500 Ω.

! CAUTION
Verify the correct power/converter modules by observing the locking/retracting tabs appear as follows:

-  (in -48 V BTS power conversion shelf)STPN4044A
PWR CONV  LPA

9 Seat all LPA and associated LPA fan modules into their associated slots in the shelves one at a time.
Repeat Step 3 after seating each LPA  and associated LPA fan module.

� A typical response is that the ohmmeter will steadily climb in resistance as capacitors charge,
stopping at approximately 500 Ω..
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Figure 2-3: +27 V BTS DC Distribution Pre-test
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Figure 2-4: +27 V SC 4812T BTS Starter Frame
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Figure 2-5: -48 V BTS DC Distribution Pre-test
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Figure 2-6: -48 V SC 4812T BTS Starter Frame

ÂÂÂÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂÂÂÂ

Á Á

Á

Á
Á

Á
Á

Á

Á

FW00477

Expansion I/O
Housing

For clarity, doors are not shown.

Front Cosmetic
Panel

Power Input
Connection

TX Out (1 - 6)

Span I/O B

Span I/O A

Site I/O

RX In (1A - 6A
and 1B - 6B)

Exhaust Region

C-CCP Cage

Breakers

Combiner
Section

RGD (Needed for
Expansion only)

LPA Cage

Power
Conversion

Shelf

Breakers

Alarms
2



Pre-Power-up  Tests 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

2-12

DC Power Pre-test (RFDS)

Before applying power to the RFDS, follow the steps in Table 2-3, while
referring to Figure 2-7, to verify there are no shorts in the RFDS DC
distribution system, backplanes, or modules/boards. As of the date of
this publication, the RFDS is not used with the -48 V BTS.

NOTE Visual inspection of card placement and equipage for each frame
vs. site documentation must be completed, as covered in
Table 2-1 on page 2-3, before proceeding with this test.

Table 2-3: DC Power Pre-test (RFDS)

Step Action

1 Physically verify that all DC/DC converters supplying the RFDS are OFF or disabled.

2 Set the input power rocker switch P1 to the OFF position (see Figure 2-7).

3 Verify the initial resistance from the power (+ or -) feed terminal with respect to ground terminal
measures > 5 kΩ , then slowly begins to increase.

� If the initial reading is < 5 kΩ and remains constant, a short exists somewhere in the DC
distribution path supplied by the breaker. Isolate the problem before proceeding.

4 Set the input power rocker switch P1 to the ON position.

Repeat Step 3.

Figure 2-7: DC Distribution Pre-test (COBRA RFDS Detail)
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Initial Power-up Tests

Power-up Procedures

WARNING Potentially lethal voltage and current levels are routed to the
BTS equipment. This test must be performed with a second
person present, acting in a safety role. Remove all rings, jewelry,
and wrist watches prior to beginning this test.

DC Input Power

In the tests to follow, power will first be verified at the input to each
BTS frame. After power is verified, cards and modules within the frame
itself will be powered up and verified one at a time.

Before applying any power, verify the correct power feed and return
cables are connected between the power supply breakers and the power
connectors at the top of each BTS frame. Verify correct cable position
referring to Figure 2-3 on page 2-8 for +27 V systems and Figure 2-5
on page 2-10 for -48 V systems.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.
Extreme care should be taken during the removal and installation
of any card/module. After removal, the card/module should be
placed on a conductive surface or back into the anti-static bag in
which it was shipped.

NOTE For positive power applications (+27 V):

� The positive power cable is red.

� The negative power cable (ground) is black.
For negative power applications (-48 V):

� The negative power cable is red or blue.

� The positive power cable (ground) is black.
In all cases, the black power cable is at ground potential.

Motorola recommends that the DC input power cable used to connect the
frame to the main DC power source conforms to the guidelines outlined
in Table 2-4.

Table 2-4: DC Input Power Cable Guidelines

Maximum Cable Length Wire Size

30.38 m (100 ft) 107 mm2 (AWG #4/0)

54.864 m (180 ft) 185 mm2 (350 kcmil)

Greater that 54.864 m (180 ft) Not recommended

NOTE If Anderson SB350 style power connectors are used, make sure
the connector adapters are securely attached to each of the BTS
power feeds and returns. Also, make sure the cables have been
properly installed into each connector.
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Common Power Supply Verification

The procedure in Table 2-5 must be performed on any BTS frame
connected to a common power supply at the site after the common power
supply has been installed and verified per the power supply OEM
suggested procedures.

Perform the following steps to verify the power input is within
specification before powering up the individual cards/modules with the
frames themselves.

Table 2-5: Common Power Supply Verification

Step Action

1 Physically verify that all DC power sources supplying the frame are OFF or disabled.

2 On the RFDS (for +27 V systems only), set the input power switch P1 to the OFF position (see
Figure 2-7).

3 On each frame:

� Unseat all circuit boards (except CCD and CIO cards) in the C-CCP shelf and LPA shelves, but
leave them in their associated slots.

� Set breakers to the OFF position by pulling out C-CCP and LPA breakers (see Figure 2-3 on
page 2-8 or Figure 2-5 on page 2-10 for breaker panel layout if required).

- C-CCP shelf breakers are labeled CCCP-1 , 2, 3 in the +27 V BTS and labeled POWER
1,4,5,2,6,7,3,8,9  in the -48 V BTS.

- LPA breakers are labeled 1A-1B  through 4C-4D.

4 Inspect input cables, verify correct input power polarity via decal on top of frame (+27 Vdc or
-48 Vdc).

5 Apply power to BTS frames, one at a time, by setting the appropriate breaker in the power supply that
supplies the frame to the ON position.

6 After power is applied to each frame, use a digital voltmeter to verify power supply output voltages at
the top of each BTS frame are within specifications: +27.0 Vdc or -48 Vdc nominal.
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Initial Power-up (RFDS)

The procedure in Table 2-6 must be performed on the RFDS after input
power from the common power supply has been verified. Perform the
following steps to apply initial power to the cards/modules within the
frame itself, verifying that each is operating within specification.

NOTE Visual inspection of card placement and equipage for each frame
vs. site documentation must be completed, as covered in
Table 2-1, on page 2-3, before proceeding with this test.

Table 2-6: Initial Power-up (RFDS)

Step Action

1 On the RFDS, set the input power rocker switch (P1) to the ON position (see Figure 2-7).

2 Verify power supply output voltages (at the top of BTS frame), using a digital voltmeter, are within
specifications: +27.0 V nominal.

Initial Power-up (BTS)

The procedure must be performed on each frame after input power from
the common power supply has been verified. Follow the steps in
Table 2-7 to apply initial power to the cards/modules within the frame
itself, verifying that each is operating within specification.

Table 2-7: Initial Power-up (BTS)

Step Action

1 At the BTS, set the C-CCP (POWER) power distribution breakers (see Figure 2-3 on page 2-8 or
Figure 2-5 on page 2-10) to the ON position by pushing in the breakers.

2 Insert the C-CCP fan modules. Observe that the fan modules come on line.

3 ! CAUTION
Verify the correct power/converter modules by observing the locking/retracting tabs appear as follows:

- (in +27 V BTS C-CCP shelf)

- (in -48 V BTS C-CCP shelf)

- (in -48 V BTS power conversion shelf)

Insert and lock the converter/power supplies into their associated slots one at a time.
• If no boards have been inserted, all three PWR/ALM LEDs would indicate RED to notify the user

that there is no load on the power supplies.

- If the LED is RED, do not be alarmed. After Step 4 is performed, the LEDs should turn GREEN;
if not, then a faulty converter/power supply module is indicated and should be replaced before
proceeding.

STPN 4045A
PWR CONV  CDMA RCVR

STPN 4044A
PWR CONV  LPA

STPN4009
PWR CONV  CDMA RCVR

4 Seat and lock all remaining circuit cards and modules in the C-CCP shelf into their associated slots.

5 Seat the first equipped LPA module pair into the assigned slot in the upper LPA shelf including LPA
fan.

� In +27 V systems, observe that the LPA internal fan comes on line.

6 Repeat step 5 for all remaining LPAs.

. . . continued on next page
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Table 2-7: Initial Power-up (BTS)

Step Action

7 Set the LPA breakers to the ON position (per configuration) by pushing them IN one at a time. See
Figure 1-13 on page 1-33 or Figure 1-14 on page 1-34 for configurations and Figure 2-3 on page 2-8
or Figure 2-5 on page 2-10 for LPA breaker panel layout.

On +27 V frames, engage (push) LPA circuit breakers.

� Confirm LEDs on LPAs light.

On -48 V frames, engage (push) LPA PS circuit breakers.

� Confirm LPA PS fans start.

� Confirm LEDs on -48 V power converter boards light.

� Confirm LPA fans start.

� Confirm LEDs on LPAs light.

8 After all cards/modules have been seated and verified, use a digital voltmeter to verify power supply
output voltages at the top of the frame remain within specifications: +27.0 Vdc or -48 Vdc nominal.

9 Repeat Steps 1 through 8 for additional co-located frames (if equipped).
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Chapter 3

Optimization/Calibration
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Optimization/Calibration - Introduction

Introduction

This section describes procedures for isolating the BTS from the span
lines, preparing and using the LMF, downloading system operating
software, CSM reference verification/optimization, set up and calibration
of the supported test equipment, transmit/receive path verification, using
the RFDS, and verifying the customer defined alarms and relay contacts
are functioning properly.

NOTE Before using the LMF, use an editor to view the “CAVEATS”
section in the “readme.txt” file in the c:\wlmf folder for any
applicable information.

Optimization Process

After a BTS is physically installed and the preliminary operations
(power up) have been completed, use the LMF to calibrate and optimize
the BTS. Motorola recommends that the optimization be accomplished
as follows:

1. Download MGLI-1 with code and data and then enable MGLI-1.

NOTE GLIs may be GLI2s or GLI3s.

2. Use the status function and verify that all of the installed devices of
the following types respond with status information: CSM, BBX,
GLI, MCC, and TSU (if RFDS is installed). If a device is installed
and powered up but is not responding and is colored gray in the BTS
display, the device is not listed in the CDF file. The CDF file must
be corrected before the device can be accessed by the LMF.

3. Download code and data to all devices of the following types:

- CSM

- BBX (may be BBX2 or BBX-1X)

- GLI (other than MGLI-1)

- MCC (may be MCC-8E, MCC24, or MCC-1X)

4. Download the RFDS TSIC (if installed).

5. Verify the operation of the GPS and HSO or LFR signals.

6. Enable the following devices (in the order listed):

- Secondary CSM

- Primary CSM

- All MCCs

7. Connect the required test equipment for a full optimization.

8. Select the test equipment.

9. Calibrate the TX and RX test cables if they have not previously been
calibrated using the CDMA LMF that will be used for the
optimization/calibration. The cable calibration values can also be
entered manually.

3



Optimization/Calibration - Introduction68P09255A61-4

Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
3-3

10. Select all of the BBXs and all of the MCCs, and use the full
optimization function. The full optimization function performs TX
calibration, BLO download, TX audit, all TX tests, and all RX tests
for all selected devices.

11. If the TX calibration fails, repeat the full optimization for any failed
paths.

12. If the TX calibration fails again, correct the problem that caused the
failure and repeat the full optimization for the failed path.

13. If the TX calibration and audit portion of the full optimization passes
for a path but some of the TX or RX tests fail, correct the problem
that caused the failure and run the individual tests as required until
all TX and RX tests have passed for all paths.

Site Types
Sites are configured as Omni/Omni or Sector/Sector (TX/RX). Each type
has unique characteristics and must be optimized accordingly.

NOTE For more information on the differences in site types, please
refer to the applicable BTS/Modem Frame Hardware Installation
and Functional Hardware Description manuals.

Cell-Site  Data File
The Cell-Site Data File (CDF) contains information that defines the
BTS and data used to download files to the devices. A CDF file must be
placed in the applicable BTS folder before the LMF can be used to log
into that BTS. CDF files are normally obtained from the CBSC using a
floppy disk. A file transfer protocol (ftp) method can be used if the LMF
computer has that capability.

 The CDF includes the following information:

� Download instructions and protocol

� Site specific equipage information

� C-CCP shelf allocation plan

- BBX equipage (based on cell-site type) including redundancy

- CSM equipage including redundancy

- MCC (MCC24E, MCC8E, or MCC-1X) channel element allocation
plan. This plan indicates how the C-CCP shelf is configured, and
how the paging, synchronization, traffic, and access channel
elements (and associated gain values) are assigned among the (up to
12) MCCs in the shelf.

� CSM equipage including redundancy

� Effective Rated Power (ERP) table for all TX channels to antennas
respectively. Motorola System Engineering specifies the ERP of a
transmit antenna based on site geography, antenna placement, and
government regulations. Working from this ERP requirement, the
antenna gain, (dependent on the units of measurement specified) and
antenna feed line loss can be combined to determine the required
power at the top of the BTS frame. The corresponding BBX output
level required to achieve that power level on any channel/sector can
also be determined.
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NOTE Refer to the CDMA LMF Operator’s Guide for additional
information on the layout of the LMF directory structure
(including CDF file locations and formats).

BTS System Software Download

BTS system software must be successfully downloaded to the BTS
processor boards before optimization can be performed. BTS operating
code is loaded from the LMF computer terminal.

NOTE Before using the LMF for optimization/ATP, the correct
bts-#.cdf  and cbsc-#.cdf  files for the BTS must be obtained
from the CBSC and put in a bts-#  folder in the LMF. Failure to
use the correct CDF files can cause wrong results. Failure to use
the correct CDF files to log into a live (traffic carrying) site
can shut down the site.

The CDF is normally obtained from the CBSC on a DOS formatted
diskette, or through a file transfer protocol (ftp) if the LMF computer has
ftp capability. Refer to the CDMA LMF Operator’s Guide, or the LMF
Help screen, for the procedure.

Site Equipage Verification

If you have not already done so, use an editor to view the CDF, and
review the site documentation. Verify the site engineering equipage data
in the CDF matches the actual site hardware using a CDF conversion
table.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.
Extreme care should be taken during the removal and installation
of any card/module. After removal, the card/module should be
placed on a conductive surface or back into the anti-static bag in
which it was shipped.
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Isolate Span Lines/Connect LMF

Isolate BTS from T1/E1 Spans

NOTE At active sites, the OMC/CBSC must disable the BTS and place
it out of service (OOS). DO NOT remove the 50-pin TELCO
cable connected to the BTS frame site I/O board J1 connector
until the OMC/CBSC has disabled the BTS!

Each frame is equipped with one Site I/O and two Span I/O boards. The
Span I/O J1 connector provides connection of 25 pairs of wire. A GLI
card can support up to six spans. In the SC 4812T configuration, the odd
spans (1, 3, and 5) terminate on the Span “A” I/O; and the even spans (2,
4, and 6) terminate on the Span “B” I/O.

Before connecting the LMF to the frame LAN, the OMC/CBSC must
disable the BTS and place it OOS to allow the LMF to control the
CDMA BTS. This prevents the CBSC from inadvertently sending
control information to the CDMA BTS during LMF based tests. Refer to
Figure 3-1 and Figure 3-2 as required.

Table 3-1: T1/E1 Span Isolation

Step Action

1 From the OMC/CBSC, disable the BTS and place it OOS. Refer to SC OMC-R/CBSC System
Operator Procedures.

- The T1/E1 span 50-pin TELCO cable connected to the BTS frame SPAN I/O board J1 connector
can be removed from both Span I/O boards, if equipped, to isolate the spans.

NOTE
If a third party is used for span connectivity, the third party must be informed before disconnecting the
span line.

Verify that you remove the SPAN cable, not the “MODEM/TELCO” connector.

Figure 3-1: Span I/O Board T1 Span Isolation

50-PIN  TELCO
CONNECTORS
REMOVED

SPAN A CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

SPAN B CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

TOP of Frame
 (Site I/O and Span I/O boards)

RS-232  9-PIN SUB D
CONNECTOR SERIAL
PORT FOR EXTERNAL
DIAL UP MODEM
CONNECTION (IF USED)
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LMF to BTS Connection

The LMF is connected to the LAN A or B connector located on the left
side of the frame’s lower air intake grill, behind the LAN Cable Access
door (see Figure 3-2).

Table 3-2: LMF to BTS Connection

Step Action

1 To gain access to the connectors on the BTS, open the LAN Cable Access door, then pull apart the
Velcro  tape covering the BNC “T” connector (see Figure 3-2).

2 Connect the LMF to the LAN A BNC connector via PCMCIA Ethernet Adapter with an unshielded
twisted-pair (UTP) Adapter and 10BaseT/10Base2 converter (powered by an external AC/DC
transformer).

- If there is no login response, connect the LMF to the LAN B connector.

- If there is still no login response, see Table 6-1, Login Failure Troubleshooting Procedures.

NOTE
- Xircom Model PE3-10B2 or equivalent can also be used to interface the LMF Ethernet

connection to the frame connected to the PC parallel port, powered by an external AC/DC
transformer. In this case, the BNC cable must not exceed 91 cm (3 ft) in length.

! CAUTION
- The LAN shield is isolated from chassis ground. The LAN shield (exposed portion of BNC

connector) must not touch the chassis during optimization.

Figure 3-2: LMF Connection Detail
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Preparing the LMF

Overview

Software and files for installation and updating of the LMF are provided
on CD ROM disks. The following installation items must be available:

� LMF Program on CD ROM

� CDF for each supported BTS (on diskette or available from the
CBSC)

� CBSC File for each supported BTS (on diskette or available from the
CBSC)

The following section provides information and instructions for
installing and updating the LMF software and files.

NOTE For the CDMA LMF graphics to display properly, the computer
platform must be configured to display more than 256 colors.
See the operating system software instructions for verifying and
configuring the display settings.

CDMA LMF Home Directory

The CDMA LMF installation program creates the default home
directory, c:\wlmf, and installs the application files and subdirectories
(folders) in it. Because this can be changed at installation, the CDMA
LMF home directory will be referred to with the generic convention of:

<x>:\<lmf home directory>

Where:

<x> = the LMF computer drive letter where the CDMA LMF home
directory is located

<lmf home directory> = the directory path or name where the CDMA
LMF is installed.”
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LMF Operating System Installation

Follow the procedure in Table 3-3 to install the LMF operating system.

Table 3-3: LMF Operating System Installation

� Step Action

1 Insert the LMF Program CD ROM into the LMF CD ROM drive.

- If the Setup screen is displayed, go to step 5.

- If the Setup screen is not displayed, proceed to step 2.

2 Click on the Start button.

3 Select Run.

4 In the Open box, enter d:\autorun and click on the OK button.

NOTE
If applicable, replace the letter d with the correct CD ROM drive letter.

5 Follow the instructions displayed on the Setup screen.

NOTE
First Time Installations:

- Install U/WIN (First)

- Install Java Runtime Environment (Second)

- Install LMF Software (Third)

- Install/Create BTS Folders (Fourth)

Any time you install U/WIN, you must install the LMF software because the installation of the
LMF modifies some of the files that are installed during the U/Win installation. Installing U/Win
over-writes these modifications.

NOTE
There are multiple binary image packages for installation on the CD-ROM. When prompted,
choose the load that corresponds to the switch release that you currently have installed. Perform
the Device Images install after the WinLMF installation.

If applicable, a separate CD ROM of BTS Binaries may be available for binary updates.

 

Copy CDF Files from CBSC

Before the LMF can execute the optimization/ATP procedures for the
BTS, the correct bts-#.cdf and cbsc-#.cdf files must be
obtained from the CBSC and put in a bts-# folder in the LMF
notebook. This requires copying the CBSC CDF files to a DOS
formatted diskette, and using the diskette to install the CDF file in the
LMF.

Follow the procedure in Table 3-4 to obtain the CDF files from the
CBSC and copy the files to a diskette. For any further information, refer
to the CDMA LMF Operator’s Guide or the LMF Help screen.
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NOTE If the LMF has ftp capability, the ftp method can be used to copy
the CDF files from the CBSC.

On Sun OS workstations, the unix2dos command can be used in
place of the cp command (e.g., unix2dos bts-248.cdf
bts-248.cdf). This should be done using a copy of the CBSC
CDF file so the original CBSC CDF file is not changed to DOS
format.

When copying CDF files, comply with the following to prevent
BTS login problems with the LMF:

- The numbers used in the bts-#.cdf and cbsc-#.cdf
filenames must correspond to the locally assigned numbers
for each BTS and its controlling CBSC.

- The generic cbsc-1.cdf file supplied with the LMF works
with locally numbered BTS CDF files. Using this file does
not provide a valid optimization unless the generic file is
edited to replace default parameters (e.g., channel numbers)
with the operational parameters used locally.

Table 3-4: Copying CBSC CDF Files to the LMF

� Step Action

AT THE CBSC:

1 Login to the CBSC workstation.

2 Insert a DOS formatted diskette in the workstation drive.

3 Type eject -q and press the <Enter> key.

4 Type mount and press the <Enter> key.

NOTE
� Look for the “floppy/no_name” message on the last line displayed.

� If the eject command was previously entered, floppy/no_name will be appended with a
number. Use the explicit floppy/no_name reference displayed when performing step 7.

5 Change to the directory containing the file by typing cd <directory name> (ex. cd
bts-248 ) and pressing <Enter>.

6 Type ls <Enter> to display the list of files in the directory.

. . . continued on next page
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Table 3-4: Copying CBSC CDF Files to the LMF

� ActionStep

7 With Solaris versions of Unix, create DOS-formatted versions of the bts-#.cdf and cbsc-#.cdf
files on the diskette by entering the following command:

unix2dos <source filename> /floppy/no_name/<target filename>
(e.g., unix2dos bts-248.cdf /floppy/no_name/bts-248.cdf).

NOTE
� Other versions of Unix do not support the unix2dos and dos2unix commands. In these cases,

use the Unix cp (copy) command. The copied files will be difficult to read with a DOS or
Windows text editor because Unix files do not contain line feed characters. Editing copied CDF
files on the LMF computer is, therefore, not recommended.

� Using cp, multiple files can be copied in one operation by separating each filename to be copied
with a space and ensuring the destination directory (floppy/no_name) is listed at the end of the
command string following a space (e.g., cp  bts-248.cdf cbsc-6.cdf /floppy/na_name).

8 Repeat steps 5 through 7 for each bts-# that must be supported by the LMF.

9 When all required files have been copied to the diskette, type eject and press the <Enter> key.

10 Remove the diskette from the CBSC.

AT THE LMF:

11 Start the Windows operating system.

12 Insert the diskette into the LMF.

13 Using Windows Explorer (or equivalent program), create a corresponding bts-# folder in the
<lmf home directory>\cdma directory for each bts-#.cdf/cbsc-#.cdf file pair copied from the
CBSC.

14 Use Windows Explorer (or equivalent program) to transfer the cbsc-#.cdf  and bts-#.cdf  files from
the diskette to the corresponding <lmf home directory>\cdma\bts-#  folders created in step 13.

 

Creating a Named HyperTerminal Connection for MMI Connection

Confirming or changing the configuration data of certain BTS Field
Replaceable Units (FRUs) requires establishing an MMI communication
session between the LMF and the FRU. Using features of the Windows
operating system, the connection properties for an MMI session can be
saved on the LMF computer as a named Windows HyperTerminal
connection. This eliminates the need for setting up connection
parameters each time an MMI session is required to support
optimization.

Once the named connection is saved, a shortcut for it can be created on
the Windows desktop. Double clicking the shortcut icon will start the
connection without the need to negotiate multiple menu levels.

Follow the procedure in Table 3-5 to establish a named HyperTerminal
connection and create a WIndows desktop shortcut for it.
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Table 3-5: Creating a Named Hyperlink Connection for MMI Connection

Step Action

1 From the Windows Start menu, select:

Programs>Accessories

2 Select Communications, double click the Hyperterminal folder, and then double click on the
Hyperterm.exe icon in the window that opens.

NOTE
� If a Location Information Window appears, enter the required information, then click  Close.

(This is required the first time, even if a modem is not to be used.)

� If a You need to install a modem..... message appears, click NO.

3 When the Connection Description box opens:

- Type a name for the connection being defined (e.g., MMI Session) in the Name: window.

- Highlight any icon preferred for the named connection in the Icon: chooser window.

- Click OK.

4

NOTE
For LMF configurations where COM1 is used by another interface such as test equipment and a
physical port is available for COM2, select COM2 to prevent conflicts.

From the Connect using: pick list in the Connect To box displayed, select the RS-232 port to be used
for the connection (e.g., COM1 or COM2 (Win NT) - or Direct to Com 1 or Direct to Com 2 (Win
98), and click OK.

5 In the Port Settings tab of the COM# Properties window displayed, configure the RS-232 port
settings as follows:

� Bits per second: 9600

� Data bits: 8

� Parity: None

� Stop bits: 1

� Flow control: None

6 Click OK.

7 Save the defined connection by selecting:

File>Save

8 Close the HyperTerminal window by selecting:

File>Exit

9 Click Yes to disconnect when prompted.

10 Perform one of the following:

� If the Hyperterminal folder window is still open (Win 98) proceed to step 12

� From the Windows Start menu, select Programs > Accessories.

. . . continued on next page
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Table 3-5: Creating a Named Hyperlink Connection for MMI Connection

Step Action

11 Perform one of the following:

� For Win NT, select Hyperterminal and release any pressed mouse buttons.

� For Win 98, select Communications and double click the Hyperterminal folder.

12 Highlight the newly created connection icon by moving the cursor over it (Win NT) or clicking on it
(Win 98).

13 Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

14 From the pop-up menu displayed, select Create Shortcut(s) Here.

15 If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.

 

Folder Structure Overview

The LMF uses an <lmf home directory> folder that contains all of the
essential data for installing and maintaining the BTS. The list that
follows outlines the folder structure for the LMF. Except for the bts-nnn
folders, these folders are created as part of the the LMF installation.
Refer to the CDMA LMF Operator’s Guide for a complete description of
the folder structure.

Figure 3-3: LMF Folder Structure

version folder (A separate folder is
required for each different version; for
example, a folder name 2.8.1.1.1.5.)

loads folder

(C:)

x:\<lmf home directory> folder

cdma folder

code folder

data folder

BTS-nnn folders (A separate folder is
required for each BTS where bts-nnn is the
unique BTS number; for example, bts-163.)

NOTE The “loads” folder and all the folders below it are not available
from the LMF for Software Release 2.16.1.x. These folders may
be present as as a legacy from previous software versions or
downloaded from the CBSC/OMC-R.
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Pinging the Processors

For proper operation, the integrity of the Ethernet LAN A and B links
must be be verified. Figure 3-4 represents a typical BTS Ethernet
configuration. The drawing depicts one (of two identical) links, A and B.

Ping is a program that routes request packets to the LAN network
modules to obtain a response from the specified “targeted” BTS.

Figure 3-4: BTS LAN Interconnect Diagram
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Follow the procedure in Table 3-6 and refer to Figure 3-5 or Figure 3-6,
as required, to ping each processor (on both LAN A and LAN B) and
verify LAN redundancy is operating correctly.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.

NOTE The Ethernet LAN A and B cables must be installed on each
frame/enclosure before performing this test. All other processor
board LAN connections are made via the backplanes.
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Table 3-6: Pinging the Processors

� Step Action

1 If you have not already done so, connect the LMF to the BTS (see Table 3-2 on page 3-6).

2 From the Windows desktop, click the Start button and select Run.

3 In the Open box, type ping and the <MGLI IP address> (for example, ping 128.0.0.2).

NOTE
128.0.0.2 is the default IP address for MGLI-1 in field BTS units. 128.0.0.1 is the default IP
address for MGLI-2.

4 Click on the OK button.

5 If the connection is successful, text similar to the following is displayed:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

If there is no response the following is displayed:

Request timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI still fails to
respond, typical problems are shorted BNC to inter-frame cabling, open cables, crossed A and B
link cables, missing 50-Ohm terminators, or the MGLI itself.
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Figure 3-5: +27 V SC 4812T Starter Frame I/O Plate
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Figure 3-6: -48 V SC 4812T Starter Frame I/O Plate
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Using CDMA LMF

Basic LMF Operation

The CDMA LMF allows the user to work in the two following operating
environments, which are accessed using the specified desktop icon:

� Graphical User Interface (GUI) using the WinLMF icon

� Command Line Interface (CLI) using the WinLMF CLI icon

The GUI is the primary optimization and acceptance testing operating
environment. The CLI environment provides additional capability to the
user to perform manually controlled acceptance tests and audit the
results of optimization and calibration actions.

Basic operation of the LMF GUI  includes the following:

� Selecting and deselecting BTS devices

� Enabling devices

� Disabling devices

� Resetting devices

� Obtaining device status

� Sorting a status report window

For detailed information on performing these and other LMF operations,
refer to the CDMA LMF Operator’s Guide.

Graphical User Interface Overview

The LMF uses a GUI, which works in the following way:

� Select the device or devices.

� Select the action to apply to the selected device(s).

� While action is in progress, a status report window displays the action
taking place and other status information.

� The status report window indicates when the the action is complete
and displays other pertinent information.

� Clicking the OK button closes the status report window.
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Command Line Interface Overview

The LMF also provides Command Line Interface (CLI) capability.
Activate the CLI by clicking on a shortcut icon on the desktop. The CLI
can not be launched from the GUI, only from the desktop icon.

Both the GUI and the CLI use a program known as the handler. Only one
handler can be running at one time Due to architectural limitations, the
GUI must be started before the CLI if you want the GUI and CLI to use
the same handler. When the CLI is launched after the GUI, the CLI
automatically finds and uses an in-progress login session with a BTS
initiated under the GUI. This allows the use of the GUI and the CLI in
the same BTS login session. If a CLI handler is already running when
the GUI is launched (this happens if the CLI window is already running
when the user starts the GUI, or if another copy of the GUI is already
running when the user starts the GUI), a dialog window displays the
following warning message:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure that you want to start the application?

This window also contains yes and no buttons. Selecting yes starts the
application. Selecting no terminates the application.

CLI Format Conventions

The CLI command can be broken down in the following way:

� verb

� device including device identifier parameters

� switch

� option parameters consisting of:

- keywords

- equals signs (=) between the keywords and the parameter values

- parameter values

Spaces are required between the verb, device, switch, and option
parameters. A hyphen is required between the device and its identifiers.
Following is an example of a CLI command.

measure bbx-<bts_id>- <bbx_id> rssi channel=6 sector=5

Refer to LMF CLI Commands for a complete explanation of the CLI
commands and their usage.
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Logging into a BTS

NOTE Be sure that the correct bts-#.cdf and cbsc-#.cdf file is used for
the BTS. These should be the CDF files that are provided for the
BTS by the CBSC. Failure to use the correct CDF files can
result in invalid optimization. Failure to use the correct CDF
files to log into a live (traffic carrying) site can shut down the
site.

Logging into a BTS establishes a communications link between the BTS
and the CDMA LMF. You may be logged into more than one BTS at a
time, but only one LMF may be logged into each BTS.

Before attempting to log into the BTS, confirm the CDMA LMF is
properly connected to the BTS (see Figure 3-2).

Prerequisites

Before attempting to login to a BTS, ensure the following have been
completed:

� The LMF operating system is correctly installed and prepared.

� A bts-nnn folder with the correct CDF and CBSC file exists.

� The LMF is correctly installed and prepared, and the LMF computer is
connected to the BTS before starting the Windows operating system
and LMF software. If necessary, restart the computer after connecting
it to the BTS (see Table 3-2 and Figure 3-2).

BTS Login from the GUI Environment

Follow the procedure in Table 3-7 to log into a BTS when using the GUI
environment.

Table 3-7: BTS GUI Login Procedure

Step Action

1 Start the CDMA LMF GUI environment by double clicking on the WinLMF desktop icon (if the LMF
is not running).

NOTE
If a warning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the CDMA LMF GUI environment again:

The CLI handler is already running.

This may cause conflicts with the LMF

Are you sure you want to start the application?

Yes No

2 Click on the Login tab (if not displayed).

3 If no base stations are displayed in the Available Base Stations pick list, double click on the CDMA
icon.

. . . continued on next page
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Table 3-7: BTS GUI Login Procedure

Step Action

4 Click on the desired BTS number.

5 Click on the Network Login tab (if not already in the forefront).

6 Enter the correct IP address (normally 128.0.0.2 for a field BTS) if not correctly displayed in the IP
Address box.

NOTE
128.0.0.2 is the default IP address for MGLI-1 in field BTS units. 128.0.0.1 is the default IP address
for MGLI-2.

7 Type in the correct IP Port number (normally 9216) if not correctly displayed in the IP Port box.

8 Click on Ping.

- If the connection is successful, the Ping Display window shows text similar to the following:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

- If there is no response the following is displayed:

128.0.0.2:9216:Timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI still fails to
respond, typical problems are shorted BNC to inter-frame cabling, open cables, crossed A and B link
cables, missing 50-Ohm terminators, or the MGLI itself.

9 Change the Multi-Channel Preselector (from the Multi-Channel Preselector pick list), normally
MPC, corresponding to your BTS configuration, if required.

NOTE
When performing RX tests on expansion frames, do not choose EMPC if the test equipment is
connected to the starter frame.

10 Click on the Use a Tower Top Amplifier, if applicable.

11 Click on Login.

A BTS tab with the BTS is displayed.

NOTE
� If you attempt to login to a BTS that is already logged on, all devices will be gray.

� There may be instances where the BTS initiates a log out due to a system error (i.e., a device
failure).

� If the MGLI is OOS_ROM (blue), it will have to be downloaded with code before other devices can
be seen.

� If the MGLI is OOS-RAM (yellow), it must be enabled before other installed devices can be seen.
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BTS Login from the CLI Environment

Follow the procedure in Table 3-8 to log into a BTS when using the CLI
environment.

NOTE The GUI and CLI environments use the same connection to a
BTS. If a GUI and the CLI session are running for the same BTS
at the same time, logging out of the BTS in either environment
will log out of it for both. When either a login or logout is
performed in the CLI window, there is no GUI indication that
logout has occurred.

Table 3-8: BTS CLI Login Procedure

Step Action

1 Double click the WinLMF CLI desktop icon (if the LMF CLI environment is not already running).

NOTE
If a BTS was logged into under a GUI session when the CLI environment was started, the CLI session
will be logged into the same BTS, and step 2 is not required.

2 At the /wlmf prompt, enter the following command:

login bts-<bts#> host=<host> port=<port>
where:

host = MGLI card IP address (defaults to address last logged into for this BTS or 128.0.0.2 if this is
first login to this BTS).

port = IP port of the BTS (defaults to port last logged into for this BTS or 9216 if this is first login to
this BTS).

A response similar to the following will be displayed:

LMF>
13:08:18.882 Command Received and Accepted
             COMMAND=login bts-33

13:08:18.882 Command In Progress

13:08:21.275 Command Successfully Completed
             REASON_CODE=”No Reason”
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Logging Out

Logging out of a BTS is accomplished differently for the GUI and the
CLI operating environments.

NOTE The GUI and CLI environments use the same connection to a
BTS. If a GUI and the CLI session are running for the same BTS
at the same time, logging out of the BTS in either environment
will log out of it for both. When either a login or logout is
performed in the CLI window, there is no GUI indication that
logout has occurred.

Logging Out of a BTS from the GUI Environment

Follow the procedure in Table 3-9 to logout of a BTS when using the
GUI environment.

Table 3-9: BTS GUI Logout Procedure

Step Action

1 Click on BTS on the BTS tab menu bar.

2 Click the Logout item in the pull-down menu.

A Confirm Logout pop-up message appears.

3 Click on Yes or press the <Enter> key to confirm logout.

You are returned to the Login tab.

NOTE
If a logout was previously performed on the BTS from a CLI window running at the same time as the
GUI, a Logout Error pop-up message appears stating the system should not log out of the BTS.
When this occurs, the GUI must be exited and restarted before it can be used for further operations.

4 If a Logout Error pop-up message appears stating that the system could not log out of the Base
Station because the given BTS is not logged in, perform the following actions:

- Click OK.

- Select File>Exit in the window menu bar.

- Click Yes in the Confirm Logout pop-up.

- Click Yes in the Logout Error pop-up which appears again.

5 If further work is to be done in the GUI, restart it.

NOTE
� The Logout item on the BTS menu bar will only log you out of the displayed BTS.

� You can also log out of all BTS sessions and exit LMF by clicking on the File selection in the menu
bar and selecting Exit from the File menu list. A Confirm Logout pop-up message will appear.
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Logging Out of a BTS from the CLI Environment

Follow the procedure in Table 3-9 to logout of a BTS when using the
CLI environment.

Table 3-10: BTS CLI Logout Procedure

Step Action

NOTE
If the BTS is also logged into from a GUI running at the same time and further work must be done
with it in the GUI, proceed to step 2.

1 Logout of a BTS by entering the following command:

logout bts-<bts#>
A response similar to the following is displayed:

LMF>

12:22:58.028 Command Received and Accepted
            Command=logout bts-33

12:22:58.028 Command Received and Accepted

12:22:58.028 Command Successfully Completed
            REASON_CODE=”No Reason”

2 If desired, close the CLI interface by entering the following command:

exit
A response similar to the following is displayed before the window closes:

Killing background processes....
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Establishing an MMI Communication Session
For those procedures that require MMI communications between the
LMF and BTS FRUs, follow the procedure in Table 3-11 to initiate the
communication session.

NOTE If the LMF GUI is running and the LMF is logged into a BTS,
the LMF cannot initiate a hyperterminal session on the COM
port normally used to communicate with the test equipment.
Also, if the LMF has only one COM port, you cannot operate
test equipment and have a hyperterminal session running at the
same time.

Table 3-11: Establishing MMI Communications

Step Action

1 Connect the LMF computer to the equipment as detailed in the applicable procedure that requires the
MMI communication session.

2 Start the named HyperTerminal connection for MMI sessions by double clicking on its desktop
shortcut.

NOTE
If a desktop shortcut was not created for the MMI connection, access the connection from the Start
menu by selecting:

Programs>Accessories>Hyperterminal>HyperTerminal><Named HyperTerminal Connection
(e.g., MMI Session).

3 Once the connection window opens, establish MMI communication with the BTS FRU by pressing
the LMF computer <Enter> key until the prompt identified in the applicable procedure is obtained.

 

Figure 3-7: CDMA LMF Computer Common MMI Connections
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Download the BTS

Download the BTS - Overview

Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code is loaded in all devices during
manufacture or factory repair. Device application (RAM) code and data
must be downloaded to each equipped device by the user before the BTS
can be made fully functional for the site where it is installed.

ROM Code

Downloading ROM code to BTS devices from the LMF is NOT routine
maintenance nor a normal part of the optimization process. It is only
done in unusual situations where the resident ROM code in the device
does not match the release level of the site operating software AND the
CBSC cannot communicate with the BTS to perform the download. If
you must download ROM code, refer to Appendix H.

Before ROM code can be downloaded from the LMF, the correct ROM
code file for each device to be loaded must exist on the LMF computer.

NOTE The ROM code file is not available for GLI3s. GLI3s are ROM
code loaded at the factory.

RAM Code

Before RAM code can be downloaded from the CDMA LMF, the correct
RAM code file for each device must exist on the LMF computer. RAM
code can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the CDMA LMF file structure. The RAM code file is selected
automatically if the file is in the \lmf\cdma\loads\n.n.n.n\code folder
(where n.n.n.n is the version number of the download code). The RAM
code file in the code folder must have the correct hardware bin number.

RAM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to OOS-ROM
(blue). When the download is completed successfully, the device
changes to OOS-RAM (yellow). When code is downloaded to an MGLI,
the LMF automatically also downloads data, and then enables the MGLI.
When enabled, the MGLI changes to INS (green).

For non-MGLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS-RAM
(yellow).
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Download Code to Devices

Code can be downloaded to a device that is in any state. After the
download starts, the device being downloaded changes to
OOS_ROM (blue). If the download is completed successfully, the device
changes to OOS_RAM with code loaded (yellow). Prior to downloading
a device, a code file must exist. The code file is selected automatically if
the code file is in the /lmf/cdma/n.n.n.n/code folder (where n.n.n.n is the
version number of the download code that matches the “NextLoad”
parameter in the CDF file). The code file in the code folder must have
the correct hardware bin number. Code can be automatically or manually
selected.

The following are the devices to be downloaded:

� Span Configuration

- Master Group Line Interface (MGLI2 or MGLI3)

- Group Line Interface (GLI2 or GLI3)

� Clock Synchronization Module (CSM)

� Multi Channel Card (MCC24E, MCC8E or MCC-1X)

� Broadband Transceiver (BBX2 or BBX-1X)

� Test Subscriber Interface Card (TSIC) - if RFDS is installed

NOTE The MGLI must be successfully downloaded with code and data,
and put INS before downloading any other device. The
download code process for an MGLI automatically downloads
data and enables the MGLI before downloading other devices.
The other devices can be downloaded in any order.

Follow the procedure in Table 3-12 to download the firmware
application code for the MGLI. The download code action downloads
data and also enables the MGLI.

Prerequisite

Prior to performing this procedure, ensure a code file exists for each of
the devices to be downloaded.

Table 3-12: Download and Enable MGLI

� Step Action

1 Select Tools>Update Next Load>CDMA function to ensure the Next Load parameter is set to the
correct code version level.

2 Download code to the primary MGLI by clicking on the MGLI.

- From the Device pull down menu, select Download>Code/Data.
A status report confirms change in the device(s) status.

- Click OK to close the status window. (The MGLI should automatically be downloaded with
data and enabled.)

3 Download code and data to the redundant MGLI but do not enable at this time.
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Download Code and Data to Non-GLI Devices
Non-GLI  devices can be downloaded individually or all equipped
devices can be downloaded with one action. Follow the procedure in
Table 3-13 to download code and data to the non-GLI devices.

NOTE - When downloading multiple devices, the download may
fail for some of the devices (a time out occurs). These
devices can be downloaded separately after completing the
multiple download.

- CSM devices are RAM code-loaded at the factory. RAM
code is downloaded to CSMs only if updating to a newer
software version.

Table 3-13: Download Code and Data to Non-GLI Devices

� Step Action

1 Select all devices to be downloaded.

2 From the Device pull down menu, select Download>Code/Data.

A status report displays the result of the download for each selected device.

Click OK to close the status window.

NOTE
After the download has started, the device being downloaded changes to blue. If the download is
completed successfully, the device changes to yellow (OOS-RAM with code loaded).

After a BBX, CSM or MCC is successfully downloaded with code and has changed to
OOS-RAM, the status LED should be rapidly flashing GREEN.

NOTE
The command in Step 2 loads both code and data. Data can be downloaded without doing a code
download anytime a device is OOS-RAM using the command in Step 3.

3 To download the firmware application data to each device, select the target device and select:
Device>Download>Data
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Select CSM Clock Source
A CSM can have three different clock sources. The Clock Source
function can be used to select the clock source for each of the three
inputs. This function is only used if the clock source for a CSM needs to
be changed. The Clock Source function provides the following clock
source options:

� Local GPS

� Mate GPS

� Remote GPS

� HSO (only for sources 2 & 3)

� HSO Extender

� HSOX (only for sources 2 & 3)

� LFR (only for sources 2 & 3)

� 10 MHz (only for sources 2 & 3)

� NONE (only for sources 2 & 3)

Prerequisites

MGLI=INS_ACT

CSM= OOS_RAM or INS_ACT

Follow the procedure in Table 3-14 to select a CSM Clock Source.

Table 3-14: Select CSM Clock Source

Step Action

1 Select the applicable CSM(s).

2 Click on the Device menu.

3 Click on the CSM/MAWI menu item.

4 Click on the Select Clock Source menu item.

A clock source selection window is displayed.

5 Select the applicable clock source in the Clock Reference Source pick lists.

Uncheck the related check box if you do not want the displayed pick list item to be used.

6 Click on the OK button.

A status report window displays the results of the selection action.

7 Click on the OK button to close the status report window.
 

Enable CSMs
Each BTS CSM system features two CSM boards per site. In a typical
operation, the primary CSM locks its Digital Phase Locked Loop
(DPLL) circuits to GPS signals. These signals are generated by either an
on-board GPS module (RF-GPS) or a remote GPS receiver (R-GPS).
The CSM2 card is required when using the R-GPS. The GPS receiver
(mounted on CSM-1) is the primary timing reference and synchronizes
the entire cellular system. CSM-2 provides redundancy but does not
have a GPS receiver.
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The BTS may be equipped with a remote GPS, LORAN-C LFR, HSO
10 MHz Rubidium source, or HSOX for expansion frames, which the
CSM can use as a secondary timing reference. In all cases, the CSM
monitors and determines what reference to use at a given time.

NOTE - CSMs are code loaded at the factory. This data is retained
in EEPROM. The download code procedure is required in
the event it becomes necessary to code load CSMs with
updated software versions. Use the status function to
determine the current code load versions.

- For non-RGPS sites only, verify the CSM configured with
the GPS receiver “daughter board” is installed in the
CSM-1 slot before continuing.

- The CSM(s) to be enabled must have been downloaded
with code (Yellow, OOS-RAM) and data.

Follow the procedure in Table 3-15 to enable the CSMs.

Table 3-15: Enable CSMs

� Step Action

1 Verify the CSM(s) have been downloaded with code (Yellow, OOS-RAM) and data.

2 Click on the target CSM.

From the Device pull down, select Enable.

NOTE
If equipped with two CSMs, enable CSM-2 first and then CSM-1.

A status report confirms change in the device(s) status.

Click OK to close the status window.

NOTE
FAIL may be shown in the status table for enable action. If Waiting For Phase Lock is shown in
the Description field, the CSM changes to the enabled state after phase lock is achieved. CSM-1
houses the GPS receiver. The enable sequence can take up to one hour to complete.

NOTE
The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and
operated by the United States Department of Defense (D.O.D.). The D.O.D. periodically alters
satellite orbits; therefore, satellite trajectories are subject to change. A GPS receiver that is INS
contains an “almanac” that is updated periodically to take these changes into account.

If an installed GPS receiver has not been updated for a number of weeks, it may take up to one
hour for the GPS receiver “almanac” to be updated.

Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3-D position
fix for a minimum of 45 seconds before the CSM will come in-service. (In some cases, the GPS
receiver needs to track only one satellite, depending on accuracy mode set during the data load.)

NOTE
If equipped with two CSMs, the LMF should display CSM-1 as bright GREEN (INS-ACT) and
CSM-2 as dark green (INS-STB). After the CSMs have been successfully enabled, the
PWR/ALM LEDs are steady green (alternating green/red indicates the card is in an alarm state).

3 If more than an hour has passed, refer to Table 3-19 and Table 3-20 to determine the cause.
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Enable MCCs

This procedure configures the MCC and sets the “TX fine adjust”
parameter. The “TX fine adjust” parameter is not a transmit gain setting,
but a timing adjustment that compensates for the processing delay in the
BTS (approximately 3 �s).

Follow the procedure in Table 3-16 to enable the MCCs.

NOTE The MGLI and primary CSM must be downloaded and enabled
(IN-SERVICE ACTIVE) before downloading and enabling the
MCC.

Table 3-16: Enable MCCs

� Step Action

1 Verify the MCC(s) have been downloaded with code (Yellow, OOS-RAM) and data.

2 Select the MCCs to be enabled or from the Select pull-down menu choose MCCs.

3 From the Device menu, select Enable

A status report confirms change in the device(s) status.

4 Click on OK to close the status report window.

Enable Redundant GLIs

Follow the procedure in Table 3-17 to enable the redundant GLI(s).

Table 3-17: Enable Redundant GLIs

� Step Action

1 Select the target redundant GLI(s).

2 From the Device menu, select Enable.

A status report window confirms the change in the device(s) status and the enabled GLI(s) is
green.

3 Click on OK to close the status report window.
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CSM System Time/GPS and LFR/HSO Verification

CSM & LFR Background

The primary function of the Clock Synchronization Manager (CSM)
boards (slots 1 and 2) is to maintain CDMA system time. The CSM in
slot 1 is the primary timing source while slot 2 provides redundancy. The
CSM2 card (CSM second generation) is required when using the remote
GPS receiver (R-GPS). R-GPS uses a GPS receiver in the antenna head
that has a digital output to the CSM2 card. CSM2 can have a daughter
card as a local GPS receiver to support an RF-GPS signal.

The CSM2 switches between the primary and redundant units (slots 1
and 2) upon failure or command. CDMA Clock Distribution
Cards (CCDs) buffer and distribute even-second reference and 19.6608
MHz clocks. CCD-1 is married to CSM-1 and CCD-2 is married to
CSM 2. A failure on CSM-1 or CCD-1 cause the system to switch to
redundant CSM-2 and CCD-2.

In a typical operation, the primary CSM locks its Digital Phase Locked
Loop (DPLL) circuits to GPS signals. These signals are generated by
either an on-board GPS module (RF-GPS) or a remote GPS receiver
(R-GPS). The CSM2 card is required when using the R-GPS. DPLL
circuits employed by the CSM provide switching between the primary
and redundant unit upon request. Synchronization between the primary
and redundant CSM cards, as well as the LFR or HSO back-up source,
provides excellent reliability and performance.

Each CSM board features an ovenized, crystal oscillator that provides
19.6608 MHz clock, even second tick reference, and 3 MHz sinewave
reference, referenced to the selected synchronization source (GPS,
LORAN-C Frequency Receiver (LFR), or High Stability Oscillator
(HSO), T1 Span, or external reference oscillator sources). The 3 MHz
signals are also routed to the RDM EXP 1A & 1B connectors on the top
interconnect panel for distribution to co-located frames at the site.

Fault management has the capability of switching between the GPS
synchronization source and the LFR/HSO backup source in the event of
a GPS receiver failure on CSM-1. During normal operation, the CSM-1
board selects GPS as the primary source (see Table 3-19). The source
selection can also be overridden via the LMF or by the system software.

All boards are mounted in the C-CCP shelf at the top of the BTS frame.
Figure 1-10 on page 1-28 illustrates the location of the boards in the
BTS frame.
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Low Frequency Receiver/
High Stability Oscillator

The CSM handles the overall configuration and status monitoring
functions of the LFR/HSO. In the event of GPS failure, the LFR/HSO is
capable of maintaining synchronization initially established by the GPS
reference signal.

The LFR requires an active external antenna to receive LORAN RF
signals. Timing pulses are derived from this signal, which is
synchronized to Universal Time Coordinates (UTC) and GPS time. The
LFR can maintain system time indefinitely after initial GPS lock.

The HSO is a high stability 10 MHz oscillator with the necessary
interface to the CSMs. The HSO is typically installed in those
geographical areas not covered by the LORAN-C system. Since the
HSO is a free-standing oscillator, system time can only be maintained
for 24 hours after 24 hours of GPS lock.

Upgrades and Expansions: LFR2/HSO2/HSOX

LFR2/HSO2 (second generation cards) both export a timing signal to the
expansion or logical BTS frames. The associated expansion or logical
frames require an HSO-expansion (HSOX) whether the starter frame has
an LFR2 or an HSO2. The HSOX accepts input from the starter frame
and interfaces with the CSM cards in the expansion frame. LFR and
LFR2 use the same source code in source selection (see Table 3-18).
HSO, HSO2, and HSOX use the same source code in source selection
(see Table 3-18).

NOTE Allow the base site and test equipment to warm up for 60
minutes after any interruption in oscillator power. CSM board
warm-up allows the oscillator oven temperature and oscillator
frequency to stabilize prior to test. Test equipment warm-up
allows the Rubidium standard timebase to stabilize in frequency
before any measurements are made.

Front Panel LEDs

The status of the LEDs on the CSM boards are as follows:

� Steady Green - Master CSM locked to GPS or LFR (INS).

� Rapidly Flashing Green - Standby CSM locked to GPS or LFR
(STBY).

� Flashing Green/Rapidly Flashing Red - CSM OOS-RAM attempting
to lock on GPS signal.

� Rapidly Flashing Green and Red - Alarm condition exists. Trouble
Notifications (TNs) are currently being reported to the GLI.
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CSM Frequency Verification

The objective of this procedure is the initial verification of the CSM
boards before performing the RF path verification tests. Parts of this
procedure will be repeated for final verification after the overall
optimization has been completed.

Null Modem Cable
A null modem cable is required. It is connected between the MMI port
of the primary CSM and the null modem board. Figure 3-8 shows the
wiring detail for the null modem cable.

Figure 3-8: Null Modem Cable Detail
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Prerequisites

Ensure the following prerequisites have been met before proceeding:

� The LMF is NOT logged into the BTS.

� The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.

Test Equipment Setup: GPS & LFR/HSO Verification

Follow the procedure in Table 3-18 to set up test equipment while
referring to Figure 3-9 as required.

Table 3-18: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

1 Perform one of the following operations:

� For local GPS (RF-GPS), verify a CSM board with a GPS receiver is installed in primary CSM
slot 1 and that CSM-1 is INS.
This is verified by checking the board ejectors for kit number SGLN1145 on the board in slot 1.

� For Remote GPS (RGPS), verify a CSM2 board is installed in primary slot 1 and that CSM-1 is
INS.
This is verified by checking the board ejectors for kit number SGLN4132ED (or later).

2 Remove CSM-2 (if installed) and connect a serial cable from the LMF COM 1 port (via null modem
board) to the MMI port on CSM-1.

3 Reinstall CSM-2.

. . . continued on next page
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Table 3-18: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

4 Start an MMI communication session with CSM-1 by using the Windows desktop shortcut icon (see
Table 3-5)

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

5 When the terminal screen appears, press the <Enter> key until the CSM> prompt appears.

 

Figure 3-9: CSM MMI terminal connection
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GPS Initialization/Verification

Follow the procedure in Table 3-19 to initialize and verify proper GPS
receiver operation.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� The LMF is not logged into the BTS.

� The COM1 port is connected to the MMI port of the primary CSM via
a null modem board (see Figure 3-9).

� The primary CSM and HSO (if equipped) have been warmed up for at
least 15 minutes.

CAUTION Connect the GPS antenna to the GPS RF connector ONLY.
Damage to the GPS antenna and/or receiver can result if the
GPS antenna is inadvertently connected to any other RF
connector.
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Table 3-19: GPS Initialization/Verification

Step Action

1 To verify that Clock alarms (0000), Dpll is locked and has a reference source, and
GPS self test passed messages are displayed within the report, issue the following MMI
command

bstatus

- Observe the following typical response:

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11

2 Enter the following command at the CSM> prompt to display the current status of the Loran and the
GPS receivers.

sources

- Observe the following typical response for systems equipped with LFR:

N Source Name Type TO Good Status Last Phase Target Phase Valid
-------------------------------------------------------------------------
0 LocalGPS Primary 4 YES Good 0 0 Yes
1 LFR CHA Secondary 4 YES Good -2013177 -2013177 Yes
2 Not Used
Current reference source number: 0

- Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
----------------------------------------------------------------------------
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 No N/A timed-out* Timed-out* No

*NOTE “Timed-out” should only be displayed while the HSO is warming up.  “Not-Present” or
“Faulty” should not be displayed.  If the HSO does not appear as one of the sources, then configure the
HSO as a back-up source by entering the following command at the CSM> prompt:

ss 1 12

After a maximum of 15 minutes, the Rubidium oscillator should reach operational temperature and the
LED on the HSO should now have changed from red to green.  After the HSO front panel LED has
changed to green, enter sources <cr> at the CSM> prompt.  Verify that the HSO is now a valid
source by confirming that the bold text below matches the response of the “sources” command.

The HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO rubidium
oscillator is fully warmed.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
----------------------------------------------------------------------------
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxxxxx xxxxxxxxxx Yes

3 HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If this is not the case, have the OMCR determine the correct BTS timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

. . . continued on next page
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Table 3-19: GPS Initialization/Verification

Step Action

4 If any of the above mentioned areas fail, verify:

- If LED is RED, verify that HSO had been powered up for at least 5 minutes. After oscillator
temperature is stable, LED should go GREEN Wait for this to occur before continuing !

- If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

- Verify the HSO is FULLY SEATED and LOCKED to prevent any possible board warpage

5 Verify the following GPS information (underlined text above):

- GPS information is usually the 0 reference source.

- At least one Primary source must indicate “Status = good” and “Valid = yes” to bring site up.

6 Enter the following command at the CSM> prompt to verify that the GPS receiver is in tracking mode.

gstatus

- Observe the following typical response:

24:06:08 GPS Receiver Control Task State: tracking satellites.
24:06:08 Time since last valid fix: 0 seconds.
24:06:08 
24:06:08 Recent Change Data:
24:06:08 Antenna cable delay 0 ns.
24:06:08 Initial position: lat 117650000 msec, lon -350258000 msec, height 0 cm (GPS)
24:06:08 Initial position accuracy (0): estimated.
24:06:08 
24:06:08 GPS Receiver Status:
24:06:08 Position hold:  lat 118245548 msec, lon -350249750 msec, height 20270 cm
24:06:08 Current position: lat 118245548 msec, lon -350249750 msec, height 20270 cm
(GPS)
24:06:08 8 satellites tracked, receiving 8 satellites, 8 satellites visible.
24:06:08 Current Dilution of Precision (PDOP or HDOP): 0.
24:06:08 Date & Time: 1998:01:13:21:36:11
24:06:08 GPS Receiver Status Byte: 0x08
24:06:08 Chan:0, SVID: 16, Mode: 8, RSSI: 148, Status: 0xa8
24:06:08 Chan:1, SVID: 29, Mode: 8, RSSI: 132, Status: 0xa8
24:06:08 Chan:2, SVID: 18, Mode: 8, RSSI: 121, Status: 0xa8
24:06:08 Chan:3, SVID: 14, Mode: 8, RSSI: 110, Status: 0xa8
24:06:08 Chan:4, SVID: 25, Mode: 8, RSSI:  83, Status: 0xa8
24:06:08 Chan:5, SVID:  3, Mode: 8, RSSI:  49, Status: 0xa8
24:06:08 Chan:6, SVID: 19, Mode: 8, RSSI: 115, Status: 0xa8
24:06:08 Chan:7, SVID: 22, Mode: 8, RSSI: 122, Status: 0xa8
24:06:08 
24:06:08 GPS Receiver Identification:
24:06:08 COPYRIGHT 1991-1996 MOTOROLA INC. 
24:06:08 SFTW P/N # 98-P36830P      
24:06:08 SOFTWARE VER # 8           
24:06:08 SOFTWARE REV # 8           
24:06:08 SOFTWARE DATE  6 AUG 1996 
24:06:08 MODEL #    B3121P1115      
24:06:08 HDWR P/N # _               
24:06:08 SERIAL #   SSG0217769      
24:06:08 MANUFACTUR DATE 6B07       
24:06:08 OPTIONS LIST    IB        
24:06:08 The receiver has 8 channels and is equipped with TRAIM.

. . . continued on next page
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Table 3-19: GPS Initialization/Verification

Step Action

7 Verify the following GPS information (shown above in underlined text):

- At least 4 satellites are tracked, and 4 satellites are visible.

- GPS Receiver Control Task State is “tracking satellites”. Do not continue until this occurs!

- Dilution of Precision indication is not more that 30.

Record the current position base site latitude, longitude, height and height reference (height reference
to Mean Sea Level (MSL) or GPS height (GPS).  (GPS = 0   MSL = 1).

8 If steps 1 through 7 pass, the GPS is good.

NOTE
If any of the above mentioned areas fail, verify that:

- If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be  tracked and visible if actual lat, log, and height data for this site has
been entered into CDF file).

- If Initial position accuracy is “surveyed”, position data currently in the CDF file is assumed to be
accurate. GPS will not automatically survey and update its position.

- The GPS antenna is not obstructed or misaligned.

- GPS antenna connector center conductor measures approximately +5 Vdc with respect to the
shield.

- There is no more than 4.5 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

- Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

9 Enter the following commands at the CSM> prompt to verify that the CSM is warmed up and that GPS
acquisition has taken place.

debug dpllp 

Observe the following typical response if the CSM is not warmed up (15 minutes from application of
power)  (If warmed-up proceed to step 10)

CSM>DPLL Task Wait. 884 seconds left.
DPLL Task Wait. 882 seconds left.
DPLL Task Wait. 880 seconds left.   ...........etc.

NOTE
The warm command can be issued at the MMI port used to force the CSM into warm-up, but the
reference oscillator will be unstable.

. . . continued on next page
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Table 3-19: GPS Initialization/Verification

Step Action

10 Observe the following typical response if the CSM is warmed up.

c:17486 off: -11, 3, 6 TK SRC:0 S0: 3 S1:-2013175,-2013175
c:17486 off: -11, 3, 6 TK SRC:0 S0: 3 S1:-2013175,-2013175
c:17470 off: -11, 1, 6 TK SRC:0 S0: 1 S1:-2013175,-2013175
c:17486 off: -11, 3, 6 TK SRC:0 S0: 3 S1:-2013175,-2013175
c:17470 off: -11, 1, 6 TK SRC:0 S0: 1 S1:-2013175,-2013175
c:17470 off: -11, 1, 6 TK SRC:0 S0: 1 S1:-2013175,-2013175

11 Verify the following GPS information (underlined text above, from left to right):

- Lower limit offset from tracked source variable is not less than -60 (equates to 3µs limit).

- Upper limit offset from tracked source variable is not more than +60 (equates to 3µs limit).

- TK SRC: 0 is selected, where SRC 0 = GPS.

12 Enter the following commands at the CSM> prompt to exit the debug mode display.

debug dpllp

 

LFR Initialization/Verification
The LORAN-C LFR is a full size card that resides in the C-CCP Shelf.
The LFR is a completely self-contained unit that interfaces with the
CSM via a serial communications link. The CSM handles the overall
configuration and status monitoring functions of the LFR.

The LFR receives a 100 kHz, 35 kHz BW signal from up to 40 stations
(8 chains) simultaneously and provides the following major functions:

� Automatic antenna pre-amplifier calibration (using a second
differential pair between LFR and LFR antenna)

� A 1 second ±200 ηs strobe to the CSM

If the BTS is equipped with an LFR, follow the procedure in Table 3-20
to initialize the LFR and verify proper operation as a backup source for
the GPS.

NOTE If CSMRefSrc2 = 2 in the CDF file, the BTS is equipped with
an LFR. If CSMRefSrc2 = 18, the BTS is equipped with an
HSO.
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Table 3-20: LFR Initialization/Verification

Step Action Note

1 At the CSM> prompt, enter lstatus <cr> to verify that the LFR is in tracking
mode. A typical response is:

CSM> lstatus <cr>
LFR St ti St tLFR Station Status:
Clock coherence: 512 >
5930M 51/60 dB 0 S/N Flag:
5930X 52/64 dn -1 S/N Flag:
5990 47/55 dB -6 S/N Flag:
7980M 62/66 dB 10 S/N Fl

This must be greater
than 100 before LFR
becomes a valid source.

7980M 62/66 dB 10 S/N Flag:
7980W 65/69 dB 14 S/N Flag: . PLL Station . >
7980X 48/54 dB -4 S/N Flag:
7980Y 46/58 dB -8 S/N Flag:E
7980Z 60/67 dB 8 S/N Flag:
8290M 50/65 dB 0 S/N Flag

This shows the LFR is
locked to the selected
PLL station.

8290M 50/65 dB 0 S/N Flag:
8290W 73/79 dB 20 S/N Flag:
8290W 58/61 dB 6 S/N Flag:8290W 58/61 dB 6 S/N Flag:
8970M 89/95 dB 29 S/N Flag:
8970W 62/66 dB 10 S/N Flag:
8970X 73/79 dB 22 S/N Flag:8970X 73/79 dB 22 S/N Flag:
8970Y 73/79 dB 19 S/N Flag:
8970Z 62/65 dB 10 S/N Flag:
9610M 62/65 dB 10 S/N Fl

g
9610M 62/65 dB 10 S/N Flag:
9610V 58/61 dB 8 S/N Flag:
9610W 47/49 dB -4 S/N Flag:E9610W 47/49 dB -4 S/N Flag:E
9610X 46/57 dB -5 S/N Flag:E
9610Y 48/54 dB -5 S/N Flag:E
9610Z 65/69 dB 12 S/N Flag9610Z 65/69 dB 12 S/N Flag:
9940M 50/53 dB -1 S/N Flag:S
9940W 49/56 dB -4 S/N Flag:E9940W 49/56 dB 4 S/N Flag:E
9940Y 46/50 dB-10 S/N Flag:E
9960M 73/79 dB 22 S/N Flag:
9960W 51/60 dB 0 S/N Flag:9960W 51/60 dB 0 S/N Flag:
9960X 51/63 dB -1 S/N Flag:
9960Y 59/67 dB 8 S/N Flag:
9960Z 89/96 dB 29 S/N Fl9960Z 89/96 dB 29 S/N Flag:

LFR Task State: lfr locked to station 7980W
LFR Recent Change Data:

Search List: 5930 5990 7980 8290 8970 9940 9610 9960 >
PLL GRI: 7980W

LFR Master, reset not needed, not the reference source.
CSM>

This search list and PLL
data must match the
configuration for the
geographical location
of the cell site.

2 Verify the following LFR information (highlighted above in boldface type):

- Locate the “dot” that indicates the current phase locked station assignment (assigned by MM).

- Verify that the station call letters are as specified in site documentation as well as M X Y Z
assignment.

- Verify the signal to noise (S/N) ratio of the phase locked station is greater than 8.

3 At the CSM> prompt, enter sources <cr> to display the current status of the the LORAN receiver.

- Observe the following typical response.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
----------------------------------------------------------------------------
0 Local GPS Primary 4 Yes Good -3 0 Yes
1 LFR ch A Secondary 4 Yes Good -2013177 -2013177 Yes
2 Not used
Current reference source number: 1

. . . continued on next page
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Table 3-20: LFR Initialization/Verification

Step NoteAction

4 LORAN-C LFR information (highlighted above in boldface type) is usually the #1 reference source
(verified from left to right).

NOTE
If any of the above mentioned areas fail, verify:

- The LFR antenna is not obstructed or misaligned.

- The antenna pre-amplifier power and calibration twisted pair connections are intact and < 91.4 m
(300 ft) in length.

- A dependable connection to suitable Earth Ground is in place.

- The search list and PLL station for cellsite location are correctly configured .

NOTE
LFR functionality should be verified using the “source” command (as shown in Step 3). Use the
underlined responses on the LFR row to validate correct LFR operation.

5 Close the Hyperterminal window.

 

HSO Initialization/Verification

The HSO module is a full-size card that resides in the C-CCP Shelf.
This completely self contained high stability 10 MHz oscillator
interfaces with the CSM via a serial communications link. The CSM
handles the overall configuration and status monitoring functions of the
HSO. In the event of GPS failure, the HSO is capable of maintaining
synchronization initially established by the GPS reference signal for a
limited time.

The HSO is typically installed in those geographical areas not covered
by the LORAN-C system and provides the following major functions:

� Reference oscillator temperature and phase lock monitor circuitry

� Generates a highly stable 10 MHz sine wave.

� Reference divider circuitry converts 10 MHz sine wave to 10 MHz
TTL signal, which is divided to provide a 1 PPS strobe to the CSM.
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Prerequisites
� The LMF is not logged into the BTS.

� The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.

� The primary CSM and the HSO (if equipped) have warmed up for 15
minutes.

If the BTS is equipped with an HSO, follow the procedure in Table 3-21
to configure the HSO.

Table 3-21: HSO Initialization/Verification

Step Action

1 At the BTS, slide the HSO card into the cage.

NOTE
The LED on the HSO should light red for no longer than 15-minutes, then switch to green. The CSM
must be locked to GPS.

2 On the LMF at the CSM> prompt, enter sources <cr>.

- Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
----------------------------------------------------------------------------
0 Local GPS Primary 4 Yes Good 0 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxx -69532 Yes
2 Not used
Current reference source number: 0

When the CSM is locked to GPS, verify that the HSO “Good” field is Yes and the “Valid” field is Yes.

3 If source “1” is not configured as HSO, enter at the CSM> prompt: ss 1 12 <cr>

Check for Good in the Status field.

4 At the CSM> prompt, enter sources <cr>.

Verify the HSO valid field is Yes. If not, repeat this step until the “Valid” status of Yes is returned. The
HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO Rubidium
oscillator is fully warmed.
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Test Equipment Set-up

Connecting Test Equipment to the BTS
All test equipment is controlled by the LMF via an IEEE-488/GPIB bus.
If there is a communications problem between the LMF and any piece of
test equipment, verify that the GPIB addresses have been set correctly
(normally 1 for a signal generator, 13 for a power meter, and 18 for a
CDMA analyzer). See Appendix J for procedures to verify and change
the GPIB addresses.

The following equipment is required to perform optimization:

� LMF

� Test set

� Directional coupler and attenuator

� RF cables and connectors

� Null modem cable (see Figure 3-8)

� GPIB interface box

Refer to Table 3-22 and Table 3-23 for an overview of connections for
test equipment currently supported by the LMF. In addition, see the
following figures:

� Figure 3-12 and Figure 3-13 show the test set connections for TX
calibration.

� Figure 3-14 and Figure 3-15 show test set connections for IS-95 A/B
optimization/ATP tests.

� Figure 3-16 shows test set connections for IS-95 A/B and
CDMA 2000 optimization/ATP tests.

� Figure 3-17 and Figure 3-18 show typical TX and RX ATP setup with
a directional coupler (shown with and without RFDS).

Supported Test Sets

CAUTION To prevent damage to the test equipment, all TX test connections
must be through the directional coupler and in-line attenuator as
shown in the test setup illustrations.

IS-95  A/B Testing
Optimization and ATP testing for IS-95A/B may be performed using
one of the following test sets:

� CyberTest

� Advantest R3465 and HP 437B or Gigatronics Power Meter

� Hewlett-Packard HP 8935

� Hewlett-Packard HP 8921 (W/CDMA and PCS Interface for
1.7/1.9 GHz) and HP 437B or Gigatronics Power Meter

The equipment listed above cannot be used for  CDMA 2000 testing.
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CDMA 2000 Testing

NOTE IS-95  C is the same as CDMA 2000.

Optimization and ATP testing may be performed using one of the
following test sets:

� Advantest R3267 Analyzer with Advantest R3562 Signal Generator

� Agilent E4406A with E4432B Signal Generator

� Hewlett-Packard HP 8935 with option 200 or R2K for 1X TX and
with Agilent E4432B Signal Generator for 1X FER

The E4406A/E4432B pair, or the R3267/R3562 pair, should be
connected together using a GPIB cable. In addition, the R3562 and
R3267 should be connected with a serial cable from the Serial I/O to the
Serial I/O. This test equipment is capable of performing tests in both
IS-95 A/B mode and CDMA 2000 mode if the required options are
installed.

Optional test equipment
� Spectrum Analyzer (HP8594E) - can be used to perform cable

calibration.
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Test Equipment Reference Chart
Table 3-22 and Table 3-23 depicts the current test equipment available
meeting Motorola standards.

To identify the connection ports, locate the test equipment presently
being used in the TEST SETS columns, and read down the column.
Where a ball appears in the column, connect one end of the test cable to
that port. Follow the horizontal line to locate the end connection(s),
reading up the column to identify the appropriate equipment/BTS port.

Table 3-22: IS-95 A/B Test Equipment Setup
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL
Cyber-

Test

Advant-
est

R3465
HP

8935
HP

8921A
HP 8921
W/PCS

Power
Meter

GPIB
Inter-
face LMF

30 dB Direction-
al Coupler & 20

dB Pad* BTS

EVEN SECOND 
SYNCHRONIZATION

EVEN
SEC REF

EVEN SEC
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

19.6608 MHZ
CLOCK TIME

BASE IN

CDMA
TIME BASE

IN
EXT

REF IN

CDMA
TIME

BASE IN

CDMA
TIME

BASE IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB HP-IB HP-IB GPIB

SERIAL
PORTHP-IB HP-IB

TX TEST
CABLES

RF
IN/OUT

INPUT
50-OHM

RF
IN/OUT TX1-6

RF
IN/OUT

RF
IN/OUT

30 DB COUPLER
AND 20 DB PAD

RX TEST
CABLES

RF GEN
OUT

RF OUT
50-OHM RX1-6

DUPLEX
OUT

RF OUT
ONLY

SYNC
MONITOR

FREQ
MONITOR

RF
IN/OUT
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Table 3-23: IS-95 A/B/C Test Equipment Setup
TEST SETS ADDITIONAL TEST EQUIPMENT

SIGNAL

Advantest
R3562
Signal

Generator

Advantest
R3267

Analyzer

Agilent
E4406A
Analyzer

Agilent
E4432B
Signal

Generator
HP

8935
Power
Meter

GPIB
Inter-
face LMF

30 dB
Directional
Coupler &
20 dB Pad* BTS

EVEN SECOND 
SYNCHRONIZATION

EXT
TRIG  IN EXT TRIG

TRIGGER
IN

19.6608 MHZ
CLOCK

MOD TIME
BASE IN

EXT
REF IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB HP-IB GPIB

SERIAL
PORTHP-IB

TX TEST
CABLES RF OUT RF IN TX1-6

RF INPUT
50 OHM

30 DB COUPLER
AND 20 DB PAD

RX TEST
CABLES

RF GEN
OUT

RF OUT
50-OHM RX1-6

RF OUT
ONLY

SYNC
MONITOR

FREQ
MONITOR

PATTERN
TRIG  IN

GPIB

RF OUTPUT
50 OHM

RF OUTPUT
50-OHM

10 MHZ IN 10 MHZ OUT 10 MHZ IN10 MHZ OUT
10 MHZ

SERIAL I/O SERIAL I/OSIGNAL SOURCE
CONTROLLED

SERIAL I/O

EVEN
SECOND
SYNC  IN

EXT
REF IN

HP-IB

RF
IN/OUT

DUPLEX

3



Test Equipment Set-up68P09255A61-4

Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
3-47

Equipment Warm-up

NOTE Warm-up BTS equipment for a minimum of 60 minutes prior to
performing the BTS optimization procedure. This assures BTS
site stability and contributes to optimization accuracy. (Time
spent running initial power-up, hardware/firmware audit, and
BTS download counts as warm-up time.)

Calibrating Cables
Figure 3-10 and Figure 3-11 show the cable calibration setup for various
supported test sets. The left side of the diagram depicts the location of
the input and output ports of each test set, and the right side details the
set up for each test.

WARNING Before installing any test equipment directly to any BTS TX
OUT connector, verify there are NO CDMA BBX channels
keyed. At active sites, have the OMC-R/CBSC place the antenna
(sector) assigned to the LPA under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.
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Figure 3-10: Cable Calibration Test Setup
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Motorola CyberTest

Hewlett-Packard Model HP 8935

Advantest Model R3465

DUPLEX
OUT

RF OUTPUT
50-OHM

RF INPUT
50-OHM

RF GEN OUTANT IN

ANT
IN

SUPPORTED TEST SETS

100-W ATT  (MIN)
NON-RADIA TING

RF LOAD

TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP

TEST
SET

C. TX TEST SETUP

20 DB PAD
FOR 1.9 GHZ

CALIBRATION SET UP

N-N  FEMALE
ADAPTER

TX
CABLE

TX
CABLE

SHORT
CABLE

Note: The Directional Coupler is not used with the
Cybertest Test Set. The TX cable is connected
directly to the Cybertest Test Set.

A 10dB attenuator must be used with the short test
cable for cable calibration with the CyberTest Test
Set. The 10dB attenuator is used only for the cable
calibration procedure, not with the test cables for
TX calibration and ATP tests.

TEST
SET

RX
CABLE

SHORT
CABLE

FW00089

Note: For 800 MHZ only. The HP8921A cannot
be used to calibrate cables for PCS frequencies.

Hewlett-Packard  Model HP 8921A

DIRECTIONAL COUPLER 
(30 DB)

N-N FEMALE
ADAPTER

DUPLEX
OUT

RF IN/OUT
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Figure 3-11: Cable Calibration Test Setup (Advantest R3267, Agilent E4406A)

100-W ATT  (MIN)
NON-RADIA TING

RF LOAD

TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP

TEST
SET

C. TX TEST SETUP

20 DB PAD
FOR 1.9 GHZ

CALIBRATION SET UP

N-N  FEMALE
ADAPTER

TX
CABLE

TX
CABLE

SHORT
CABLE

TEST
SET

RX
CABLE

SHORT
CABLE

REF FW00089

DIRECTIONAL COUPLER 
(30 DB)

N-N FEMALE
ADAPTER

RF IN

RF OUT

Advantest R3267 (Top) and R3562 (Bottom)

EXT TRIG IN

MOD TIME BASE IN
(EXT REF IN)

RF
INPUT 50

OHM

RF
OUTPUT
50 OHM

Agilent E4432B (Top) and E4406A (Bottom)

SUPPORTED TEST SETS
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ÁÁ
ÁÁ
ÁÁÁÁ
ÁÁÁ
Á
Á
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Hewlett-Packard Model HP 8935

DUPLEX
OUT

ANT
IN

Setup for TX Calibration
Figure 3-12 and Figure 3-13 show the test set connections for TX
calibration.
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Figure 3-12: TX Calibration Test Setup (CyberTest, HP 8935, and Advantest)
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Motorola CyberTest

Hewlett-Packard Model HP 8935

TEST SETS TRANSMIT (TX) SET UP
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FRONT PANEL
RF

IN/OUT

RF IN/OUT

HP-IB
TO GPIB
BOX

RS232-GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

COMMUNICATIONS
TEST SET

CONTROL
IEEE 488
GPIB BUS

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232
NULL
MODEM
CABLE

OUT

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS

G MODE

ON

TEST SET
INPUT/

OUTPUT
PORTS

BTS

100-W ATT (MIN)
NON-RADIA TING
RF LOAD

IN

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

2O DB PAD
(FOR 1.7/1.9 GHZ)

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

TX TEST
CABLE

TX ANTENNA
PORT OR TX

RFDS
DIRECTIONAL

COUPLERS
ANTENNA PORT

POWER
METER

(OPTIONAL)*

NOTE: THE DIRECTIONAL COUPLER IS NOT USED WITH THE
CYBERTEST TEST SET. THE TX CABLE IS CONNECTED DIRECTLY
TO THE CYBERTEST TEST SET.

Advantest Model R3465

INPUT
50-OHM

GPIB
CONNECTS  TO
BACK OF UNIT

* A POWER METER CAN BE USED IN PLACE
OF THE COMMUNICATIONS TEST SET FOR TX
CALIBRATION/AUDIT

POWER
SENSOR

REF FW00094

30 DB
DIRECTIONAL
COUPLER
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Figure 3-13: TX Calibration Test Setup (Advantest R3267, Agilent E4406A, and HP8935)

TEST SETS TRANSMIT (TX) SET UP

RS232-GPIB
INTERFACE BOX
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IEEE 488
GPIB BUS
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(RJ45 CONNECTORS)

RS232
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MODEM
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OUT

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS

G MODE
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TEST SET
INPUT/

OUTPUT
PORTS

BTS

100-W ATT (MIN)
NON-RADIA TING
RF LOAD

IN

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

2O DB PAD
(FOR 1.7/1.9 GHZ)
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10BASE2
CONVERTER

LAN
B

LAN
A
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CABLE

TX ANTENNA
PORT OR TX

RFDS
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Setup for Optimization/ATP
Figure 3-14 and Figure 3-15 show test set connections for IS-95 A/B
optimization/ATP tests. Figure 3-16 shows test set connections for
IS-95 A/B/C optimization/ATP tests.

Figure 3-14: Opt/ATP Test Setup Calibration (HP 8935)
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Figure 3-15: Opt/ATP Test Setup (HP 8921A)
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Figure 3-16: Opt/ATP Test Setup (Advantest R3267 and Agilent E4406A)
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TX ATP Setup

Figure 3-17 shows a typical TX ATP setup.

Figure 3-17: Typical TX ATP Setup with Directional Coupler
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Figure 3-18: Typical RX ATP Setup with Directional Coupler
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Test Set Calibration

Test Set Calibration Background
Proper test equipment calibration ensures that the test equipment and
associated test cables do not introduce measurement errors, and that
measurements are correct.

NOTE If the test set being used to interface with the BTS has been
calibrated and maintained as a set, this procedure does not need
to be performed. (Test Set includes LMF terminal,
communications test set, additional test equipment, associated
test cables, and adapters.)

This procedure must be performed prior to beginning the optimization.
Verify all test equipment (including all associated test cables and
adapters actually used to interface all test equipment and the BTS) has
been calibrated and maintained as a set.

CAUTION If any piece of test equipment, test cable, or RF adapter, that
makes up the calibrated test equipment set, has been replaced,
re-calibration must be performed. Failure to do so can introduce
measurement errors, resulting in incorrect measurements and
degradation to system performance.

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

Purpose of Test Set Calibration

These procedures access the LMF automated calibration routine used to
determine the path losses of the supported communications analyzer,
power meter, associated test cables, and (if used) antenna switch that
make up the overall calibrated test set. After calibration, the gain/loss
offset values are stored in a test measurement offset file on the LMF.

Selecting Test Equipment
Use LMF Options from the Options menu list to select test equipment
automatically (using the autodetect feature) or manually.

A Serial Connection and a Network Connection tab are provided for
test equipment selection. The Serial Connection tab is used when the
test equipment items are connected directly to the LMF computer via a
GPIB box (normal setup). The Network Connection tab is used when
the test equipment is to be connected remotely via a network connection.

Prerequisites
Ensure the following prerequisites have been met before proceeding:

� Test equipment is correctly connected and turned on.

� CDMA LMF computer serial port and test equipment are connected to
the GPIB box.
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Manually Selecting Test Equipment in a Serial Connection Tab
Test equipment can be manually specified before, or after, the test
equipment is connected. The LMF does not check to see if the test
equipment is actually detected for manual specification. Follow the
procedure in Table 3-24 to select test equipment manually.

Table 3-24: Selecting Test Equipment Manually in a Serial Connection Tab

� Step Action

1 From the Tools menu, select Options.

The LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on the Manual Specification button (if not enabled).

5 Click on the check box corresponding to the test item(s) to be used.

NOTE
GPIB addresses can range from 1 through 30. The LMF will accept any address in that range, but
the numbers in the GPIB address boxes must match the addresses of the test equipment.
Motorola recommends that you use 1 for a CDMA signal generator, 13 for a power meter, and 18
for a CDMA analyzer. To verify and, if necessary, change the GPIB addresses of the test
equipment, refer to Appendix J.

6 Type the GPIB address in the corresponding GPIB address box.

Recommended Addresses
1 = CDMA Signal generator
13 = Power Meter
18 = CDMA Analyzer

7 Click on Apply. (The button darkens until the selection has been committed.)

NOTE
With manual selection, the LMF does not detect the test equipment to see if it is connected and
communicating with the LMF.

To verify and, if necessary, change the GPIB address of the test equipment, refer to Appendix J.

8 Click on Dismiss to close the test equipment window.
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Automatically Selecting Test Equipment in a Serial Connection Tab
When using the auto-detection feature to select test equipment, the LMF
examines which test equipment items are actually communicating with
the LMF. Follow the procedure in Table 3-25 to use the auto-detect
feature.

Table 3-25: Selecting Test Equipment Using Auto-Detect

� Step Action

1 From the Tools menu, select Options.

The LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on Auto-Detection (if not enabled).

NOTE
GPIB addresses can range from 1 through 30. The LMF will accept any address in that range, but
the numbers in the GPIB address to search box must match the addresses of the test equipment.
Motorola recommends that you use 1 for a CDMA signal generator, 13 for a power meter, and 18
for a CDMA analyzer. To verify and, if necessary, change the GPIB addresses of the test
equipment, refer to Appendix J.

5 Type the GPIB addresses in the box labeled GPIB address to search (if not already displayed).

NOTE
When both a power meter and an analyzer are selected, the LMF uses the first item that is capable
of performing the test and is listed in the GPIB addresses to search box for RF power
measurements (i.e., TX calibration). The address for a CDMA signal generator is normally 1, the
address for a power meter is normally 13, and the address for a CDMA analyzer is normally 18. If
1,13,18 is included in the GPIB addresses to search box, the power meter (13) is used for RF
power measurements. When the test equipment items are manually selected, the CDMA analyzer
is used only if a power meter is not selected.

6 Click on Apply.

NOTE
The button darkens until the selection has been committed. A check mark appears in the Manual
Configuration section for detected test equipment items.

7 Click Dismiss to close the LMF Options window.
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Calibrating Test Equipment

The calibrate test equipment function zeros the power measurement level
of the test equipment item that is to be used for TX calibration and audit.
If both a power meter and an analyzer are connected, only the power
meter is zeroed.

Use the Calibrate Test Equipment menu item from the Util menu to
calibrate test equipment. The test equipment must be selected before
calibration can begin. Follow the procedure in Table 3-26 to calibrate the
test equipment.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for tests
that are to be run.

� Test equipment has been selected.

Table 3-26: Test Equipment Calibration

� Step Action

1 From the Util menu, select Calibrate Test Equipment.

A Directions window is displayed.

2 Follow the directions provided.

3 Click on Continue to close the Directions window.

A status report window is displayed.

4 Click on OK to close the status report window.
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Agilent E4406A Transmitter Tester Self-alignment (Calibration)

The Agilent E4406A requires pre-calibration actions or calibration
verification that are not supported by the LMF. Follow the procedure in
Table 3-27 and refer to Figure 3-19 to perform the Agilent E4406A
self-alignment (calibration).

Table 3-27: Agilent E4406A Self-alignment (Calibration)

Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.

- The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Alignments softkey button to the right of the instrument screen.

- The softkey labels will change.

3 Press the Align All Now softkey button.

- All other instrument functions will be suspended during the alignment.

- The display will change to show progress and results of the alignments performed.

- The alignment will take less than one minute.

Figure 3-19: Agilent E4406A Self-alignment
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Calibrating Cables

The cable calibration function measures the loss (in dB) for the TX and
RX cables that are to be used for testing. A CDMA analyzer is used to
measure the loss of each cable configuration (TX cable configuration and
RX cable configuration). The cable calibration consists of the following:

� Measuring the loss of a short cable - This is required to compensate
for any measurement error of the analyzer. The short cable (used only
for the calibration process) is used in series with both the TX and RX
cable configuration when measuring. The measured loss of the short
cable is deducted from the measured loss of the TX and RX cable
configuration to determine the actual loss of the TX and RX cable
configurations. The result is then adjusted out of both the TX and RX
measurements to compensate for the measured loss.

� Measuring the short cable plus the RX cable configuration loss -
The RX cable configuration normally consists only of a coax cable
with type-N connectors that is long enough to reach from the BTS RX
port of the test equipment.

� Measuring the short cable plus the TX cable configuration loss -
The TX cable configuration normally consists of two coax cables with
type-N connectors and a directional coupler, a load, and an additional
attenuator (if required by the specified BTS). The total loss of the path
loss of the TX cable configuration must be as required for the BTS
(normally 30 or 50 dB).

Calibrating Cables with a CDMA Analyzer

Cable Calibration is used to calibrate both TX and RX test cables.
Follow the procedure in Table 3-28 to calibrate the cables. Figure 3-10
illustrates the cable calibration test equipment setup. Appendix F covers
the procedures for manual cable calibration.

NOTE LMF cable calibration for PCS systems (1.7/1.9 GHz) cannot be
accomplished using an HP8921 analyzer with PCS interface or
an Advantest analyzer. A different analyzer type or the signal
generator and spectrum analyzer method must be used (refer to
Table 3-29 and Figure 3-20). Cable calibration values are then
manually entered.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for cable
calibration.

� Test equipment has been selected and calibrated.

3



Test Set Calibration68P09255A61-4

Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
3-63

Table 3-28: Cable Calibration

� Step Action

1 From the Util menu, select Cable Calibration.

A Cable Calibration window is displayed.

2 Enter a channel number(s) in the Channels box.

NOTE
Multiple channels numbers must be separated with a comma, no space (i.e., 200,800). When two
or more channels numbers are entered, the cables are calibrated for each channel. Interpolation is
accomplished for other channels as required for TX calibration.

3 Select TX and RX Cable Cal, TX Cable Cal, or RX Cable Cal in the Cable Calibration pick
list.

4 Click OK. Follow the direction displayed for each step.

A status report window displays the results of the cable calibration.

 

Calibrating TX Cables Using a Signal Generator and Spectrum Analyzer
Follow the procedure in Table 3-29 to calibrate the TX cables using a
signal generator and spectrum analyzer. Refer to Figure 3-20 for a
diagram of the signal generator and spectrum analyzer.

Table 3-29: Calibrating TX Cables Using Signal Generator and Spectrum Analyzer

� Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator.

2 Set signal generator to 0 dBm at the customer frequency of:

- 869-894 MHz for 800 MHz CDMA

- 1930-1990 MHz for North American PCS.

- 1840-1870 MHz for Korean PCS

3 Use a spectrum analyzer to measure signal generator output (see Figure 3-20, A) and record the
value.

4 Connect the spectrum analyzer’s short cable to point B, (as shown in the lower right portion of the
diagram) to measure cable output at customer frequency of:

- 869-894 MHz for 800 MHz CDMA

- 1930-1990 MHz for North American PCS.

- 1840-1870 MHz for Korean PCS

Record the value at point B.

5 Calibration factor = A - B
Example: Cal = -1 dBm - (-53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the equipment setup, as is, to ensure test procedures
use the correct calibration factor.
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Figure 3-20: Calibrating Test Equipment Setup for TX BLO and TX ATP Tests
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Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer
Follow the procedure in Table 3-30 to calibrate the RX cables using the
signal generator and spectrum analyzer. Refer to Figure 3-21, if required.

Table 3-30: Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer

� Step Action

1 Connect a short test cable to the spectrum analyzer and connect the other end to the Signal
Generator.

2 Set signal generator to -10 dBm at the customer’s RX frequency of:

- 824-849 for 800 MHz CDMA

- 1850-1910 MHz band for North American PCS

- 1750-1780 MHz for Korean PCS

3 Use spectrum analyzer to measure signal generator output (see Figure 3-21, A) and record the
value for A.

4 Connect the test setup, as shown in the lower portion of the diagram to measure the output at the
customer’s RX frequency of:

- 824-849 for 800 MHz CDMA

- 1850-1910 MHz band for North American PCS

- 1750-1780 MHz for Korean PCS

Record the value at point B.

. . . continued on next page
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Table 3-30: Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer

� ActionStep

5 Calibration factor = A - B
Example: Cal = -12 dBm - (-14 dBm) = 2 dBm

NOTE
The short test cable is used for test equipment setup calibration only. It is not be part of the final
test setup. After calibration is completed, do not re-arrange any cables. Use the equipment setup,
as is, to ensure test procedures use the correct calibration factor.

 

Figure 3-21: Calibrating Test Equipment Setup for RX ATP Test
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Setting Cable Loss Values
Cable loss values for the TX and RX test cable configurations are
normally set by accomplishing cable calibration using the applicable test
equipment. The resulting values are stored in the cable loss files. The
cable loss values can also be set/changed manually. Follow the procedure
in Table 3-31 to set cable loss values.

Prerequisites
� Logged into the BTS

Table 3-31: Setting Cable Loss Values

Step Action

1 Click on the Util menu.

2 Select Edit>Cable Loss>TX or RX.

A data entry pop-up window appears.

3 To add a new channel number, click on the Add Row button, then click in the Channel # and Loss
(dBm) columns and enter the desired values.

4 To edit existing values, click in the data box to be changed and change the value.

5 To delete a row, click on the row and then click on the Delete Row button.

6 To save displayed values, click on the Save button.

7 To exit the window, click on the Dismiss button.

Values entered/changed after the Save button was used are not saved.

NOTE
� If cable loss values exist for two different channels, the LMF will interpolate for all other channels.

� Entered values are used by the LMF as soon as they are saved. You do not have to logout and login.
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Setting Coupler Loss Values
If an in-service coupler is installed, the coupler loss (e.g., 30 dB) must
be manually entered so it will be included in the LMF TX calibration
and audit calculations and RX FER Test. Follow the procedure in
Table 3-32 to set coupler loss values.

Prerequisites
� Logged into the BTS.

Table 3-32: Setting Coupler Loss Value

Step Action

1 Click on the Util menu.

2 Select Edit>Coupler Loss>TX or RX. A data entry pop-up window appears.

3 Click in the Loss (dBm) column for each carrier that has a coupler and enter the appropriate value.

4 To edit existing values click in the data box to be changed and change the value.

5 Click on the Save button to save displayed values.

6 Click on the Dismiss button to exit the window.

Values entered/changed after the Save button was used are not saved.

NOTE
� The In-Service Calibration check box in the Tools>Options>BTS Options tab must be checked

before entered coupler loss values are used by the TX calibration and audit functions or RX FER
test.

� Entered values are used by the LMF as soon as they are saved. You do not have to logout and login.
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Bay Level Offset Calibration

Introduction to Bay Level Offset Calibration

Calibration compensates for normal equipment variations within the
BTS and assures maximum measurement accuracy.

RF Path Bay Level Offset Calibration

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database calibration
table in the LMF. The BLOs are subsequently downloaded to each BBX.

For starter frames, each receive path starts at a BTS RX antenna port and
terminates at a backplane BBX slot. Each transmit path starts at a BBX
backplane slot, travels through the LPA, and terminates at a BTS TX
antenna port.

For expansion frames each receive path starts at the BTS RX port of the
cell site starter frame, travels through the frame-to-frame expansion
cable, and terminates at a backplane BBX slot of the expansion frame.
The transmit path starts at a BBX backplane slot of the expansion frame,
travels though the LPA, and terminates at a BTS TX antenna port of the
same expansion frame.

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database. Each
transmit path starts at a C-CCP shelf backplane BBX slot, travels
through the LPA, and ends at a BTS TX antenna port. When the TX path
calibration is performed, the RX path BLO is automatically set to the
default value.

At omni sites, BBX slots 1 and 13 (redundant) are tested. At sector sites,
BBX slots 1 through 12, and 13 (redundant) are tested. Only those slots
(sectors) actually equipped in the current CDF are tested, regardless of
physical BBX board installation in the slot.

When to Calibrate BLOs
Calibration of BLOs is required:

� After initial BTS installation

� Once each year

� After replacing any of the following components or associated
interconnecting RF cabling:

- BBX board

- C-CCP shelf

- CIO card

- CIO to LPA backplane RF cable

- LPA backplane

- LPA

- TX filter / TX filter combiner

- TX thru-port cable to the top of frame
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TX Path Calibration

The TX Path Calibration assures correct site installation, cabling, and the
first order functionality of all installed equipment. The proper function
of each RF path is verified during calibration. The external test
equipment is used to validate/calibrate the TX paths of the BTS.

WARNING Before installing any test equipment directly to any TX OUT
connector you must first verify that there are no CDMA
channels keyed. Have the OMC-R place the sector assigned to
the LPA under test OOS. Failure to do so can result in serious
personal injury and/or equipment damage.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module. If this is not done, there is a
high probability that the card/module could be damaged by ESD.

NOTE At new site installations, to facilitate the complete test of each
CCP shelf (if the shelf is not already fully populated with BBX
boards), move BBX boards from shelves currently not under test
and install them into the empty BBX slots of the shelf currently
being tested to insure that all BBX TX paths are tested.

- This procedure can be bypassed on operational sites that are
due for periodic optimization.

- Prior to testing, view the CDF file to verify the correct
BBX slots are equipped. Edit the file as required to include
BBX slots not currently equipped (per Systems
Engineering documentation).

BLO Calibration Data File

During the calibration process, the LMF creates a bts-n.cal  calibration
(BLO) offset data file in the bts-n  folder. After calibration has been
completed, this offset data must be downloaded to the BBXs using the
Download BLO function. An explanation of the file is shown below.

NOTE Due to the size of the file, Motorola recommends that you  print
out a hard copy of a bts.cal file and refer to it for the following
descriptions.

The CAL file is subdivided into sections organized on a per slot basis (a
slot Block).

Slot 1 contains the calibration data for the 12 BBX slots. Slot 20
contains the calibration data for the redundant BBX. Each BBX slot
header block contains:

� A creation Date and Time - broken down into separate parameters of
createMonth, createDay, createYear, createHour, and createMin.

� The number of calibration entries - fixed at 720 entries corresponding
to 360 calibration points of the CAL file including the slot header and
actual calibration data.
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� The calibration data for a BBX is organized as a large flat array. The
array is organized by branch, sector, and calibration point.

- The first breakdown of the array indicates which branch the
contained calibration points are for. The array covers transmit, main
receive and diversity receive offsets as follows:

Table 3-33: BLO BTS.cal File Array Assignments

Range Assignment

C[1]-C[240] Transmit

C[241]-C[480] Main Receive

C[481]-C[720] Diversity Receive

NOTE Slot 385 is the BLO for the RFDS.

- The second breakdown of the array is per sector. Configurations
supported are Omni, 3-sector or 6-sector.

Table 3-34: BTS.cal File Array (Per Sector)

BBX Sectorization TX RX RX Diversity

Slot[1] (Primary BBXs 1 through 12)

1 (Omni) 3-Sector , C[1]-C[20] C[241]-C[260] C[481]-C[500]

2
3-Sector ,

1st C[21]-C[40] C[261]-C[280] C[501]-C[520]

3 6 Sector, Carrier C[41]-C[60] C[281]-C[300] C[521]-C[540]

4
1st

Carrier 3-Sector , C[61]-C[80] C[301]-C[320] C[541]-C[560]

5
Carrier 3-Sector ,

3rd C[81]-C[100] C[321]-C[340] C[561]-C[580]

6 Carrier C[101]-C[120] C[341]-C[360] C[581]-C[600]

7 3-Sector , C[121]-C[140] C[361]-C[380] C[601]-C[620]

8
3-Sector ,

2nd C[141]-C[160] C[381]-C[400] C[621]-C[640]

9 6 Sector, Carrier C[161]-C[180] C[401]-C[420] C[641]-C[660]

10
2nd

Carrier 3-Sector , C[181]-C[200] C[421]-C[440] C[661]-C[680]

11
Carrier 3-Sector ,

4th C[201]-C[220] C[441]-C[460] C[681]-C[700]

12 Carrier C[221]-C[240] C[461]-C[480] C[701]-C[720]

Slot[20]] (Redundant BBX-13)

1 (Omni) 3-Sector , C[1]-C[20] C[241]-C[260] C[481]-C[500]

2
3-Sector ,

1st C[21]-C[40] C[261]-C[280] C[501]-C[520]

3 6 Sector, Carrier C[41]-C[60] C[281]-C[300] C[521]-C[540]

4
1st

Carrier 3-Sector , C[61]-C[80] C[301]-C[320] C[541]-C[560]

5
Carrier 3-Sector ,

3rd C[81]-C[100] C[321]-C[340] C[561]-C[580]

6 Carrier C[101]-C[120] C[341]-C[360] C[581]-C[600]

 . . . continued on next page
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Table 3-34: BTS.cal File Array (Per Sector)

BBX RX DiversityRXTXSectorization

7 3-Sector , C[121]-C[140] C[361]-C[380] C[601]-C[620]

8
3-Sector ,

2nd C[141]-C[160] C[381]-C[400] C[621]-C[640]

9 6 Sector, Carrier C[161]-C[180] C[401]-C[420] C[641]-C[660]

10
2nd

Carrier 3-Sector , C[181]-C[200] C[421]-C[440] C[661]-C[680]

11
Carrier 3-Sector ,

4th C[201]-C[220] C[441]-C[460] C[681]-C[700]

12 Carrier C[221]-C[240] C[461]-C[480] C[701]-C[720]

� Ten calibration points per sector are supported for each branch. Two
entries are required for each calibration point.

� The first value (all odd entries) refer to the CDMA channel
(frequency) where the BLO is measured. The second value (all even
entries) is the power set level. The valid range for PwrLvlAdj is from
2500 to 27500 (2500 corresponds to -125 dBm and 27500
corresponds to +125 dBm).

� The 20 calibration entries for each sector/branch combination must be
stored in order of increasing frequency. If less than 10 points
(frequencies) are calibrated, the largest frequency that is calibrated is
repeated to fill out the 10 points.

Example:
C[1]=384, odd cal entry

=   1 ‘‘calibration point”
C[2]=19102, even cal entry
C[3]=777,
C[4]=19086,
.
.
C[19]=777,
C[20]=19086, (since only two cal points were calibrated this 

would be repeated for the next 8 points)

� When the BBX is loaded with image = data, the cal file data for the
BBX is downloaded to the device in the order it is stored in the cal
file. TxCal data is sent first, C[1] - C[240]. Sector 1’s ten calibration
points are sent (C[1] - C[20]) followed by sector 2’s ten calibration
points (C[21] - C[40]), etc. The RxCal data is sent next (C[241] -
C[480]), followed by the RxDCal data (C[481] - C[720]).

� Temperature compensation data is also stored in the cal file for each
set.
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Test Equipment Setup: RF Path Calibration
Follow the procedure in Table 3-35 to set up test equipment.

Table 3-35: Test Equipment Setup (RF Path Calibration)

Step Action

NOTE
Verify the GPIB controller is properly connected and turned on.

! CAUTION
To prevent damage to the test equipment, all transmit (TX) test connections must be via the 30 dB
directional coupler for 800 MHz with an additional 20 dB in-line attenuator for 1.7/1.9 GHz.

1 Connect the LMF computer terminal to the BTS LAN A connector on the BTS (if you have not
already done so). Refer to the procedure in Table 3-2 on page 3-6.

� If required, calibrate the test equipment per the procedure in Table 3-26 on page 3-60.

� Connect the test equipment as shown in Figure 3-12 on page 3-50.

TX Path Calibration
The assigned channel frequency and power level (as measured at the top
of the frame) for transmit calibration are derived from the site CDF files.
For each BBX, the channel frequency is specified in the ChannelList
CDF file parameter and the power is specified in the SIFPilotPwr
CDF file parameter for the sector associated with the BBX (located
under the ParentSECTOR field of the ParentCARRIER CDF file
parameter).

NOTE If both the BTS-x.cdf and CBSC-x.cdf files are current, all
information will be correct on the LMF. If not, the carrier and
channel will have to be set for each test.

The calibration procedure attempts to adjust the power to within +0.5 dB
of the desired power. The calibration will pass if the error is less than
+1.5 dB.

The TX Bay Level Offset at sites WITHOUT the directional coupler
option, is approximately 42.0 dB ±3.0 dB.

� At sites WITHOUT RFDS option, BLO is approximately 
42.0 dB ±4.0 dB. A typical example would be TX output power
measured at BTS (36.0 dBm) minus the BBX TX output level
(approximately -6.0 dBm) would equate to 42 dB BLO.

The TX Bay Level Offset at sites WITH the directional coupler option,
is approximately 41.4 dB ±3.0 dB. TX BLO = Frame Power Output
minus BBX output level.

� Example: TX output power measured at RFDS TX coupler
(39.4 dBm) minus the BBX TX output level (approximately
-2.0 dBm) and RFDS directional coupler/cable (approximately
-0.6 dBm) would equate to 41.4 dB BLO.

The LMF Tests menu list items, TX Calibration and All Cal/Audit,
perform the TX BLO Calibration test for a XCVR(s). The All Cal/Audit
menu item performs TX calibration, downloads BLO, and performs TX
audit if the TX calibration passes. All measurements are made through
the appropriate TX output connector using the calibrated TX cable setup.
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Rate Set Drop-down Pick List

The Rate Set Drop-down Box is enabled if at least one MCC card is
selected for the test. The available options for TX tests are 1 = 9600, and
3 = 9600 1X. Option 3 is only available if 1X cards are selected for the
test. The available transfer rate options for RX tests are 1 = 9600 and
2 = 14400. Option 2 is only available if no 1X cards are selected.

Verify BLO
In both the TX Calibration and All Cal/Audit dialog boxes, a Verify
BLO checkbox is provided and checked by default. After the actual TX
calibration is completed during either the TX Calibration or All
Cal/Audit process, the BLO derived from the calibration is compared to
a standard, acceptable BLO tolerance for the BTS. In some installations,
additional items may be installed in the transmit path. The additional
change in gain from these items could cause BLO verification failure
and, therefore, failure of the entire calibration. In these cases, either the
Verify BLO checkbox should be unchecked or the additional path losses
should be added into each applicable sector using the
Util>Edit>TX Coupler Loss... function.

Single-sided  BLO

Another option that appears in the pull-down menu is Single-sided
BLO. Normally valid BLO values are some value plus-or-minus some
offset. The ranges that we currently use for calibration are wider than
necessary to accommodate the redundant BBX. The lower half of that
range is where non-redundant BBXs should be. When Single-sided
BLO is selected, the result is only considered a success if it is in the
lower half of the range. If it was normally a success from 37-47 (which
is 42 �5), Single-sided BLO would make it a success only if the result
was from 37-42. To get the more stringent conditions, the operator
checks Single-sided BLO when calibrating non-redundant transceivers.
Single-sided BLO carries the likelihood of more failures. This option
should only be used by experienced CFEs.

Test Pattern

The TESTS_TX CAL menu has a Test Pattern pull-down menu. This
menu has the following choices:

� Pilot (default) - performs tests using a pilot signal only. This pattern
should be used when running in-service tests. It only requires a BBX
to do the test.

� Standard - performs the tests using pilot, synch, paging and six
traffic channels. This pattern should be used on all non-in-service
tests. Standard requires a BBX and an MCC. Standard uses gain
values specified by the IS97 standard.

� CDFPilot -performs the tests using the pilot signal, however, the gain
is specified in the CDF file. Advanced users may use CDFPilot to
generate a Pilot pattern using the value specified by the PilotGain
parameter in the CDF file instead of a pre-determined value.
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� CDF - performs the tests using pilot, synch, paging and six traffic
channels, however, the gain for the channel elements is specified in
the CDF file. Advanced users may use CDF to generate a standard
pattern. Instead of using the values specified by IS97, the settings for
the following CDF parameters are used:

- PilotGain

- PchGain

- SchGain

- NomGain1Way

Prerequisites

Before running this test, ensure that the following have been done:

� CSM-1, GLIs, MCCs, and BBXs have correct code load and data
load.

� Primary CSM and MGLI are INS.

� All BBXs are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

Connect the test equipment as shown in Figure 3-12 and follow the
procedure in Table 3-36 to perform the TX calibration test.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

NOTE Verify all BBX boards removed and repositioned have been
returned to their assigned shelves/slots. Any BBX boards moved
since they were downloaded will have to be downloaded again.

Follow the procedure in Table 3-36 to perform the TX calibration test.

Table 3-36: BTS TX Path Calibration

� Step Action

1 Select the BBX(s) to be calibrated.

NOTE
If STANDARD or CDF is selected for TEST PATTERN, then at least one MCC must be also
selected.

2 From the Tests menu, select TX>TX Calibration or All Cal/Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list. (Press and hold the
<Shift> or <Ctrl> key to select multiple items.)

4 Type the appropriate channel number in the Carrier n Channels box.

5 Select Verify BLO (default) or Single-sided BLO.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

. . . continued on next page
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Table 3-36: BTS TX Path Calibration

� ActionStep

6 From the Test Pattern pick list, select a test pattern.

NOTE
� Selecting Pilot (default) performs tests using a pilot signal only.

� Selecting Standard performs tests using pilot, synch, paging and six traffic channels. This
requires an MCC to be selected.

� Selecting CDFPilot performs tests using a pilot signal, however, the gain for the channel
elements is specified in the CDF file.

� Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the
gain for the channel elements is specified in the CDF file.

7 Click on OK.

8 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

9 Click on Save Results or Dismiss to close the status report window.
 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re-run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.
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Download BLO Procedure

After a successful TX path calibration, download the bay level offset
(BLO) calibration file data to the BBXs. BLO data is extracted from the
CAL file for the Base Transceiver Subsystem (BTS) and downloaded to
the selected BBX devices.

NOTE If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� BBXs being downloaded are OOS-RAM (yellow).

� TX calibration is successfully completed.

Follow the procedure in Table 3-37 to download the BLO data to the
BBXs.

Table 3-37: Download BLO

� Step Action

1 Select the BBX(s) to be downloaded.

2 From the Device menu, select Download>BLO.

A status report window displays the result of the download.

NOTE
Selected device(s) do not change color when BLO is downloaded.

3 Click on OK to close the status report window.

Calibration Audit Introduction

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibration offsets. The calibration audit
procedure measures the path gain or loss of every BBX transmit path at
the site. In this test, actual system tolerances are used to determine the
success or failure of a test. The same external test equipment set up is
used.

NOTE RF path verification, BLO calibration, and BLO data download
to BBXs must have been successfully completed prior to
performing the calibration audit.
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TX Path Audit
Perform the calibration audit of the TX paths of all equipped BBX slots
per the procedure in Table 3-38

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

NOTE If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

TX Audit Test
The Tests menu item, TX Audit, performs the TX BLO Audit test for a
BBX(s). All measurements are made through the appropriate TX output
connector using the calibrated TX cable setup.

Prerequisites

Before running this test, ensure that the following have been done:

� CSM-1, GLIs, and BBXs have correct code load and data load.

� Primary CSM and MGLI are INS.

� All BBXs are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

Connect the test equipment as shown in Figure 3-12 or Figure 3-13.
Follow the procedure in Table 3-38 to perform the BTS TX Path Audit
test.

Table 3-38: BTS TX Path Audit

� Step Action

1 Select the BBX(s) to be audited.

NOTE
If STANDARD or CDF is selected for Test Pattern, then at least one MCC must be also selected.

2 From the Tests menu, select TX>TX Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

4 Type the appropriate channel number in the Carrier n Channels box.

5 If at least one MCC was selected in Step 1, select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop-down list in the Rate Set box.

NOTE
The rate selection of 3 is only available if 1X cards are selected for the test.

6 Select Verify BLO (default) or Single-sided BLO.
. . . continued on next page
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Table 3-38: BTS TX Path Audit

� ActionStep

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

7 From the Test Pattern pick list, select a test pattern.

NOTE
� Selecting Pilot (default) performs tests using a pilot signal only.

� Selecting Standard performs tests using pilot, synch, paging and six traffic channels. This
requires an MCC to be selected.

� Selecting CDFPilot performs tests using a pilot signal, however, the gain for the channel
elements is specified in the CDF file.

� Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the
gain for the channel elements is specified in the CDF file.

8 Click on OK.

9 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

10 Click on Save Results or Dismiss to close the status report window.
 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the Status Report window and provides information in the
Description field. Recheck the test setup and connection and re-run the
test. If the tests fail again, note specifics about the failure, and refer to
Chapter 6, Troubleshooting.
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All Cal/Audit Test

The Tests menu item, All Cal/Audit, performs the TX BLO Calibration
and Audit test for a XCVR(s). All measurements are made through the
appropriate TX output connector using the calibrated TX cable setup.

NOTE If the TX calibration portion of the test passes, the BLO data is
automatically downloaded to the BBX(s) before the audit portion
of the test is run.

Prerequisites

Before running this test, ensure that the following have been done:

� CSM-1, GLIs, BBXs have correct code and data loads.

� Primary CSM and MGLI are INS.

� All BBXs are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

Follow the procedure in Table 3-39 to perform the All Cal/Audit test.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

Table 3-39: All Cal/Audit Test

� Step Action

1 Select the BBX(s) to be tested.

NOTE
If STANDARD, CDFPilot, or CDF is selected for the TEST PATTERN, then at least one MCC
must be also selected.

2 From the Tests menu, select All Cal/Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

4 Type the appropriate channel number in the Carrier n Channels box.

5 If at least one MCC was selected in Step1 select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop-down list in the Rate Set box.

NOTE
The rate selection of 3 is only available if 1X cards are selected for the test.

6 Select Verify BLO or Single-sided BLO.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.
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Table 3-39: All Cal/Audit Test

� ActionStep

7 From the Test Pattern pick list, select a test pattern.

NOTE
� Selecting Pilot (default) performs tests using a pilot signal only.

� Selecting Standard performs tests using pilot, synch, paging and 6 traffic channels. This
requires an MCC to be selected.

� Selecting CDFPilot performs tests using a pilot signal, however, the gain for the channel
elements is specified in the CDF file.

� Selecting CDF performs tests using pilot, synch, paging and 6 traffic channels, however, the
gain for the channel elements is specified in the CDF file.

8 Click on OK.

9 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

10 Click on Save Results or Dismiss to close the status report window.
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Create CAL File

The Create Cal File function gets the BLO data from BBXs and
creates/updates the CAL file for the BTS. If a CAL file does not exist, a
new one is created. If a CAL file already exists, it is updated. After a
BTS has been fully optimized, a copy of the CAL file must exist so it
can be transferred to the CBSC. If TX calibration has been successfully
performed for all BBXs and BLO data has been downloaded, a CAL file
exists. Note the following:

� The Create Cal File function only applies to selected (highlighted)
BBXs.

WARNING The user is not encouraged to edit the CAL file as this action can
cause interface problems between the BTS and the LMF. To
manually edit the CAL file, you must first logout of the BTS. If
you manually edit the CAL file and then use the Create Cal File
function, the edited information is lost.

Prerequisites

Before running this test, the following should be done:

� LMF is logged into the BTS.

� BBXs are OOS_RAM with BLO downloaded.

Table 3-40: Create CAL File

� Step Action

1 Select the applicable BBXs.

NOTE
The CAL file is only updated for the selected BBXs.

2 Click on the Device menu.

3 Click on the Create Cal File menu item.

A status report window displays the results of the action.

4 Click OK to close the status report window.
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RFDS Set-up and Calibration

RFDS Description

NOTE The RFDS is not available for the -48 V BTS at the time of this
publication.

The optional RFDS performs RF tests of the site from the CBSC or from
an LMF. The RFDS consists of the following elements:

� Antenna Select Unit (ASU)

� Fixed Wireless Terminal Interface Card (FWTIC)

� Subscriber Unit Assembly (SUA)

For complete information regarding the RFDS, refer to the CDMA RFDS
Hardware Installation manual and CDMA RFDS User’s Guide.

The LMF provides the following functions for RFDS equipment:

� TX and RX Calibration

� Dekey Test Subscriber Unit (TSU)

� Download Test Subscriber Interface Card (TSIC)

� Forward Test

� Key TSU

� Measure TSU Receive Signal Strength Indication (RSSI)

� Ping TSU

� Program TSU Number Assignment Module (NAM)

� Reverse Test

� RGLI actions (for GLI based RFDS units)

� Set ASU

� Status TSU
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RFDS Parameter Settings

The bts-#.cdf  file includes RFDS parameter settings that must
match the installed RFDS equipment. The paragraphs below describe the
editable parameters and their defaults. Table 3-41 explains how to edit
the parameter settings.

� RfdsEquip - valid inputs are 0 through 2.
0 = (default) RFDS is not equipped
1 = Non-Cobra/Patzer box RFDS
2 = Cobra RFDS

� TsuEquip - valid inputs are 0 or 1
0 = (default) TSU not equipped
1 = TSU is equipped in the system

� MC1....4 - valid inputs are 0 or 1
0 = (default) Not equipped
1 = Multicouplers equipped in RFDS system 

(9600 system RFDS only)

� Asu1/2Equip - valid inputs are 0 or 1
0 = (default) Not equipped
1 = Equipped

� TestOrigDN - valid inputs are ’’’ (default) or a numerical string up to
15 characters. (This is the phone number the RFDS dials when
originating a call. A dummy number needs to be set up by the switch,
and is to be used in this field.)

NOTE Any text editor supporting the LMF may be used to open any
text files to verify, view, or modify data.
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Table 3-41: RFDS Parameter Settings

Step Action

NOTE
Log out of the BTS prior to performing this procedure.

1 Using a text editor, verify the following fields are set correctly in the bts-#.cdf  file
(1 = GLI based RFDS; 2 = Cobra RFDS).

EXAMPLE:

Asu1Equip = 1
Asu2Equip = 0 (1 if system is non-duplexed)
Mc1Equip = 0
Mc2Equip = 0
Mc3Equip = 0
Mc4Equip = 0
RfdsEquip = 2
TestOrigDN = ’123456789’
TsuEquip = 1

NOTE
The above is an example of the bts-#.cdf  file that should have been generated by the OMC and
copied to the LMF. These fields will have been set by the OMC if the RFDSPARM database is
modified for the RFDS.

2 Save and/or quit the editor. If any changes were made to these fields, data will need to be downloaded
to the GLI (see Step 3, otherwise proceed to Step 4).

3 To download to the GLI, click on the Device menu and select the Download>Code/Data menu item
(selected devices do not change color when data is downloaded).

A status report window displays the status of the download.

Click OK to close the status report window.

! CAUTION
After downloading data to the GLI, the RFDS LED slowly begins flashing red and green for
approximately 2-3 minutes. DO NOT attempt to perform any functions with the RFDS until the LED
remains green.

4 Status the RFDS TSU.

A status report window displays the software version number for the TSIC and SUA.

NOTE
If the LMF yields an error message, check the following:

� Ensure the AMR cable is correctly connected from the BTS to the RFDS.

� Verify the RFDS has power.

� Verify the RFDS status LED is green.

� Verify fields in the bts-#.cdf  file are correct (see Step 1).

� Status the MGLI and ensure the device is communicating (via Ethernet) with the LMF, and the
device is in the proper state (INS).
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RFDS TSU NAM Programming

The RFDS TSU NAM must be programmed with the appropriate system
parameters and phone number during hardware installation. The TSU
phone and TSU MSI must be recorded for each BTS used for OMC-R
RFDS software configuration. The TSU NAM should be configured the
same way that any local mobile subscriber would use.

NOTE The user will only need to program the NAM for the initial
install of the RFDS.

The NAM must be programmed into the SUA before it can receive and
process test calls, or be used for any type of RFDS test.

Explanation of Parameters used when Programming the TSU NAM

Table 3-42 defines the parameters used when editing the tsu.nam file.

Table 3-42: Definition of Parameters

Access_Overload_Code
Slot_Index
System ID
Network ID

These parameters are obtained from the switch.

Primary_Channel_A
Primary_Channel_B
Secondary_Channel_A
Secondary_Channel B

These parameters are the channels used in operation of the system.

Lock_Code
Security_Code
Service_Level
Station_Class_Mark

Do not change.

IMSI_11_12
IMSI_MCC

These fields can be obtained at the OMC using the following
command:
OMC000>disp bts-# imsi
If the fields are blank, replace the IMSI fields in the NAM file to 0,
otherwise use the values displayed by the OMC.

MIN_1 Phone Number This field is the phone number assigned to the mobile. The ESN and
MIN should be entered into the switch as well.

NOTE: This field is different from the TestOrigDN field in the
bts.cdf file. The MIN is the phone number of the RFDS subscriber,
and the TestOrigDN is the number the subscriber calls.

3



RFDS Set-up and Calibration 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

3-86

Valid NAM Ranges
Table 3-43 provides the valid NAM field ranges. If any of the fields are
missing or out of range, the RFDS errors out.

Table 3-43: Valid NAM Field Ranges

Valid Range

NAM Field Name Minimum Maximum

Access_Overload_Code 0 15

Slot_Index 0 7

System ID 0 32767

Network ID 0 32767

Primary_Channel_A 25 1175

Primary_Channel_B 25 1175

Secondary_Channel_A 25 1175

Secondary_Channel_B 25 1175

Lock_Code 0 999

Security_Code 0 999999

Service_Level 0 7

Station_Class_Mark 0 255

IMSI_11_12 0 99

IMSI_MCC 0 999

MIN Phone Number N/A N/A

Set Antenna Map Data
The antenna map data is only used for RFDS tests and is required if an
RFDS is installed. Antenna map data does not have to be entered if an
RFDS is not installed. The antenna map data must be entered manually.
Perform the procedure in Table 3-44 to set the Antenna Map Data.

Prerequisite
� Logged into the BTS

Table 3-44: Set Antenna Map Data

Step Action

1 Click on the Util menu.

2 Select Edit>Antenna Map.

A data entry pop-up window appears with a tab for TX and a tab for RX.

3 Enter/edit values as required for each carrier.

NOTE
Refer to the Util >Edit-antenna map LMF help screen for antenna map examples.

4 Click on the Save button to save displayed values.

. . . continued on next page
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Table 3-44: Set Antenna Map Data

Step Action

NOTE
Entered values are used by the LMF as soon as they are saved. You do not have to logout and login.

5 Click on the Dismiss button to exit the window.

NOTE
Values entered/changed after using the Save button are not saved.

 

Set RFDS Configuration Data

If an RFDS is installed, the RFDS configuration data must be manually
entered. Perform the procedure in Table 3-45 to set the RFDS
Configuration Data.

Prerequisite
� Logged into the BTS.

NOTE The entered antenna# index numbers must correspond to the
antenna# index numbers used in the antenna maps.

Table 3-45: Set RFDS Configuration Data

Step Action

1 Click on the Util menu.

2 Select Edit>RFDS Configuration.

A data entry pop-up window appears with a tab for TX and a tab for RX.

3 To add a new antenna number, click on the Add Row button, then click in the other columns and enter
the desired data.

4 To edit existing values, click in the data box to be changed and change the value.

NOTE
Refer to the Util >Edit-RFDS Configuration LMF help screen for RFDS configuration data
examples.

5 To delete a row, click on the row and click on the Delete Row button.

6 To save displayed values, click on the Save button.

NOTE
� Entered values are used by the LMF as soon as they are saved. You do not have to logout and login.

7 To exit the window, click on the Dismiss button .

NOTE
Values entered/changed after using the Save button are not saved.
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RFDS Calibration
The RFDS TX and RX antenna paths must be calibrated to ensure peak
performance. The RFDS calibration option calibrates the RFDS TX and
RX paths.

For a TX antenna path calibration, the BTS XCVR is keyed at a
pre-determined power level and the BTS power output level is measured
by the RFDS. The power level is then measured at the TX antenna
directional coupler by the power measuring test equipment item being
used (power meter or analyzer). The difference (offset) between the
power level at the RFDS and the power level at the TX antenna
directional coupler is used as the TX RFDS calibration offset value.

For an RX antenna path calibration, the RFDS is keyed at a
pre-determined power level and the power input level is measured by the
BTS XCVR. A CDMA signal at the same power level measured by the
BTS XCVR is then injected at the RX antenna directional coupler by the
RFDS keyed power level and the power level measured at the BTS
XCVR is the RFDS RX calibration offset value.

The TX and RX RFDS calibration offset values are written to the CAL
file.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� BBXs are OOS_RAM.

� Cable calibration has been performed

� TX calibration has been performed and BLO has been downloaded for
the BTS.

� Test equipment has been connected correctly for a TX calibration.

� Test equipment has been selected and calibrated.

Follow the procedure in Table 3-46 to calibrate the TX and RX antenna
paths.

Table 3-46: RFDS Calibration Procedure

� Step Action

1 Select the BTS tab.

2 Select the B (for BTS) radio button.

3 Select the BBX to use during the test.

4 Select the RFDS menu.

5 Select the RFDS Calibration menu item.

6 Select the appropriate direction (TX or RX) in the Direction pick list.

7 Type the appropriate channel number(s) in the Channel box.

NOTE
Separate channel numbers with a comma or dash (no spaces) if using more than one channel
number (e.g., 247,585,742 or 385-395  for numbers through and including).

. . . continued on next page
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Table 3-46: RFDS Calibration Procedure

� ActionStep

8 Select the appropriate carrier(s) in the Carriers pick list.

NOTE
Use the <Shift> or <Ctrl> key to select multiple carriers.

9 Select the appropriate Rx branch (Main, Diversity or Both) in the RX Branch pick list.

10 Click OK.

A status report window is displayed, followed by a Directions pop-up window.

11 Follow the cable connection directions as they are displayed.

A status report window displays the results of the actions.

12 Click on the OK button to close the status report window.

13 Click on the MGLI.

14 Download updated RFDS offset data to the selected GLI device by clicking on
Device>Download>Data from the tab menu bar and pull-down menu.

 

Program TSU NAM

Follow the procedure in Table 3-47 to program the TSU NAM. The
NAM must be programmed before it can receive and process test calls,
or be used for any type of RFDS test.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� MGLI is INS.

� TSU is powered up and has a code load.

Table 3-47: Program the TSU NAM

Step Action

1 Select the RFDS tab.

2 Select the SUA (Cobra RFDS) or TSU (GLI based RFDS).

3 Click on the TSU menu.

4 Click on the Program TSU NAM menu item.

5 Enter the appropriate information in the boxes (see Table 3-42 and Table 3-43).

6 Click on the OK button to display the status report.

7 Click on the OK button to close the status report window.
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BTS Redundancy/Alarm Testing

Objective

This section tests the redundancy options that could be included in the
cell site. These tests verify, under a fault condition, that all modules
equipped with redundancy switch operations to their redundant partner
and resume operation. An example would be to pull the currently active
CSM and verify the standby CSM takes over distribution of the CDMA
reference signal.

Redundancy covers many BTS modules. Confirm the redundant options
included in the BTS, and proceed as required. If the BTS has only basic
power supply redundancy, the tests and procedures detailed in the
following tables should be bypassed.

� Table 3-50. Miscellaneous Alarm Tests (BTS Frame)

� Table 3-51. BBX Redundancy Tests (BTS Frame)

� Table 3-52. CSM, GPS, & LFR/HSO Redundancy Alarm Tests

� Table 3-53. LPA Redundancy Test

� Table 3-54. MGLI/GLI Redundancy Test

During redundancy verification of the test, alarms reported by the master
GLI (displayed via the alarm monitor) will also be verified/noted.

Test Equipment

The following pieces of test equipment are required to perform this test:

� LMF

� Communications Test Set

Redundancy/Alarm Test

Perform each of the following tests to verify BTS redundancy and to
confirm all alarms are received and reported by the BTS equipment. The
procedures should be performed on the following modules/boards:

� Power supply/converter modules in all frames

� Distribution shelf modules in the BTS frame

� C-CCP shelf modules in the BTS frame (except MCCs)

� LPA modules in the BTS frame

� AMR Customer defined input/output tests
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Test Equipment Setup
Follow the procedure in Table 3-48 to set up test equipment:

NOTE All alarm tests are performed using TX antenna 1

Table 3-48: Test Equipment Setup for Redundancy/Alarm Tests

Step Action

1 Interface the LMF computer to the BTS LAN A connector on the BTS frame (refer to Table 3-2,
page 3-6).

2 Login to the BTS.

3 Set up test equipment for TX Calibration at TXOUT1 (see Figure 3-12).

NOTE
If site is not equipped for redundancy, remove all GLI and BBX boards installed in any redundant
slot positions at this time.

4 Display the alarm monitor by selecting Util>Alarm Monitor.

5 Unequip all customer defined AMR alarms reported via the AMR Alarm connector (A & B) by
clicking on MGLI, then selecting Device>Set Alarm Relays>Unequipped.

NOTE
During configuration of MGLI alarm reporting, spurious alarms may report. Allow the BTS to
stabilize for 10 seconds. If any alarms are actively being reported after the BTS has stabilized,
determine the cause before proceeding further.

Power Supply Redundancy

Follow the steps in Table 3-49 to verify redundancy of the power supply
modules. Alarms reported by the master GLI (displayed via the alarm
monitor) are also verified.

Table 3-49: Power Supply/Converter Redundancy (BTS Frame)

Step Action

1 Select the MGLI (highlight) and from the pulldown menu select:

Device>BBX/MAWI>Set Redundant Sector>Carrier-#-1-1
Device>BBX/MAWI>Set Pilot Only>Carrier-#-1-1

Device>BBX/MAWI>Set Pilot Gain>Carrier-#-1-1 and Pilot Gain = 262

2 Select (highlight) BBX-1 and from the pulldown menu select Device>BBX/MAWI>Key.

3 Set XCVR gain to 40 and enter the correct XCVR channel number.

4 Remove PS-1 from the power distribution shelf (see Figure 3-22).

- Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

- Verify no other modules went OOS.

5 Re-install PS-1.

Observe the alarm clears on the alarm monitor.

6 Repeat steps 4 and 5 for PS-2 and PS-3.

. . . continued on next page
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Table 3-49: Power Supply/Converter Redundancy (BTS Frame)

ActionStep

NOTE
For +27 V systems, skip to step 7 through step 10.

7 On -48 V systems, remove PS-4 (see Figure 3-23).

- Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

- Verify no other modules went OOS.

8 Re-install PS-4.

Observe the alarm clears on the alarm monitor.

9 Repeat steps 7 and 8 for PS-5 through PS-9.

10 Verify that all PWR/ALM LEDs are GREEN.

11 Select BBX-1 and Device>BBX/MAWI>Dekey
 

Figure 3-22: SC 4812T C-CCP Shelf
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Figure 3-23: -48 V BTS Power Conversion Shelf
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Miscellaneous Alarm/Redundancy Tests
Follow the steps in Table 3-50 to verify alarms reported by the master
GLI are displayed via the alarm monitor if a BTS frame module failure
occurs.

Table 3-50: Miscellaneous Alarm Tests

Step Action

1 Select Util>Alarm Monitor to display the alarm monitor window.

2 Perform the following to verify fan module alarms:
• Unseat a fan module (see Figure 3-24 or Figure 3-25).

• Observe an alarm message was reported via the MGLI (as displayed on the alarm monitor).

• Replace fan module and verify the alarm monitor reports that the alarm clears.

• Repeat for all other fan modules in the BTS frame.

NOTE
Follow Step 3 for Starter Frames and Step 4 for Expansion Frames.

3 Starter Frames Only:

Perform the following to verify MPC module alarms.
• Unseat MPC modules (see Figure 3-22) one at a time.

• Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

• Replace the MPC modules and verify the alarm monitor reports the alarm clears.

4 Expansion Frames Only:

Perform the following to verify EMPC module alarms.
• Unseat EMPC modules (see Figure 3-22) one at a time

• Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

• Replace the EMPC modules and verify the alarm monitor reports that the alarm clears.

. . . continued on next page
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Table 3-50: Miscellaneous Alarm Tests

Step Action

5 If equipped with AMR redundancy, perform the following to verify AMR module redundancy/alarms.
• Unseat AMR 2 (see Figure 3-22).

• Observe that an alarm message is reported via the MGLI (as displayed on the alarm monitor).

• Repeat Steps 1 through 3 and/or 4.

• Replace the AMR module and verify the alarm monitor reports that the alarm clears.

• Unseat AMR 1 and observe an alarm message was reported via the MGLI (as displayed on the alarm
monitor).

• Replace the AMR module and verify the LMF reports the alarm has cleared.

NOTE
All PWR/ALM LEDs should be GREEN at the completion of this test.

 

Figure 3-24: +27 V BTS C-CCP Fan Modules

FAN
MODULE

PWR/ALM

REAR

FRONT

FAN
MODULE

PWR/ALM

REAR

FRONT

FAN
MODULE

PWR/ALM

REAR

FRONT

FAN MODULES

LATCHES

FW00130

3



BTS Redundancy/Alarm Testing68P09255A61-4

Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
3-95

Figure 3-25: -48 V BTS C-CCP and Power Conversion Shelf Fan Modules
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BBX Redundancy

Follow the steps in Table 3-51 to verify redundancy of the BBXs in the
C-CCP shelf. Alarms reported by the master GLI (displayed via the
alarm monitor) are also verified. This test can be repeated for additional
sectors at the customer’s discretion.

Table 3-51: BBX Redundancy Alarms

Step Action

� WARNING
Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

1 Enable the primary, then the redundant BBX assigned to ANT 1 by selecting the BBX and
Device>BBX/MAWI>Key.

2 Observe that primary BBXs key up, and a carrier is present at each respective frequency.

3 Remove the primary BBX.

4 Observe a carrier is still present.
The Redundant BBX is now the active BBX for Antenna 1.

5 Replace the primary BBX and reload the BBX with code and data.

6 Re-enable the primary BBX assigned to ANT 1 and observe that a carrier is present at each respective
frequency.

7 Remove the redundant BBX and observe a carrier is still present.

. . . continued on next page

3



BTS Redundancy/Alarm Testing 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

3-96

Table 3-51: BBX Redundancy Alarms

Step Action

8 The Primary BBX is now the active BBX for ANT 1.

9 Replace the redundant BBX and reload the BBX with code and data.

10 Re-enable the redundant BBX assigned to ANT 1 and observe that a carrier is present at each
respective frequency:

11 De-key the Xcvr by selecting Device>BBX/MAWI>Dekey.

12 Repeat Steps 1 through 11 for additional BBXs/antennas, if equipped.

 

CSM, GPS, & LFR/HSO Redundancy/Alarm Tests

Follow the procedure in Table 3-52 to verify the manual redundancy of
the CSM, GPS, and LFR/HSO boards. Verification of alarms reported is
also covered.

NOTE DO NOT perform the procedure in Table 3-52, unless the site is
configured with a LORAN-C or HSO timebase as a backup for
the GPS.

Table 3-52: CSM, GPS, & LFR/HSO,  Redundancy/Alarm Tests

Step Action

� WARNING
Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

1 Enable the primary, then the redundant BBXs assigned to ANT 1 by selecting the BBX and
Device>BBX/MAWI>Key.

2 Disconnect the GPS antenna cable, located on top of the BTS frame (see Figure 3-26).
This forces the LORAN-C LFR or HSO board timebase to become the CDMA timing source.

3 Observe a CDMA timing reference alarm and source change is reported by the alarm monitor.

4 Allow the LFR/HSO to become the active timing source.

� Verify the BBXs remain keyed and INS.

� Verify no other modules went OOS due to the transfer to LFR/HSO reference.

� Observe the PWR/ALM LEDs on the CSM 1 front panel are steady GREEN.

5 Reconnect the GPS antenna cable.

6 Allow the GPS to become the active timing source.

� Verify the BBXs remain keyed and INS.

� Verify no other modules went OOS due to the transfer back to the GPS reference.

� Observe the PWR/ALM LEDs on CSM 1 are steady GREEN.

. . . continued on next page
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Table 3-52: CSM, GPS, & LFR/HSO,  Redundancy/Alarm Tests

Step Action

7 Disable CSM 1 and enable CSM 2.

� Various CSM source and clock alarms are now reported and the site comes down.

� Alarms clear when the site comes back up.

8 Allow the CSM 2 board to go INS_ACT.

� Verify the BBXs are dekeyed and OOS, and the MCCs are OOS_RAM.

� Verify no other modules went OOS due to the transfer to CSM 2 reference.

� Observe the PWR/ALM LEDs on CSM 2 front panels are steady GREEN.

NOTE
It can take up to 20 minutes for the CSM to re-establish the GPS link and go INS. MCCs go
OOS_RAM.

9 Key BBXs 1 and R and observe a carrier is present.

10 Repeat Steps 2 through 6 to verify CSM source redundancy with CSM 2.

* IMPORTANT
DO NOT ENABLE the redundant CSM.

11 Disable CSM 2 and enable CSM 1.

� Various CSM Source and Clock alarms are reported and the site comes down.

� Alarms clear when the site comes back up.

12 De-key the Xcvr by selecting Device>BBX/MAWI>Dekey.

13 Allow the CSM 1 board to go INS_ACT.

� Verify the BBXs are de-keyed and OOS.

� Verify no other modules went OOS due to the transfer to CSM 1 reference.

� Observe PWR/ALM LEDs on the CSM 1 front panels are steady GREEN.

14 Disable the primary and redundant BBXs.
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Figure 3-26: +27 V SC 4812T Starter Frame I/O Plate
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LPA Redundancy Test

Follow the procedure in Table 3-53 to verify redundancy of the LPAs.

WARNING First verify there are no BBX channels keyed BEFORE
moving the antenna connection. Failure to do so can result in
serious personal injury and/or equipment damage.

Table 3-53: LPA Redundancy Test

Step Action

1 From the pulldown menu select:

Device>BBX/MAWI>Set Redundant Sector>Carrier-#-1-1
Device>BBX/MAWI>Set Pilot Only>Carrier-#-1-1

Device>BBX/MAWI>Set Pilot Gain> Carrier-#-1-1 and Pilot Gain = 262

2 Key-up the BBX assigned to the LPAs associated with the sector under test (gain = 40).

3 Adjust the communications test set spectrum analyzer, as required, to observe the overall carrier
amplitude and IM Shelf and note for reference. These figures will be required later.

NOTE
See Figure 3-14 for test equipment setup, if required.

4 Push-in and release the breaker supplying the 1st LPA of the pair.

NOTE
After power is removed, IM suppression takes a few seconds to settle out while compensating for the
removal of the 1st LPA. The overall gain decreases by approximately 6 dB. The process must be
complete before proceeding.

5 Verify:
• The other LPA module did not go OOS due to the loss of the LPA.

• The overall carrier amplitude is reduced by approximately 6 dB and IM suppression on the analyzer
display remains basically unchanged.

• LPA fault message is reported via the MGLI and displayed on the alarm monitor.

6 Re-apply power to the LPA module and observe the alarm has cleared on the alarm monitor.

NOTE
All PWR/ALM LEDs should be GREEN at completion of test.

7 Repeat Steps 4 through 6 to verify the 2nd LPA of the pair.

8 De-key the BBX.

� WARNING
First verify there are no BBX channels keyed when moving the antenna connection. Failure to do so
can result in serious personal injury and/or equipment damage.

9 Repeat Steps 1 through 8 to verify LPAs assigned to sectors 2 and 3 (if equipped). Move the test cable
on top of the BTS to TX OUT 2 and TX OUT 3 antenna connectors as required.
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MGLI/GLI Redundancy Test

CAUTION This test can only be performed when the MM path is established
by the MM (not just with LAPD link connected). Attempting to
force the GLIs to “hot swap” under alarm monitor control, when
isolated from the MM, causes MGLIs to hang up.

Table 3-54: MGLI/GLI Redundancy Test (with MM Connection Established)

Step Action

NOTE
� This test assumes the alarm monitor is NOT connected to the BTS and the T1/E1 span is connected

and communication is established with the MM.

� BOTH GLIs must be INS before continuing.

1 Verify the BBXs are enabled and a CDMA carrier is present.

2 Identify the primary and redundant MGLI pairs.

3 Pull the MGLI that is currently INS-ACT  and has cage control.

4 Observe the BBX remains GREEN, and the redundant MGLI is now active.

5 Verify no other modules go OOS due to the transfer of control to the redundant module.

6 Verify that the BBXs are enabled and a CDMA carrier is present.

7 Reinstall the MGLI and have the OMCR/CBSC place it back in-service.

8 Repeat Steps 1 through 7 to verify the other MGLI/GLI board.
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BTS Alarms Testing

Alarm Test Overview

ALARM connectors provide Customer Defined Alarm Inputs and
Outputs. The customer can connect BTS site alarm input sensors and
output devices to the BTS, thus providing alarm reporting of active
sensors as well controlling output devices.

The SC 4812T is capable of concurrently monitoring 36 input signals
coming into the BTS. These inputs are divided between 2 Alarm
connectors marked ‘ALARM A’ and ‘ALARM B’ located at the top of
the frame (see Figure 3-27). The ALARM A connector is always
functional; ALARM B is functional when an AMR module is equipped
in the AMR 2 slot in the distribution shelf. ALARM A port monitors
input numbers 1 through 18, while ALARM B port monitors input
numbers 19 through 36 (see Figure 3-28). State transitions on these input
lines are reported to the LMF and OMCR as MGLI Input Relay alarms.

ALARM A and ALARM B connectors each provide 18 inputs and 8
outputs. If both A and B are functional, 36 inputs and 16 outputs are
available. They may be configured as redundant. The configuration is set
by the CBSC.

Alarm Reporting Display

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util>Alarm Monitor.

The following buttons are included:

� The Options button allows for a severity level (Warning, Minor, and
Major) selection. The default is all levels. To change the level of
alarms reported click on the Options button and highlight the desired
alarm level(s). To select multiple levels press the <Ctrl> key (for
individual selections) or <Shift> key (for a range of selections) while
clicking on the desired levels.

� The Pause button pauses/stops the display of alarms. When the Pause
button is clicked the name of the button changes to Continue. When
the Continue button is clicked, the display of alarms continues.
Alarms that occur between the time the Pause button is clicked and
the Continue button is clicked are not displayed.

� The Clear button clears the Alarm Monitor display. New alarms that
occur after the Clear button is clicked are displayed.

� The Dismiss button dismisses/closes the Alarm Monitor display.
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Figure 3-27: Alarm Connector Location and Connector Pin Numbering
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Purpose
The following procedures verify the customer defined alarms and relay
contacts are functioning properly. These tests are performed on all AMR
alarms/relays in a sequential manner until all have been verified. Perform
these procedures periodically to ensure the external alarms are reported
properly. Following these procedures ensures continued peak system
performance.

Study the site engineering documents and perform the following tests
only after first verifying that the AMR cabling configuration required to
interconnect the BTS frame with external alarm sensors and/or relays
meet requirements called out in the SC 4812T Series BTS Installation
Manual.

NOTE Motorola highly recommends that you read and understand this
procedure in its entirety before starting this procedure.

Test Equipment
The following test equipment is required to perform these tests:

� LMF
� Alarms Test Box (CGDSCMIS00014) -optional

Abbreviations used in the following figures and tables are
defined as:

� NC = normally closed
� NO = normally open
� COM or C = common
� CDO = Customer Defined (Relay) Output
� CDI = Customer Defined (Alarm) Input

NOTE
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Figure 3-28: AMR Connector Pin Numbering
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NOTE The preferred method to verify alarms is to follow the Alarms
Test Box Procedure, Table 3-55. If not using an Alarm Test Box,
follow the procedure listed in Table 3-56.

CDI Alarm Input Verification with Alarms Test Box
Table 3-55 describes how to test the CDI alarm input verification using
the Alarm Test Box. Follow the steps as instructed and compare results
with the LMF display.

NOTE It may take a few seconds for alarms to be reported. The default
delay is 5 seconds. Leave the alarms test box switches in the new
position until the alarms have been reported.

Table 3-55: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

1 Connect the LMF to the BTS and log into the BTS.

2 Select the MGLI.

3 Click on the Device menu.

4 Click on the Set Alarm Relays menu item.

5 Click on Normally Open.

A status report window displays the results of the action.

6 Click on the OK button to close the status report window.

7 Set all switches on the alarms test box to the Open position.

8 Connect the alarms test box to the ALARM A connector (see Figure 3-27).

9 Set all of the switches on the alarms test box to the Closed position. An alarm should be reported for
each switch setting.

10 Set all of the switches on the alarms test box to the Open position. A clear alarm should be reported
for each switch setting.

11 Disconnect the alarms test box from the ALARM A connector.

12 Connect the alarms test box to the ALARM B connector.

13 Set all switches on the alarms test box to the Closed position. An alarm should be reported for each
switch setting

. . . continued on next page
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Table 3-55: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

14 Set all switches on the alarms test box to the Open position. A clear alarm should be reported for each
switch setting.

15 Disconnect the alarms test box from the ALARM B connector.

16 Select the MGLI.

17 Click on the Device menu.

18 Click on the Set Alarm Relays menu item.

19 Click on Normally Closed. A status report window displays the results of the action.

20 Click OK to close the status report window.

Alarms should be reported for alarm inputs 1 through 36.

21 Set all switches on the alarms test box to the Closed position.

22 Connect the alarms test box to the ALARM A connector.

Alarms should be reported for alarm inputs 1 through 18.

23 Set all switches on the alarms test box to the Open position.

An alarm should be reported for each switch setting.

24 Set all switches on the alarms test box to the Closed position.

A clear alarm should be reported for each switch setting.

25 Disconnect the alarms test box from the ALARM A connector.

26 Connect the alarms test box to the ALARM B connector.

A clear alarm should be reported for alarm inputs 19 through 36.

27 Set all switches on the alarms test box to the Open position.

An alarm should be reported for each switch setting.

28 Set all switches on the alarms test box to the Closed position.

A clear alarm should be reported for each switch setting.

29 Disconnect the alarms test box from the ALARM B connector.

30 Select the MGLI.

31 Click on the Device menu.

32 Click on the Set Alarm Relays menu item.

33 Click on Unequipped.

A status report window displays the results of the action.

34 Click on the OK button to close the status report window.

35 Connect the alarms test box to the ALARM A connector.

36 Set all switches on the alarms test box to both the Open and the Closed position.

No alarm should be reported for any switch settings.

. . . continued on next page
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Table 3-55: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

37 Disconnect the alarms test box from the ALARM A connector.

38 Connect the alarms test box to the ALARM B connector.

39 Set all switches on the alarms test box to both the Open and the Closed position.

No alarm should be reported for any switch settings.

40 Disconnect the alarms test box from the ALARM B connector.

41 Load data to the MGLI to reset the alarm relay conditions according to the CDF file.

 

CDI Alarm Input Verification without Alarms Test Box
Table 3-56 describes how to test the CDI alarm input verification
without the use of the Alarms Test Box. Follow the steps as instructed
and compare results with the LMF display.

NOTE It may take a few seconds for alarms to be reported. The default
delay is 5 seconds. When shorting alarm pins wait for the alarm
report before removing the short.

Table 3-56: CDI Alarm Input Verification Without the Alarms Test Box

Step Action

1 Connect the LMF to the BTS and log into the BTS.

2 Select the MGLI.

3 Click on the Device menu.

4 Click on the Set Alarm Relays menu item.

5 Click on Normally Open.

A status report window displays the results of the action.

6 Click on OK to close the status report window.

7 Refer to Figure 3-28 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.

An alarm should be reported for each pair of pins that are shorted.

A clear alarm should be reported for each pair of pins when the short is removed.

8 Refer to Figure 3-28 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.

An alarm should be reported for each pair of pins that are shorted.

A clear alarm should be reported for each pair of pins when the short is removed.

9 Select the MGLI.

10 Click on the Device menu.

11 Click on the Set Alarm Relays menu item.

. . . continued on next page
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Table 3-56: CDI Alarm Input Verification Without the Alarms Test Box

Step Action

12 Click on Normally Closed.

A status report window displays the results of the action.

13 Click on OK to close the status report window.

Alarms should be reported for alarm inputs 1 through 36.

14 Refer to Figure 3-28 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.

A clear alarm should be reported for each pair of pins that are shorted.

An alarm should be reported for each pair of pins when the short is removed.

15 Refer to Figure 3-28 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.

A clear alarm should be reported for each pair of pins that are shorted.

An alarm should be reported for each pair of pins when the short is removed.

16 Select the MGLI.

17 Click on the Device menu.

18 Click on the Set Alarm Relays menu item.

19 Click on Unequipped.

A status report window displays the results of the action.

20 Click on OK to close the status report window.

21 Refer to Figure 3-28 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25-26 through 59-60) together.

No alarms should be displayed.

22 Refer to Figure 3-28 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25-26 through 59-60) together.

No alarms should be displayed.

23 Load data to the MGLI to reset the alarm relay conditions according to the CDF file.

 

Pin and Signal Information for Alarm Connectors
Table 3-57 lists the pins and signal names for Alarms A and B.

Table 3-57: Pin and Signal Information for Alarm Connectors

ALARM A ALARM B

Pin Signal Name Pin Signal Name Pin Signal Name Pin Signal Name

1 A CDO1 NC 31 Cust Retn 4 1 B CDO9 NC 31 B CDI 22

2 A CDO1 Com 32 A CDI 4 2 B CDO9 Com 32 Cust Retn 22

3 A CDO1 NO 33 Cust Retn 5 3 B CDO9 NO 33 B CDI 23

4 A CDO2 NC 34 A CDI 5 4 B CDO10 NC 34 Cust Retn 23

. . . continued on next page
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Table 3-57: Pin and Signal Information for Alarm Connectors

ALARM A ALARM B

Pin Signal NamePinSignal NamePinSignal NamePinSignal Name

5 A CDO2 Com 35 Cust Retn 6 5 B CDO10 Com 35 B CDI 24

6 A CDO2 NO 36 A CDI 6 6 B CDO10 NO 36 Cust Retn 24

7 A CDO3 NC 37 Cust Retn 7 7 B CDO11 NC 37 B CDI 25

8 A CDO3 Com 38 A CDI 7 8 B CDO11 Com 38 Cust Retn 25

9 A CDO3 NO 39 Cust Retn 8 9 B CDO11 NO 39 B CDI 26

10 A CDO4 NC 40 A CDI 8 10 B CDO12 NC 40 Cust Retn 26

11 A CDO4 Com 41 Cust Retn 9 11 B CDO12 Com 41 B CDI 27

12 A CDO4 NO 42 A CDI 9 12 B CDO12 NO 42 Cust Retn 27

13 A CDO5 NC 43 Cust Retn 10 13 B CDO13 NC 43 B CDI 28

14 A CDO5 Com 44 A CDI 10 14 B CDO13 Com 44 Cust Retn 28

15 A CDO5 NO 45 Cust Retn 11 15 B CDO13 NO 45 B CDI 29

16 A CDO6 NC 46 A CDI 11 16 B CDO14 NC 46 Cust Retn 29

17 A CDO6 Com 47 Cust Retn 12 17 B CDO14 Com 47 B CDI 30

18 A CDO6 NO 48 A CDI 12 18 B CDO14 NO 48 Cust Retn 30

19 A CDO7 NC 49 Cust Retn 13 19 B CDO15 NC 49 B CDI 31

20 A CDO7 Com 50 A CDI 13 20 B CDO15 Com 50 Cust Retn 31

21 A CDO7 NO 51 Cust Retn 14 21 B CDO15 NO 51 B CDI 32

22 A CDO8 NC 52 A CDI 14 22 B CDO16 NC 52 Cust Retn 32

23 A CDO8 Com 53 Cust Retn 15 23 B CDO16 Com 53 B CDI 33

24 A CDO8 NO 54 A CDI 15 24 B CDO16 NO 54 Cust Retn 33

25 Cust Retn 1 55 Cust Retn 16 25 B CDI 19 55 B CDI 34

26 A CDI 1 56 A CDI 16 26 Cust Retn 19 56 Cust Retn 34

27 Cust Retn 2 57 Cust Retn 17 27 B CDI 20 57 B CDI 35

28 A CDI 2 58 A CDI 17 28 Cust Retn 20 58 Cust Retn 35

29 Cust Retn 3 59 Cust Retn 18 29 B CDI 21 (+27 V)

Converter Alarm (-48 V)

59 B CDI 36

30 A CDI 3 60 A CDI 18 30 Cust Retn 21 (+27 V)

Converter Retn (-48V)

60 Cust Retn 36

NOTE
CDO = Customer Defined Output

CDI = Customer Defined Input
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Automated Acceptance Test Procedures - All-inclusive TX & RX

Introduction

The Automated Acceptance Test Procedure (ATP) allows Cellular Field
Engineers (CFEs) to run automated acceptance tests on all equipped BTS
subsystem devices using the Local Maintenance Facility (LMF) and
supported test equipment per the current Cell Site Data File (CDF)
assignment.

The results of these tests (at the option of the operator) are written to a
file that can be printed. All tests are controlled from the LMF platform
using the GPIB interface, therefore, only recommended test equipment
supported by the LMF can be used.

This chapter describes the tests run from the GUI environment, which is
the recommended method. The GUI provides the advantages of
simplifying the LMF user interface, reducing the potential for miskeying
commmands and associated parameters, and speeding up the execution
of complex operations involving multiple command strings. If you feel
the command line interface (CLI) will provide additional insight into the
progress of ATPs and problems that could possibly be encountered, refer
to LMF CLI Commands.

CAUTION Before performing any tests, use an editor to view the
“CAVEATS” section of the “readme.txt” file in the c:\wlmf
folder for any applicable information.

The ATP test is to be performed on out-of-service (OOS) sectors
only.

DO NOT substitute test equipment not supported by the LMF.

NOTE Refer to Chapter 3 for detailed information on test set
connections for calibrating equipment, cables and other test set
components, if required.
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Reduced ATP

NOTE Equipment has been factory-tested for FCC compliance. If
license-governing bodies require documentation supporting
SITE compliance with regulations, a full ATP may be necessary.
Perform the Reduced ATP only if reports for the specific BTS
site are NOT required.

After downloading the proper operational software to the BTS, the CFE
must perform these procedures (minimal recommendation):

1. Verify the TX/RX paths by performing TX Calibration, TX Audit
and FER tests.

2. Retrieve Calibration Data required for normal site operation.

Should failures occur while performing the specified tests, refer to the
Basic Troubleshooting section of this manual for help in determining the
failure point. Once the point of failure has been identified and corrected,
refer to the BTS Optimization and ATP Test Matrix section
(Appendix C) to determine the applicable test that must be performed.

In the unlikely event that the BTS passes these tests but has a forward
link problem during normal operation, the CFE should then perform the
additional TX tests for troubleshooting: TX spectral mask, TX rho, and
TX code domain.

Required Test Equipment

The following test equipment is required:

� LMF

� Power meter (used with HP8921A/600 and Advantest R3465)

� Communications system analyzer

� Signal generator for FER testing (required for all communications
system analyzers for 1X FER)

WARNING - Before installing any test equipment directly to any BTS
TX OUT connector, verify that there are no CDMA
channels keyed.

- At active sites, have the OMCR/CBSC place the carrier
assigned to the LPAs under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.

NOTE The test equipment must be re-calibrated before using it to
perform the TX Acceptance Tests.
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ATP Test Prerequisites

Before attempting to run any ATP tests, ensure the following have been
completed:

� BTS has been optimized and calibrated (see Chapter 3).

� LMF is logged into the BTS.

� CSMs, GLIs, BBXs, MCCs, and TSU (if the RFDS is installed) have
correct code load and data load.

� Primary CSM, GLI, and MCCs are INS_ACT (bright green).

� BBXs are calibrated and BLOs are downloaded.

� No BBXs are keyed (transmitting).

� BBXs are OOS_RAM (yellow).

� Test cables are calibrated.

� Test equipment is connected for ATP tests (see Figure 3-14 through
Figure 3-18 starting on page 3-52).

� Test equipment has been warmed up 60 minutes and calibrated.

� GPIB is on.

� BTS transmit connectors are properly terminated for the test(s) to be
performed.

WARNING Before performing the FER, be sure that all LPAs are turned
OFF (circuit breakers pulled) or that all transmitter ports are
properly terminated.

All transmit ports must be properly terminated for all ATP tests.

Failure to observe these warnings may result in bodily injury or
equipment damage.

TX OUT Connection

NOTE Many of the acceptance test procedures require taking
measurements at the TX OUT (BTS/RFDS) connector. At sites
without RFDS installed, all measurements will be via the BTS
TX OUT connector. At sites with RFDS installed, all
measurements will be via the RFDS directional coupler TX
OUT connector.

ATP Tests

The tests can be run individually or as one of the following groups:

� All TX/RX: Executes all the TX and RX tests.

� All TX: TX tests verify the performance of the BTS transmit line up.
These include the GLI, MCC, BBX, and CIO cards, the LPAs and
passive components including splitters, combiners, bandpass filters,
and RF cables.
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� All RX: RX tests verify the performance of the BTS receiver line up.
These include the MPC (for starter frames), EMPC (for expansion
frames), CIO, BBX, MCC, and GLI cards and the passive components
including RX filters (starter frame only), and RF cables.

� Full Optimization: Executes the TX calibration, downloads the BLO,
and executes the TX audit before running all of the TX and RX tests.

NOTE The Full Optimization test can be run if you want the TX path
calibrated before all the TX and RX tests are run.

If manual testing has been performed with the HP analyzer,
remove the manual control/system memory card from the card
slot and set the I/O Config to the Talk & Lstn mode before
starting the automated testing.

Follow the procedure in Table 4-1 to perform any ATP test.

NOTE The STOP button can be used to stop the testing process.

Table 4-1: ATP Test Procedure

� Step Action

1 Ensure that all pre-requisites have been met.

NOTE
If the LMF has been logged into the BTS with a different Multi-Channel Preselector setting than
the one to be used for this test, the LMF must be logged out of the BTS and logged in again with
the new Multi-Channel Preselector setting. Using the wrong MPC setting can cause a false test
failure.

2 AUTHOR NOTE:
Is this step necessary for the T and ET? As it stands now,
the additional test equipment set−up table is not in the T
and ET books.

If a companion frame is being tested and either BOTH or DIV is to be selected in step 8, perform
the additional test equipment set-up in Table ??? for the diversity RX portion of the ATP.

3 Select the device(s) to be tested.

4 From the Tests menu, select the test you want to run.

5 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier
pick list.

NOTE
To select multiple items, hold down the <Shift> or <Ctrl> key while making the selections.

6 Enter the appropriate channel number in the Carrier n Channels box.

The default channel number displayed is determined by the CdmaChans[n] number in the
cbsc-n.cdf file for the BTS.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

7 If applicable, select Verify BLO (default) or Single-sided BLO.
. . . continued on next page
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Table 4-1: ATP Test Procedure

� ActionStep

NOTE
If a companion frame with the inter-frame diversity RX cabling disconnected is being tested do
not select BOTH in step 8. The RX main and diversity paths must be tested separately for this
configuration because each requires a different Multi-Coupler Preselector type to provide the
proper test signal gain.

8 Select the appropriate RX branch (BOTH, MAIN, or DIVersity) in the drop-down list.

NOTE
The Rate Set selection of 1 is only available if non-1X cards are selected for the test.

The Rate Set selection of 2 is only available if non-1X cards are selected for the test.

The Rate Set selection of 3 is only available if 1X cards are selected for the test.

9 In the Rate Set box, select the appropriate data rate (1=9600, 2=14400, 3=9600 1X) from the
drop-down list.

10 Enter the channel elements to be tested for the RX ATP in the Channel Element(s) box. By
default, all channel elements are specified.

Use one of thefollowing methods to enter more than one channel element:

- Enter non-sequential channel elements separated by a comma and no spaces (for example;
0,5,15).

- Enter a range of sequential channel elements by typing the first and last channel elements
separated by two periods (for example; 0..15).

NOTE
The channel element numbers are 0 based; that is the first channel element is 0.

11 If applicable, select a test pattern from the Test Pattern pick list.

NOTE
� Selecting Pilot (default) performs tests using only a pilot signal.

� Selecting Standard performs tests using pilot, synch, paging and 6 traffic channels. This
requires an MCC to be selected.

� Selecting CDFPilot performs tests using only a pilot signal, however, the gain for the channel
elements is specified in the CDF file.

� Selecting CDF performs tests using pilot, synch, paging and 6 traffic channels, however, the
gain for the channel elements is specified in the CDF file.

12 Click on the OK button.

The status report window and a Directions pop-up are displayed.

13 Follow the cable connection directions as they are displayed, and click the Continue button to
begin testing.

The test results are displayed in the status report window.

14 Click on Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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TX Output Acceptance Tests: Introduction

Individual Acceptance Tests

The following individual tests can be used to verify the results of
specific tests.

Spectral Purity TX Mask (Primary & Redundant BBX)

This test verifies that the transmitted CDMA carrier waveform generated
on each sector meets the transmit spectral mask specification with
respect to the assigned CDF file values.

Waveform Quality (rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in
ANSI-J_STD-019. “Rho” represents the correlation between actual and
perfect CDMA modulation spectrum. A rho value of 1.0000 represents
100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Pilot
Gain = 262, PN Offset = 0).

Code Domain Power (Primary & Redundant BBX)

This test verifies the code domain power levels, which have been set for
all ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures < -27 dB (with respect to total CDMA channel
power).

Frame Error Rate

The Frame Error Rate (FER) test verifies RX operation of the entire
CDMA Reverse Link using all equipped MCCs assigned to all
respective sectors/antennas. This test verifies the BTS sensitivity on all
traffic channel elements currently configured on all equipped MCCs at
an RF input level of -119 dBm (or -116 dBm if using TMPC).
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TX Spectral Purity Transmit Mask Acceptance Test

Tx Mask Test

This test verifies the spectral purity of each BBX carrier keyed up at a
specific frequency, per the current CDF file assignment. All tests are
performed using the external calibrated test set, controlled by the same
command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

The Pilot Gain is set to 541 for each antenna, and all channel elements
from the MCCs are forward-link disabled. The BBX is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only). BBX power output is set to obtain +40 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler).

NOTE TX output power is set to +40 dBm by setting BTS power level
to +33.5 dBm to compensate for 6.5 dB increase from pilot gain
set to 541.

The calibrated communications test set measures and returns the
attenuation level of all spurious and IM products in a 30 kHz resolution
bandwidth. With respect to the mean power of the CDMA channel
measured in a 1.23 MHz bandwidth in dB, verify that results meet
system tolerances at the following test points:

� 1.7/1.9 GHz:

- at least -45 dB @ + 900 kHz from center frequency

- at least -45 dB @ - 900 kHz from center frequency

� 800 MHz:

- at least -45 dB @ + 750 kHz from center frequency

- at least -45 dB @ - 750 kHz from center frequency

- at least -60 dB @ - 1980 kHz from center frequency

- at least -60 dB @ - 1980 kHz from center frequency

The BBX then de-keys, and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.

See Table 4-1 to perform this test.
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Figure 4-1: TX Mask Verification Spectrum Analyzer Display
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TX Waveform Quality (rho) Acceptance Test

Rho Test

This test verifies the transmitted Pilot channel element digital waveform
quality of each BBX carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all channel elements
from the MCCs are forward link disabled. The BBX is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to
40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
channel element digital waveform quality (rho) in dB, verifying that the
result meets system tolerances:

� Waveform quality (rho) should be �0.912 (-0.4dB).

The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.

See Table 4-1 to perform this test.
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TX Pilot Time Offset Acceptance Test

Pilot Offset Acceptance Test

This test verifies the transmitted Pilot channel element Pilot Time Offset
of each BBX carrier keyed up at a specific frequency per the current
CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all TCH elements from
the MCCs are forward link disabled. The BBX is keyed up, using both
bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to
40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
Time Offset in µs, verifying results meet system tolerances:

� Pilot Time Offset should be within �3 �s of the target PT
Offset (0 �s).

The BBX then de-keys, and if selected, the MCC is  re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.

See Table 4-1 to perform this test.
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TX Code Domain Power/Noise Floor Acceptance Test

Code Domain Power Test

This test verifies the Code Domain Power/Noise of each BBX carrier
keyed up at a specific frequency per the current CDF file assignment.
All tests are performed using the external calibrated test set controlled by
the same command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

For each sector/antenna under test, the Pilot Gain is set to 262. All MCC
channel elements under test are configured to generate Orthogonal
Channel Noise Source (OCNS) on different odd Walsh codes and to be
assigned a full-rate gain of 81. The maximum number of MCC/CEs to
be tested an any one time is 32 (32 odd Walsh codes). If more than 32
CEs exist, then multiple sets of measurements are made; so all channel
elements are verified on all sectors.

BBX power output is set to 40 dBm as measured at the TX OUT
connector (on either the BTS or RFDS directional coupler).

Verify the code domain power levels, which have been set for all ODD
numbered Walsh channels, using the OCNS command. This is done by
verifying that Pilot Power (dBm) minus OCNS Power (dBm) is equal to
10.2 � 2 dB  and that the noise floor of all “OFF” Walsh channels
measures � -27 dB (with respect to total CDMA channel power).

NOTE When performing this test using the LMF and the MCC is an MCC8E
or MCC24E, the redundant BBX may fail or show marginal
performance. This is due to a timing mismatch that the LMF does not
address. Performing this test from the CBSC will not have this timing
problem.

The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated. Upon completion of the test, the
OCNS is disabled on the specified MCC/CE.

See Table 4-1 to perform this test.
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Figure 4-2: Code Domain Power and Noise Floor Levels
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RX Frame Error Rate (FER) Acceptance Test

FER Test

This test verifies the BTS FER on all traffic channel elements currently
configured on all equipped MCCs (full rate at 1% FER) at an RF input
level of -119 dBm [or -116 dBm if using Tower Top
Amplifier (TMPC)]. All tests are performed using the external calibrated
test set as the signal source controlled by the same command. All
measurements are via the LMF.

The Pilot Gain is set to 262 for each TX antenna, and all channel
elements from the MCCs are forward-link disabled. The BBX is keyed
up, using only bbxlvl level offsets, to generate a CDMA carrier (with
pilot channel element only). BBX power output is set to -20 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler). The BBX must be keyed to enable the RX receive
circuitry.

The LMF prompts the MCC/CE under test to measure all zero longcode
and provide the FER report on the selected active MCC on the reverse
link for both the main and diversity RX antenna paths, verifying that
results meet the following specification:

� FER returned less than 1% and total frames measured is 1500

All MCC/CEs selected are tested on the specified RX antenna path. The
BBX then de-keys and, if selected, the MCC is re-configured to assign
the applicable redundant BBX to the current RX antenna paths under
test. The test is then repeated.

See Table 4-1 to perform this test.
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Generate an ATP Report

Background

Each time an ATP test is run, an ATP report is updated to include the
results of the most recent ATP tests if the Save Results button is used to
close the status report window. The ATP report is not updated if the
status reports window is closed using the Dismiss button.

ATP Report

Each time an ATP test is run, a separate report is created for each BTS
and includes the following for each test:

� Test name

� BBX number

� Channel number

� Carrier number

� Sector number

� Upper test limit

� Lower test limit

� Test result

� PASS or FAIL

� Description information (if applicable)

� Time stamp

� Details/Warning information (if applicable)

The report can be printed if the LMF computer is connected to a printer.
Follow the procedure in the Table 4-2 to view and/or print the ATP
report for a BTS.

Table 4-2: Generating an ATP Report

� Step Action

1 Click on the Login tab (if not in the forefront).

2 Select the desired BTS from the available Base Station pick list.

3 Click on the Report button.

4 Click on a column heading to sort the report.

5 - If not desiring a printable file copy, click on the Dismiss button.

- If requiring a printable file copy, select the desired file type in the picklist and click on the
Save button.
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Notes
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Chapter 5

Prepare to Leave the Site
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Prepare to Leave the Site

External Test Equipment Removal

Perform the procedure in Table 5-1 to disconnect the test equipment and
configure the BTS for active service.

Table 5-1: External Test Equipment Removal

Step Action

1 Disconnect all external test equipment from all TX and RX connectors on the top of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed lines at the top of the frame.

CAUTION Verify that all sector antenna feed lines are connected to the
correct ports on the frame. Crossed antenna cables will cause
system degradation of call processing.

NOTE Each module or device can be in any state prior to downloading.
Each module or device will be in an OOS_RAM state after
downloading has completed.

- For all LMF commands, information in italics represents
valid ranges for that command field.

- Only those fields requiring an input will be specified.
Default values for other fields will be assumed.

- For more complete command examples (including system
response details), refer to the CDMA LMF User  Guide.
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Reset All Devices

Reset all devices by cycling power before leaving the site. The
configuration data and code loads could be different from data and code
on the LMF. By resetting all devices, the CBSC can load the proper data
and code when the span is active again.

Follow the procedure in Table 5-2 as required to bring all processor
modules from the OOS to INS mode.

NOTE Have the CBSC/MM bring up the site and enable all devices at
the BTS.

Table 5-2: Enabling Devices

� Step Action

1 On the LMF, select the device(s) you wish to enable.

NOTE
The MGLI and CSM must be INS before an MCC can be put INS.

2 Click on Device from the menu bar.

3 Click on Enable from the Device menu.

A status report window is displayed.

NOTE
If a BBX is selected, a Transceiver Parameters window is displayed to collect keying
information.

Do not enable the BBX.

4 Click OK to close the Transceiver Parameters window.

A status report window displays the status of the device.

5 Click OK to close the status report window.

The selected devices that successfully change to INS change color to green.
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Re-connect  BTS T1 Spans and Integrated Frame Modem

Before leaving the site, connect any T1 span TELCO connectors that
were removed to allow the LMF to control the BTS. Refer to Table 5-3
and Figure 5-1 as required.

Table 5-3: T1/E1 Span/IFM Connections

Step Action

1 Connect the 50-pin TELCO cables to the BTS span I/O board 50-pin TELCO connectors.

2 If used, connect the dial-up modem RS-232 serial cable to the Site I/O board RS-232 9-pin
sub D connector.

NOTE
Verify that you connect both SPAN cables (if removed previously), and the Integrated Frame
Modem (IFM) “TELCO” connector.

Figure 5-1: Site and Span I/O Boards T1 Span Connections

50-PIN  TELCO
CONNECTORS
REMOVED

SPAN A CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

SPAN B CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

TOP of Frame
 (Site I/O and Span I/O boards)

RS-232  9-PIN SUB D
CONNECTOR SERIAL
PORT FOR EXTERNAL
DIAL UP MODEM
CONNECTION (IF USED)

FW00299
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BTS Site Span Configuration Verification

Perform the procedure in Table 5-4 to verify the current Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI2/GLI2
boards in all C-CCP shelves that terminate a T1/E1 span should be
verified.

Table 5-4: BTS Span Parameter Configuration

Step Action

1 Connect a serial cable from the LMF COM1 port (via null modem board) to the front panel of the
MGLI2 MMI port (see Figure 5-2).

2 Start an MMI communication session with MGLI2 by using the Windows desktop shortcut icon (see
Table 3-5 on page 3-11).

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

3 Enter the following MMI command to display the current MGLI2/GLI2 framing format and line code
configuration (in bold type):

span view <cr>

Observe a display similar to the options shown below:

COMMAND ACCEPTED: span view

The parameter in NVM is set to T1_2.

The frame format in flash is set to use T1_2.
Equalization:
  Span A - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span B - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span C - Default (0-131 feet for T1/J1, 120 Ohm for E1)

S D D f lt (0 131 f t f T1/J1 120 Oh f E1)  Span D - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span E - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span F - Default (0-131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate 
The actual rate is 0

NOTE
Defaults for span equalization are 0-131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.

There is no need to change from defaults unless the OMC-R/CBSC span configuration requires it.

If the current MGLI2/GLI2 framing format and line code configuration does not display the correct
choice, proceed to Table 5-5.

4 Repeat steps 1 through 3 for all remaining GLIs.

5 Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the drop-down menu.
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Figure 5-2: MGLI2/GLI2 MMI Port Connection
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Set BTS Site Span Configuration

Perform the procedure in Table 5-5 to configure the Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI2/GLI2
boards in all C-CCP shelves that terminate a T1/E1 span must be
configured.

NOTE Perform the following procedure ONLY if span configurations
loaded in the MGLI2/GLI2s do not match those in the
OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 5-5: Set BTS Span Parameter Configuration

Step Action

1 If not already done, connect a serial cable from the LMF COM1 port (via null modem board) to the
front panel of the MGLI2 MMI port (see Figure 5-2).

2 Start an MMI communication session with CSM-1 by using the Windows desktop shortcut icon (see
Table 3-5 on page 3-11).

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

. . . continued on next page
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

3 If required only, enter the following MMI command for each span line to set the BTS span parameters
to match that of the physical spans a - f run to the site:

span_config <option#1> <option#2> <option#3> <option#4> <option#5>
option#1   =  the span to change (a - f)
option#2   =  the span type (0 - 8):

0 - E1_1 (HDB3, CCS, CRC-4)
1 - E1_2 (HDB3, CCS)
2 - E1_3 (HDB3, CAS, CRC-4, TS16)
3 - E1_4 (HDB3, CAS, TS16)
4 - T1_1 (AMI, DS1 AT&T D4, without ZCS, 3 to 1 packing, Group 0 unusable)
5 - T1_2 (B8ZS, DS1 AT&T ESF, 4 to 1 packing, 64K link)
6 - J1_1 (B8ZS, J1 AT&T ESF, Japan CRC6, 4 to 1 packing)
7 - J1_2 (B8ZS, J1 AT&T ESF, US CRC6, 4 to 1 packing)
8 - T1_3 (AMI, DS1 AT&T D4, with ZCS, 3 to 1 packing, Group 0 unusable)

option#3   =  the link speed (56 or 64) Kbps

option#4   =  the span equalization (0 - 7):
0 - T1_6 (T1,J1:long haul)
1 - T1_4 (T1,J1:393-524 feet)
2 - T1_4 (T1,J1:131-262 feet)
3 - E1_75 (E1:75 Ohm)
4 - T1_4 (T1,J1:0-131 feet)
5 - T1_4 (T1,J1:524-655 feet)
6 - T1_4 (T1,J1:262-393 feet)
7 - E1_120 (E1:120 Ohm)

option#5   =  the slot that has LAPD channel (0 - 31)

Example for setting span configuration to E1_2, 64 Kbps, E1_120-Ohm, LAPD channel 1:

span_config a 1 64 7 1
.
.

span_config f 1 64 7 1

Example for setting span configuration to T1_2, 64 Kbps, T1_4 (0-131 feet), LAPD channel 0:

span_config a 5 64 4 0
.
.

span_config f 5 64 4 0

NOTE
Make sure that spans a - f are set to the same span type and link speed. The equalization may be
different for each individual span.

After executing the span_config command, the affected MGLI2/GLI2 board MUST be reset and
re-loaded for changes to take effect.

Although defaults are shown, always consult site specific documentation for span type and rate used at
the site.

4 Press the RESET button on the GLI2 for changes to take effect.
. . . continued on next page
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

5 This completes the site specific BTS Span setup for this GLI. Move the MMI cable to the next GLI2
and repeat steps 1 and 4 for ALL MGLI2/GLI2 boards.

6 Terminate the Hyperterm session and disconnect the LMF from the MGLI/SGLI.
 

Updating CBSC LMF Files

Updated calibration (CAL) file information must be moved from the
LMF Windows environment back to the CBSC, which resides in a Unix
environment. The procedures that follow detail how to move files from
one environment to the other.

Backup CAL Data to a Diskette

The BLO calibration files should be backed up to a diskette (per BTS).
Follow the procedure in Table 5-6 to copy CAL files from a CDMA
LMF computer to a diskette.

Table 5-6: Backup CAL Data to a Diskette

� Step Action

1 Insert a diskette into the LMF A drive.

NOTE
If your diskette has not been formatted, format it using Windows. The diskette must be DOS
formatted before copying any files. Consult your Windows/DOS documentation or on-line help
on how to format diskettes.

2 Click on the Start button and launch the Windows Explorer program from the Programs menu.

3 Click on your C: drive.

4 Double Click on the wlmf folder.

5 Double Click on the CDMA folder.

6 Click on the bts-#  folder for the calibration file you want to copy.

7 Drag the BTS-#.cal  file to the 3-1/2 floppy (A:) icon on the top left of the screen and release the
mouse button.

8 Repeat steps 6 and 7 until you have copied each file desired.

9 Close the Windows Explorer program by selecting Close from the File menu option.
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LMF Removal

CAUTION DO NOT power down the LMF without performing the
procedure indicated below. Corrupted/lost data files may result,
and in some cases, the LMF may lock up.

Follow the procedure in Table 5-7 to terminate the LMF session and
remove the terminal.

Table 5-7: LMF Termination and Removal

� Step Action

1 From the CDMA window select File>Exit.

2 From the Windows Task Bar click Start>Shutdown.

Click Yes when the Shut Down Windows message appears.

3 Disconnect the LMF terminal Ethernet connector from the BTS cabinet.

4 Disconnect the LMF serial port, the RS-232 to GPIB interface box, and the GPIB cables as
required for equipment transport.

Copying CAL Files from Diskette to the CBSC

Follow the procedure in Table 5-8 to copy CAL files from a diskette to
the CBSC.

Table 5-8: Procedures to Copy CAL Files from Diskette to the CBSC

� Step Action

1 Login to the CBSC on the workstation using your account name and password.

NOTE
Enter the information that appears in bold text.

2 Place your diskette containing CAL file(s) in the CBSC workstation diskette drive.

3 Type eject -q and press the <Enter> key.

4 Type mount and press the <Enter> key.

Verify that floppy/no_name  is displayed.

NOTE
If the eject command has been previously entered, floppy/no_name  will be appended with a
number. Use the explicit floppy/no_name  reference displayed.

5 Enter cd /floppy/no_name and press the <Enter> key.

6 Enter ls -lia and press the <Enter> key.
Verify that the bts-#.cal  file is on the diskette.

7 Enter cd and press the <Enter> key.

8 Enter pwd and press the <Enter> key.

Verify that you are in your home directory (/home/<name>).

9 Enter dos2unix /floppy/no_name/bts-#.cal  bts-#.cal  and press the <Enter> key (where # is the
BTS number).

. . . continued on next page
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Table 5-8: Procedures to Copy CAL Files from Diskette to the CBSC

� ActionStep

10 Enter ls -l *.cal and press the <Enter> key.

Verify that the CAL file was successfully copied.

11 Type eject and press the <Enter> key.

12 Remove the diskette from the workstation.

 

Re-establish  OMC-R Control/ Verifying T1/E1

NOTE After all activities at the site have been completed, and after
disconnecting the LMF, place a phone call to the OMC-R and
request the BTS be placed under control of the OMC-R.
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Chapter 6

Basic Troubleshooting
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Basic Troubleshooting Overview

Overview

The information in this section addresses some of the scenarios likely to
be encountered by Cellular Field Engineering (CFE) team members.
This troubleshooting guide was created as an interim reference document
for use in the field. It provides basic “what to do if” basic
troubleshooting suggestions when the BTS equipment does not perform
per the procedure documented in the manual.

Comments are consolidated from inputs provided by CFEs in the field
and information gained form experience in Motorola labs and
classrooms.
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Troubleshooting: Installation

Cannot Log into Cell-Site

Follow the procedure in Table 6-1 to troubleshoot a login failure.

Table 6-1: Login Failure Troubleshooting Procedures

� Step Action

1 If the MGLI LED is solid RED, it implies a hardware failure. Reset the MGLI by re-seating it. If
this persists, install a known good MGLI card in the MGLI slot and retry. A Red LED may also
indicate no Ethernet termination at top of frame.

2 Verify that T1 is disconnected (see Table 3-1 on page 3-5).

If T1 is still connected, verify the CBSC has disabled the BTS.

3 Try pinging the MGLI (see Table 3-6 on page 3-14).

4 Verify the LMF is connected to the Primary LMF port (LAN A) in the front of the BTS (see
Table 3-2 on page 3-6).

5 Verify the LMF was configured properly (see Preparing the LMF section starting on page 3-6).

6 Verify the BTS-LMF cable is RG-58 [flexible black cable of less than 76 cm (2.5 feet) length].

7 Verify the Ethernet ports are terminated properly (see Figure 3-4 on page 3-13).

8 Verify a T-adapter is not used on the LMF side port if connected to the BTS front LMF primary
port.

9 Try connecting to the I/O panel (top of frame). Use BNC T-adapters at the LMF port for this
connection.

10 Re-boot the LMF and retry.

11 Re-seat the MGLI and retry.

12 Verify IP addresses are configured properly.

Cannot Communicate to Power Meter

Follow the procedure in Table 6-2 to troubleshoot a power meter
communication failure.

Table 6-2:  Troubleshooting a Power Meter Communication Failure

� Step Action

1 Verify the Power Meter is connected to the LMF with a GPIB adapter.

2 Verify the cable setup as specified in Chapter 3.

3 Verify the GPIB address of the power meter is set to the same value displayed in the applicable
GPIB address box of the LMF Options window Test Equipment tab. Refer to Table 3-24 or
Table 3-25 and the GPIB Addresses section of Appendix J for details.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to the CDMA 2000 Test Equipment
Preparation section of Appendix F for details.

. . . continued on next page
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Table 6-2:  Troubleshooting a Power Meter Communication Failure

� ActionStep

5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then cycle GPIB box power and
retry.

6 Verify the LMF computer COM1 port is not used by another application; for example, if a
HyperTerminal window is open for MMI, close it.

7 Reset all test equipment by clicking Util in the BTS menu bar and selecting
Test Equipment>Reset from the pull-down lists.

 

Cannot Communicate to Communications Analyzer

Follow the procedure in Table 6-3 to troubleshoot a communications
analyzer communication failure.

Table 6-3:  Troubleshooting a Communications Analyzer Communication Failure

� Step Action

1 Verify signal generator is connected to LMF with GPIB adapter.

2 Verify cable connections as specified in Chapter 3.

3 Verify the signal generator GPIB address is set to the same value displayed in the applicable GPIB
address box of the LMF Options window Test Equipment tab. Refer to Table 3-24 or Table 3-25
and the GPIB Address section of Appendix J for details.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to the CDMA 2000 Test Equipment
Preparation section of Appendix F for details.

5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then cycle the GPIB box power
and retry.

6 Verify the LMF computer COM1 port is not used by another application; for example, if a
HyperTerminal window is open for MMI, close it.

7 Reset all test equipment by clicking Util in the BTS menu bar and selecting
Test Equipment>Reset from the pull-down lists.
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Troubleshooting: Download

Cannot Download CODE to Any Device (card)

Follow the procedure in Table 6-4 to troubleshoot a code download
failure.

Table 6-4: Troubleshooting Code Download Failure

� Step Action

1 Verify T1 is disconnected from the BTS.

2 Verify the LMF can communicate with the BTS device using the Status function.

3 Communication to the MGLI must first be established before trying to talk to any other BTS
device.
The MGLI must be INS_ACT state (green).

4 Verify the card is physically present in the cage and powered-up.

5 If the card LED is solid RED, it implies hardware failure.
Reset the card by re-seating it.
If the LED remains solid red, replace with a card from another slot & retry.

NOTE
The card can only be replaced by a card of the same type.

6 Re-seat the card and try again.

7 If BBX reports a failure message and is OOS_RAM, the code load was OK.

8 If the download portion completes and the reset portion fails, reset the device by selecting the
device and Reset.

9 If a BBX or an MCC remains OOS_ROM (blue) after code download, use the LMF
Device > Status function to verify that the code load was accepted.

10 If the code load was accepted, use LMF Device > Download > Flash to load RAM code into flash
memory.

Cannot Download DATA to Any Device (Card)

Perform the procedure in Table 6-5 to troubleshoot a data download
failure.

Table 6-5: Troubleshooting Data Download Failure

� Step Action

1 Re-seat the card and repeat code and data load procedure.
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Cannot ENABLE Device

Before a device can be enabled (placed in-service), it must be in the
OOS_RAM state (yellow) with data downloaded to the device. The color
of the device changes to green once it is enabled.

The three states that devices can be changed to are as follows:

� Enabled (green, INS)

� Disabled (yellow, OOS_RAM)

� Reset (blue, OOS_ROM)

Follow the procedure in Table 6-6 to troubleshoot a device enable
failure.

Table 6-6: Troubleshooting Device Enable (INS) Failure

� Step Action

1 Re-seat the card and repeat the code and data load procedure.

2 If the CSM cannot be enabled, verify the CDF file has correct latitude and longitude data for cell
site location and GPS sync.

3 Ensure the primary CSM is in INS_ACT state.

NOTE
MCCs will not go INS without the CSM being INS.

4 Verify the 19.6608 MHz CSM clock; MCCs will not go INS otherwise.

5 The BBX should not be enabled for ATP tests.

6 If MCCs give “invalid or no system time”, verify the CSM is operable.

 

Miscellaneous Errors

Perform the procedure in Table 6-7 to troubleshoot miscellaneous
failures.

Table 6-7: Miscellaneous Failures

� Step Action

1 If LPAs continue to give alarms, even after cycling power at the circuit breakers, then connect an
MMI cable to the LPA and set up a Hyperterminal connection (see Table 3-5 on page 3-11).

2 Enter ALARMS in the Hyperterminal window.
The resulting LMF display may provide an indication of the problem.
(Call Field Support for further assistance.)
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Troubleshooting: Calibration

Bay Level Offset Calibration Failure

Perform the procedure in Table 6-8 to troubleshoot a BLO calibration
failure.

Table 6-8: Troubleshooting BLO Calibration Failure

� Step Action

1 Verify the Power Meter is configured correctly (see the test equipment setup section in Chapter 3)
and connection is made to the proper TX port.

2 Verify the parameters in the bts-#.cdf file are set correctly for the following bands:

For 1900 MHz:
Bandclass=1; Freq_Band=16; SSType=16
For 800 MHz:
Bandclass=0; Freq_Band=8; SSType=8
For 1700 MHz:
Bandclass=4; Freq_Band=128; SSType=16

3 Verify that no LPA in the sector is in alarm state (flashing red LED).
Reset the LPA by pulling the circuit breaker and, after 5 seconds, pushing back in.

4 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.

5 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be ‘ON’ (Power and Ready).
If any other LED is continuously ‘ON’, power-cycle (turn power off and on) the GPIB Box and
retry.

6 Verify the sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power Ref
signal.

7 If communication between the LMF and Power Meter is operational, the Meter display will show
“RES”.

 

6



Troubleshooting: Calibration 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

6-8

Cannot Load BLO

For Load BLO failures see Table 6-7.

Calibration Audit Failure

Follow the procedure in Table 6-9 to troubleshoot a calibration audit
failure.

Table 6-9: Troubleshooting Calibration Audit Failure

� Step Action

1 Verify the Power Meter is configured correctly (refer to the test equipment setup section of
Chapter  3).

2 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.

3 Verify that no LPA is in alarm state (rapidly flashing red LED).
Reset the LPA by pulling the circuit breaker and, after 5 seconds, pushing back in.

4 Verify that no sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power
Ref signal.

5 After calibration, the BLO data must be re-loaded to the BBXs before auditing.
Click on the BBX(s) and select Device>Download BLO.
Re-try the audit.

6 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be “ON” (Power and Ready).
If any other LED is continuously “ON”, power-cycle (turn power off and on) the GPIB Box and
retry.
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Troubleshooting: Transmit ATP

BTS passed Reduced ATP tests but has forward link problem during normal
operation

Follow the procedure in Table 6-10 to troubleshoot a Forward Link
problem during normal operation.

Table 6-10: Troubleshooting Forward Link Failure (BTS Passed Reduced ATP)

� Step Action

1 Perform these additional TX tests to troubleshoot a forward link problem:

- TX mask

- TX rho

- TX code domain

Cannot Perform TX Mask Measurement
Follow the procedure in Table 6-11 to troubleshoot a TX mask
measurement failure.

Table 6-11: Troubleshooting TX Mask Measurement Failure

� Step Action

1 Verify that TX audit passes for the BBX(s).

2 If performing manual measurement, verify analyzer setup.

3 Verify that no LPA in the sector is in alarm state (flashing red LED).
Re-set the LPA by pulling the circuit breaker and, after 5 seconds, pushing it back in.

Cannot Perform Rho or Pilot Time Offset Measurement
Follow the procedure in Table 6-12 to troubleshoot a rho or pilot time
offset measurement failure.

Table 6-12: Troubleshooting Rho and Pilot Time Offset Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offsets displayed on the analyzer is the same as the PN offset in the CDF file.

3 Re-load BBX data and repeat the test.

4 If performing manual measurement, verify analyzer setup.

5 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the LPA by pulling the
circuit breaker and, after 5 seconds, pushing back in.

6 If Rho value is unstable and varies considerably (e.g. .95,.92,.93), this may indicate that the GPS
is still phasing (i.e., trying to reach and maintain 0 freq. error).
Go to the freq. bar in the upper right corner of the Rho meter and select Hz. Press <Shift-avg>
and enter 10, to obtain an average Rho value. This is an indication the GPS has not stabilized
before going INS and may need to be re-initialized.
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Cannot Perform Code Domain Power and Noise Floor Measurement

Perform the procedure in Table 6-13 to troubleshoot a code domain and
noise floor measurement failure.

Table 6-13: Troubleshooting Code Domain Power and Noise Floor Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offset displayed on analyzer is same as PN offset being used in the CDF file.

3 Disable and re-enable MCC (one or more MCCs based on extent of failure).
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Troubleshooting: Receive ATP

Multi-FER  Test Failure

Perform the procedure in Table 6-14 to troubleshoot a Multi-FER
failure.

Table 6-14: Troubleshooting Multi-FER Failure

� Step Action

1 Verify the test equipment set up is correct for an FER test.

2 Verify the test equipment is locked to 19.6608 and even second clocks.

On the HP8921A test set, the yellow LED (REF UNLOCK) must be OFF.

3 Verify the MCCs have been loaded with data and are INS-ACT.

4 Disable and re-enable the MCC (one or more based on extent of failure).

5 Disable, re-load code and data, and re-enable the MCC (one or more MCCs based on extent of
failure).

6 Verify the antenna connections to frame are correct based on the directions messages.
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Troubleshooting: CSM Check-list

Problem Description
Many of the Clock Synchronization Manager (CSM) board failures may
be resolved in the field before sending the boards to the factory for
repair. This section describes known CSM problems identified in field
returns, some of which are field-repairable. Check these problems before
returning suspect CSM boards.

Intermittent 19.6608 MHz Reference Clock/GPS Receiver Operation
If having any problems with CSM board kit numbers, SGLN1145 or
SGLN4132, check the suffix with the kit number. If the kit has version
“AB”, then replace with version “BC” or higher, and return model “AB”
to the repair center.

No GPS Reference Source
Check the CSM boards for proper hardware configuration. CSM kit
SGLN1145, in Slot l, has an on-board GPS receiver; while kit
SGLN4132, in Slot 2, does not have a GPS receiver. Any incorrectly
configured board must be returned to the repair center. Do not attempt to
change hardware configuration in the field. Also, verify the GPS
antenna is not damaged and is installed per recommended guidelines.

Checksum Failure
The CSM could have corrupted data in its firmware resulting in a
non-executable code. The problem is usually caused by either electrical
disturbance or interruption of data during a download. Attempt another
download with no interruptions in the data transfer. Return the CSM
board back to the repair center if the attempt to reload fails.

GPS Bad RX Message Type
This problem is believed to be caused by a later version of CSM
software (3.5 or higher) being downloaded, via LMF, followed by an
earlier version of CSM software (3.4 or lower), being downloaded from
the CBSC. Download again with CSM software code 3.5 or higher.
Return the CSM board back to the repair center if the attempt to reload
fails.

CSM Reference Source Configuration Error
This problem is caused by incorrect reference source configuration
performed in the field by software download. CSM kits SGLN1145 and
SGLN4132 must have proper reference sources configured (as shown
below) to function correctly.

CSM Kit
No.

Hardware
Configuration

CSM Slot
No.

Reference Source
Configuration

CDF Value

SGLN1145 With GPS Receiver 1 Primary = Local GPS
Backup = Either LFR or HSO

0
2 or 18

SGLN4132 Without GPS Receiver 2 Primary = Remote GPS
Backup = Either LFR or HSO

1
2 or 18
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Takes Too Long for CSM to Come INS

This problem may be caused by a delay in GPS acquisition. Check the
accuracy flag status and/or current position. Refer to the GSM system
time/GPS and LFR/HSO verification section in Chapter 3. At least one
satellite should be visible and tracked for the “surveyed” mode and four
satellites should be visible and tracked for the “estimated” mode. Also,
verify correct base site position data used in “surveyed” mode.
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C-CCP  Backplane Troubleshooting

Introduction

The C-CCP backplane is a multi-layer board that interconnects all the
C-CCP modules. The complexity of this board lends itself to possible
improper diagnoses when problems occur.

Connector Functionality

The following connector overview describes the major types of
backplane connectors along with the functionality of each. This
information allows the CFE to:

� Determine which connector(s) is associated with a specific problem
type.

� Isolate problems to a specific cable or connector.

Primary “A” and Redundant “B” Inter Shelf Bus
Connectors

The 40 pin Inter Shelf Bus (ISB) connectors provide an interface bus
from the master GLI to all other GLIs in the modem frame. Their basic
function is to provide clock synchronization from the master GLI to all
other GLIs in the frame.

The ISB also provides the following functions:

� Span line grooming when a single span is used for multiple cages.

� MMI connection to/from the master GLI to cell site modem.

� Interface between GLIs and the AMR (for reporting BTS alarms).

Span Line Connector

The span line input is an 8-pin RJ-45 connector that provides a primary
and secondary (if used) span line interface to each GLI in the C-CCP
shelf. The span line is used for MM/EMX switch control of the Master
GLI and also all the BBX traffic.

Primary “A” and Redundant “B” Reference Distribution
Module Input/Output

The Reference Distribution Module (RDM) connectors route the 3 MHz
reference signals from the CSMs to the GLIs and all BBXs in the
backplane. The signals are used to phase lock loop all clock circuits on
the GLIs and BBX boards to produce precise clock and signal
frequencies.

Power Input (Return A, B, and C connectors)

Provides a +27 volt or -48 volt input for use by the power supply
modules.
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Power Supply Module Interface

Each power supply module has a series of three different connectors to
provide the needed inputs/outputs to the C-CCP backplane. These
include a VCC/Ground input connector, a Harting style multiple pin
interface, and a +15 V/Analog Ground output connector. The C-CCP
Power Modules convert +27 or -48 Volts to a regulated +15, +6.5, and
+5.0 Volts to be used by the C-CCP shelf cards. In the -48 V BTS, the
LPA power modules convert -48 Volts to a regulated +27 Volts.

GLI Connector

This connector consists of a Harting 4SU digital connector and a
6-conductor coaxial connector for RDM distribution. The connectors
provide inputs/outputs for the GLIs in the C-CCP backplane.

GLI 10Base-2 Ethernet “A” and “B” Connections

These BNC connectors are located on the C-CCP backplane and routed
to the GLI board. This interface provides all the control and data
communications between the master GLI and the other GLI, between
gateways, and for the LMF on the LAN.

BBX Connector

Each BBX connector consists of a Harting 2SU/1SU digital connector
and two 6-conductor coaxial connectors.  These connectors provide DC,
digital, and RF inputs/outputs for the BBXs in the C-CCP backplane.

CIO Connectors
� RX RF antenna path signal inputs are routed through RX Tri-Filters

(on the I/O plate), and via coaxial cables to the two MPC modules -
the six “A” (main) signals go to one MPC; the six “B” (diversity) to
the other. The MPC outputs the low-noise-amplified signals via the
C-CCP backplane to the CIO where the signals are split and sent to
the appropriate BBX.

� A digital bus then routes the baseband signal through the BBX, to the
backplane, then on to the MCC slots.

� Digital TX antenna path signals originate at the MCCs. Each  output
is routed from the MCC slot via the backplane appropriate BBX.

� TX RF path signal originates from the BBX, through the backplane to
the CIO, through the CIO, and via multi-conductor coaxial cabling to
the LPAs in the LPA shelf.

C-CCP  Backplane Troubleshooting Procedure

Table 6-15 through Table 6-24 provide procedures for troubleshooting
problems that appear to be related to a defective C-CCP backplane. The
tables are broken down into possible problems and steps that should be
taken in an attempt to find the root cause.

NOTE Table 6-15 through Table 6-24 must be completed before
replacing ANY C-CCP backplane.

6



C-CCP  Backplane Troubleshooting 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

6-16

Digital Control Problems

No GLI Control via LMF (all GLIs)

Follow the procedure in Table 6-15 to troubleshoot a GLI control via
LMF failure.

Table 6-15: No GLI Control via LMF (all GLIs)

� Step Action

1 Check the 10Base-2 ethernet connector for proper connection, damage, shorts, or opens.

2 Verify the C-CCP backplane Shelf ID DIP switch is set correctly.

3 Visually check the master GLI connector (both board and backplane) for damage.

4 Replace the master GLI with a known good GLI.

 

No GLI Control through Span Line Connection (All GLIs)

Follow the procedures in Table 6-16 and Table 6-17 to troubleshoot GLI
control failures.

Table 6-16: No GLI Control through Span Line Connection (Both GLIs)

Step Action

1 Verify the C-CCP backplane Shelf ID DIP switch is set correctly.

2 Verify that the BTS and GLIs are correctly configured in the OMCR/CBSC data base.

3 Visually check the master GLI connector (both board and backplane) for damage.

4 Replace the master GLI with a known good GLI.

5 Check the span line inputs from the top of the frame to the master GLI for proper connection and
damage.

6 Check the span line configuration on the MGLI (see Table 5-4 on page 5-5).

Table 6-17: MGLI Control Good - No Control over Co-located GLI

Step Action

1 Verify that the BTS and GLIs are correctly configured in the OMCR CBSC data base.

2 Check the ethernet for proper connection, damage, shorts, or opens.

3 Visually check all GLI connectors (both board and backplane) for damage.

4 Replace the remaining GLI with a known good GLI.
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No AMR Control (MGLI good)

Perform the procedure in Table 6-18 to troubleshoot an AMR control
failure when the MGLI control is good.

Table 6-18: MGLI Control Good - No Control over AMR

Step Action

1 Visually check the master GLI connector (both board and backplane) for damage.

2 Replace the master GLI with a known good GLI.

3 Replace the AMR with a known good AMR.

No BBX Control in the Shelf - (No Control over
Co-located GLIs)

Perform the procedure in Table 6-19 to troubleshoot a BBX control in
the shelf failure.

Table 6-19: No BBX Control in the Shelf - No Control over Co-located GLIs

Step Action

1 Visually check all GLI connectors (both board and backplane) for damage.

2 Replace the remaining GLI with a known good GLI.

3 Visually check BBX connectors (both board and backplane) for damage.

4 Replace the BBX with a known good BBX.

No (or Missing) Span Line Traffic

Perform the procedure in Table 6-20 to troubleshoot a span line traffic
failure.

Table 6-20: MGLI Control Good - No (or Missing) Span Line Traffic

Step Action

1 Visually check all GLI connectors (both board and backplane) for damage.

2 Replace the remaining GLI with a known good GLI.

3 Visually check all span line distribution (both connectors and cables) for damage.

4 If the problem seems to be limited to one BBX, replace the MGLI with a known good MGLI.

5 Perform the BTS Span Parameter Configuration ( see Table 5-4 on page 5-5).

6 Ensure that ISB cabling is correct.
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No (or Missing) MCC Channel Elements

Perform the procedure in Table 6-21 to troubleshoot a channel elements
failure.

Table 6-21: No MCC Channel Elements

Step Action

1 Verify CEs on a co-located MCC (MCC24 TYPE=2).

2 If the problem seems to be limited to one MCC, replace the MCC with a known good MCC.

- Check connectors (both board and backplane) for damage.

3 If no CEs on any MCC:

- Verify clock reference to CIO.

4 Check the CDF for MCCTYPE=2 (MCC24) or MCCTYPE=0 (MCC8).
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DC Power Problems

Perform the procedure in Table 6-22 to troubleshoot a DC input voltage
to power supply module failure.

WARNING Potentially lethal voltage and current levels are routed to the
BTS equipment. This test must be carried out with a second
person present, acting in a safety role. Remove all rings, jewelry,
and wrist watches prior to beginning this test.

No DC Input Voltage to Power Supply Module

Table 6-22: No DC Input Voltage to Power Supply Module

Step Action

1 Verify DC power is applied to the BTS frame.

2 Verify there are no breakers tripped.

* IMPORTANT
If a breaker has tripped, remove all modules from the applicable shelf supplied by the breaker and
attempt to reset it.

- If the breaker trips again, there is probably a cable or breaker problem within the frame.

- If the breaker does not trip, there is probably a defective module or sub-assembly within the shelf.

3 Verify that the C-CCP shelf breaker on the BTS frame breaker panel is functional.

4 Use a voltmeter to determine if the input voltage is being routed to the C-CCP backplane by
measuring the DC voltage level on the PWR_IN cable.

- If the voltage is not present, there is probably a cable or breaker problem within the frame.

- If the voltage is present at the connector, reconnect and measure the level at the “VCC” power
feed clip on the distribution backplane.

- If the voltage is correct at the power clip, inspect the clip for damage.

5 If everything appears to be correct, visually inspect the power supply module connectors.

6 Replace the power supply module with a known good module.

7 If steps 1 through 5 fail to indicate a problem, a C-CCP backplane failure (possibly an open trace) has
occurred.
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No DC Voltage (+5, +6.5, or +15 Volts) to a Specific GLI,
BBX, or Switchboard

Perform the procedure in Table 6-23 to troubleshoot a DC input voltage
to GLI, BBX, or Switchboard failure.

Table 6-23: No DC Input Voltage to any C-CCP Shelf Module

Step Action

1 Verify the steps in Table 6-22 have been performed.

2 Inspect the defective board/module (both board and backplane) connector for damage.

3 Replace suspect board/module with known good board/module.

TX and RX Signal Routing Problems

Perform the procedure in Table 6-24 to troubleshoot TX and RX signal
routing problems.

Table 6-24: TX and RX Signal Routing Problems

Step Action

1 Inspect all Harting Cable connectors and back-plane connectors for damage in all the affected board
slots.

2 Perform steps in the RF path troubleshooting flowchart in this manual.
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Module Front Panel LED Indicators and Connectors
Module Status Indicators

Each of the non-passive plug-in modules has a bi-color (green & red)
LED status indicator located on the module front panel. The indicator is
labeled PWR/ALM. If both colors are turned on, the indicator is yellow.

Each plug-in module, except for the fan module, has its own alarm
(fault) detection circuitry that controls the state of the PWR/ALM LED.

The fan TACH signal of each fan module is monitored by the AMR.
Based on the status of this signal, the AMR controls the state of the
PWR/ALM LED on the fan module.

LED Status Combinations for All Modules (except GLI, CSM, BBX, MCC)

PWR/ALM LED

The following list describes the states of the module status indicator.

� Solid GREEN -  module operating in a normal (fault free) condition.

� Solid RED - module is operating in a fault (alarm) condition due to
electrical hardware failure.

Note that a fault (alarm) indication may or may not be due to a complete
module failure and normal service may or may not be reduced or
interrupted.

DC/DC Converter LED Status Combinations

The PWR CNVTR has alarm (fault) detection circuitry that controls the
state of the PWR/ALM LED. This is true for both the C-CCP and LPA
power converters.

PWR/ALM LED

The following list describes the states of the bi-color LED.

� Solid GREEN -  module operating in a normal (fault free) condition.

� Solid RED -  module is operating in a fault (alarm) condition due to
electrical hardware problem.
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CSM LED Status Combinations
PWR/ALM LED

The CSMs include on-board alarm detection. Hardware and
software/firmware alarms are indicated via the front panel indicators.

After the memory tests, the CSM loads OOS-RAM code from the Flash
EPROM, if available. If not available, the OOS-ROM code is loaded
from the Flash EPROM.

� Solid GREEN - module is INS_ACT or INS_STBY no alarm.

� Solid RED - Initial power up or module is operating in a fault (alarm)
condition.

� Slowly Flashing GREEN - OOS_ROM no alarm.

� Long RED/Short GREEN - OOS_ROM alarm.

� Rapidly Flashing GREEN - OOS_RAM no alarm or INS_ACT in
DUMB mode.

� Short RED/Short GREEN - OOS_RAM alarm.

� Long GREEN/Short RED - INS_ACT  or INS_STBY alarm.

� Off - no DC power  or on-board fuse is open.

� Solid YELLOW - After a reset, the CSMs begin to boot. During
SRAM test and Flash EPROM code check, the LED is yellow. (If
SRAM or Flash EPROM fail, the LED changes to a solid RED and
the CSM attempts to reboot.)

Figure 6-1: CSM Front Panel Indicators & Monitor Ports

PWR/ALM
Indicator

FREQ
MONITOR

SYNC
MONITOR

FW00303

 . . . continued on next page
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FREQ Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the 19.6608 MHz clock generated by the CSM. When
both CSM 1 and CSM 2 are in an in-service (INS) condition, the CSM 2
clock signal frequency is the same as that output by CSM 1.

The clock is a sine wave signal with a minimum amplitude of +2 dBm
(800 mVpp) into a 50 Ω load connected to this port.

SYNC Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the “Even Second Tick” reference signal generated by the
CSMs.

At this port, the reference signal is a TTL active high signal with a pulse
width of 153 nanoseconds.

MMI Connector - Only accessible behind front panel. The
RS-232 MMI port connector is intended to be used primarily in
the development or factory environment, but may be used in the
field for debug/maintenance purposes.

GLI2 LED Status Combinations

The GLI2 module has indicators, controls and connectors as described
below and shown in Figure 6-2.

The operating states of the 5 LEDs are:

ACTIVE
Solid GREEN - GLI2 is active. This means that the GLI2 has shelf
control and is providing control of the digital interfaces.

Off - GLI2 is not active (i.e., Standby). The mate GLI2 should be
active.

MASTER
� Solid GREEN - GLI2 is Master (sometimes referred to as MGLI2).

� Off - GLI2 is non-master (i.e., Slave).

ALARM
� Solid RED - GLI2 is in a fault condition or in reset.

� While in reset transition,  STATUS LED is OFF while GLI2 is
performing ROM boot (about 12 seconds for normal boot).

� While in reset transition,  STATUS LED is ON while GLI2 is
performing RAM boot (about 4 seconds for normal boot).

� Off - No Alarm.
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STATUS
� Flashing GREEN-  GLI2 is in service (INS), in a stable operating

condition.

� On - GLI2 is in OOS RAM state operating downloaded code.

� Off - GLI2 is in OOS ROM state operating boot code.

SPANS
� Solid GREEN - Span line is connected and operating.

� Solid RED - Span line is disconnected or a fault condition exists.

GLI2 Pushbuttons and Connectors
RESET Pushbutton - Depressing the RESET pushbutton
causes a partial reset of the CPU and a reset of all board devices.
The GLI2 is placed in the OOS_ROM state

MMI Connector - The RS-232MMI port connector is intended
to be used primarily in the development or factory environment
but may be used in the field for debug/maintenance purposes.

LAN Connectors (A & B) - The two 10BASE2 Ethernet circuit
board mounted BNC connectors are located on the bottom front
edge of the GLI2; one for each LAN interface, A & B. Ethernet
cabling is connected to tee connectors fastened to these BNC
connectors.
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Figure 6-2: GLI2 Front Panel
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STATUS OFF − operating normally
ON − briefly during power−up when the Alarm LED turns OFF.
SLOW GREEN − when the GLI2 is INS (in−service)

RESET

ALARM OFF − operating normally
ON − briefly during power−up when the Alarm LED turns OFF.
SLOW GREEN − when the GLI2 is INS (in−service)
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All functions on the GLI2 are reset when pressing and releasing
the switch.

ON − operating normally in active mode
OFF − operating normally in standby mode

Shows the operating status of the redundant cards. The redundant
card toggles automatically if the active card is removed or fails

ON − active card operating normally
OFF − standby card operating normally

The pair of GLI2 cards include a redundant status. The card in the
top shelf is designated by hardware as the active card; the card in
the bottom shelf is in the standby mode.

OFF − card is powered down, in initialization, or in standby
GREEN − operating normally
YELLOW − one or more of the equipped initialized spans is receiving
a remote alarm indication signal from the far end
RED − one or more of the equipped initialized spans is in an alarm
state

An RS−232, serial, asynchronous communications link for use as
an MMI port. This port supports 300 baud, up to a maximum of
115,200 baud communications.
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GLI3 Front Panel

Figure 6-3 shows the GLI3 front panel.

Figure 6-3: GLI3 Front Panel
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OFF − card is powered down, in initialization, or in standby
GREEN − operating normally
YELLOW − one or more of the equipped initialized spans is receiving
a remote alarm indication signal from the far end
RED − one or more of the equipped initialized spans is in an alarm
state
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BBX LED Status Combinations

PWR/ALM LED

The BBX module has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

The following list describes the states of the bi-color LED:

� Solid GREEN - INS_ACT no alarm

� Solid RED Red - initializing or power-up alarm

� Slowly Flashing GREEN - OOS_ROM no alarm

� Long RED/Short GREEN - OOS_ROM alarm

� Rapidly Flashing GREEN - OOS_RAM no alarm

� Short RED/Short GREEN - OOS_RAM alarm

� Long GREEN/Short RED - INS_ACT  alarm

MCC LED Status Combinations

The MCC module has LED indicators and connectors as described
below (see Figure 6-4). Note that the figure does not show the
connectors as they are concealed by the removable lens.

The LED indicators and their states are as follows:

PWR/ALM LED

� RED - fault on module

ACTIVE LED

� Off - module is inactive, off-line, or not processing traffic.

� Slowly Flashing GREEN - OOS_ROM no alarm.

� Rapidly Flashing Green - OOS_RAM no alarm.

� Solid GREEN - module is INS_ACT, on-line, processing traffic.

PWR/ALM and ACTIVE LEDs

� Solid RED - module is powered but is in reset or the BCP is inactive.

MMI Connectors

� The RS-232 MMI port connector (four-pin) is intended to be used
primarily in the development or factory environment but may be used
in the field for debugging purposes.

� The RJ-11 ethernet port connector (eight-pin) is intended to be used
primarily in the development environment but may be used in the field
for high data rate debugging purposes.
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Figure 6-4: MCC Front Panel
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LPA Shelf LED Status Combinations

LPA Module LED

Each LPA module contains a bi-color LED just above the MMI
connector on the front panel of the module. Interpret this LED as
follows:

� GREEN — LPA module is active and is reporting no alarms (Normal
condition).

� Flashing GREEN/RED — LPA module is active but is reporting an
low input power condition. If no BBX is keyed, this is normal and
does not constitute a failure.

6



Basic Troubleshooting - Span Control Link68P09255A61-4

Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
6-29

Basic Troubleshooting - Span Control Link

Span Problems (No Control Link)
Perform the procedure in Table 6-25 to troubleshoot a control link
failure.

Table 6-25: Troubleshoot Control Link Failure

� Step Action

1 Connect the CDMA LMF computer to the MMI port on the applicable MGLI/GLI as shown in
Figure 6-5 or Figure 6-6.

2 Start an MMI communication session with the applicable MGLI/GLI by using the Windows
desktop shortcut icon.

3 Once the connection window opens, press the CDMA LMF computer Enter key until the GLI>
prompt is obtained.

4 At the GLI>  prompt, enter:

config ni current  <cr>  (equivalent of span view command)

The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.
Equalization:
  Span A - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span B - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span C - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span D - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span E - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span F - Default (0-131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate 
The actual rate is 0

NOTE
Defaults for span equalization are 0-131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.

There is no need to change from defaults unless the OMC-R/CBSC span configuration requires it.

5 The span configurations loaded in the GLI must match those in the OMCR/CBSC database for the
BTS. If they do not, proceed to Table 6-26.

6 Repeat steps 1 through 5 for all remaining GLIs.

7 If the span settings are correct, verify the edlc parameters using the show command.

Any alarm conditions indicate that the span is not operating correctly.

� Try looping back the span line from the DSX panel back to the MM, and verify that the looped
signal is good.

� Listen for control tone on the appropriate timeslot from the Base Site and MM.

8 Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the drop-down menu.

9 If no TCHs in groomed MCCs (or in whole C-CCP shelf) can process calls, verify that the ISB
cabling is correct and that ISB A and ISB B cables are not swapped.
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Figure 6-5: MGLI/GLI Board MMI Connection Detail
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Figure 6-6: GLI3 Board MMI Connection Detail
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Set BTS Site Span Configuration

Perform the procedure in Table 6-26 to set the span parameter
configuration.

NOTE Perform the following procedure ONLY if span configurations
loaded in the MGLI/GLIs do not match those in the
OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 6-26: Set BTS Span Parameter Configuration

� Step Action

1 If not previously done, connect the CDMA LMF computer to the MMI port on the applicable
MGLI/GLI as shown in Figure 6-5.

2 If there is no MMI communication session in progress with the applicable MGLI/GLI, initiate one
by using the Windows desktop shortcut icon.

3 At the GLI>  prompt, enter:

config  ni  format  <option>  <cr> 

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni format option 
Next available options:
   LIST -     option : Span Option
                    E1_1 : E1_1 - E1 HDB3 CRC4    no TS16
                    E1_2 : E1_2 - E1 HDB3 no CRC4 no TS16
                    E1_3 : E1_3 - E1 HDB3 CRC4    TS16
                    E1_4 : E1_4 - E1 HDB3 no CRC4 TS16
                    T1_1 : T1_1 - D4, AMI, No ZCS
                    T1_2 : T1_2 - ESF, B8ZS
                    J1_1 : J1_1 - ESF, B8ZS (Japan) - Default
                    J1_2 : J1_2 - ESF, B8ZS
                    T1_3 : T1_3 - D4, AMI, ZCS
>

NOTE
With this command, all active (in-use) spans will be set to the same format.

4 To set or change the span type, enter the correct option from the list at the entry prompt (>), as
shown in the following example:

> T1_2  <cr> 

NOTE
The entry is case-sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:

CP:  Invalid command
GLI2>

. . . continued on next page
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Table 6-26: Set BTS Span Parameter Configuration

� ActionStep

5 An acknowledgement similar to the following will be displayed:

The value has been programmed. It will take effect after the next reset.
GLI2>

6 If the current MGLI/GLI span rate must be changed, enter the following MMI command:

config  ni  linkspeed   <cr> 

The terminal will display a response similar to the following:

Next available options:
 LIST -  linkspeed : Span Linkspeed
                   56K : 56K (default for T1_1 and T1_3 systems)

                   64K : 64K (default for all other span configurations)
>

NOTE
With this command, all active (in-use) spans will be set to the same linkspeed.

7 To set or change the span linkspeed, enter the required option from the list at the entry prompt (>),
as shown in the following example:

> 64K  <cr>

NOTE
The entry is case-sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:

CP: Invalid command

GLI2>

8 An acknowledgement similar to the following will be displayed:

The value has been programmed.  It will take effect after the next reset.
GLI2>

9 If the span equalization must be changed, enter the following MMI command:

config ni equal  <cr>

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal span equal
Next available options:
   LIST -       span : Span
                       a : Span A
                       b : Span B
                       c : Span C
                       d : Span D
                       e : Span E
                       f : Span F
>

. . . continued on next page
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Table 6-26: Set BTS Span Parameter Configuration

� ActionStep

10 At the entry prompt (>), enter the designator from the list for the span to be changed as shown in
the following example:

> a  <cr>
The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal a equal 
Next available options:
   LIST -      equal : Span Equalization
                       0 : 0-131 feet (default for T1/J1)
                       1 : 132-262 feet
                       2 : 263-393 feet
                       3 : 394-524 feet
                       4 : 525-655 feet
                       5 : LONG HAUL
                       6 : 75 OHM
                       7 : 120 OHM (default for E1)
>

11 At the entry prompt (>), enter the code for the required equalization from the list as shown in the
following example:

> 0  <cr>
The terminal will display a response similar to the following:

> 0
The value has been programmed. It will take effect after the next reset.
GLI2>

12 Repeat steps 9 through 11 for each in-use span.

NOTE
After executing the config  ni  format, config ni linkspeed, and/or config  ni  equal commands,
the affected MGLI/GLI board MUST be reset and reloaded for changes to take effect.

Although defaults are shown, always consult site specific documentation for span type and
linkspeed used at the site.

13 Press the RESET button on the MGLI/GLI for changes to take effect.

. . . continued on next page
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Table 6-26: Set BTS Span Parameter Configuration

� ActionStep

14 Once the MGLI/GLI has reset, execute the following command to verify span settings are as
required:

config ni current  <cr>  (equivalent of span view command)

The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.
Equalization:
  Span A - 0-131 feet
  Span B - 0-131 feet
  Span C - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span D - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span E - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span F - Default (0-131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: 64K
Currently, the link is running at 64K
The actual rate is 0

15 If the span configuration is not correct, perform the applicable step from this table to change it and
repeat steps 13 and 14 to verify required changes have been programmed.

16 Return to step 6 of Table 6-25.

 

6
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Notes
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Optimization (Pre-ATP) Data Sheets

Verification of Test Equipment Used

Table A-1: Verification of Test Equipment Used

Manufacturer Model Serial Number

Comments:________________________________________________________

__________________________________________________________________
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Site Checklist

Table A-2: Site Checklist

OK Parameter Specification Comments

� Deliveries Per established procedures

� Floor Plan Verified

�

�

�

Inter Frame Cables:

Ethernet

Frame Ground

Power

Per procedure

Per procedure

Per procedure

�

�

�

Factory Data:

BBX

Test Panel

RFDS

Per procedure

Per procedure

Per procedure

� Site Temperature

� Dress Covers/Brackets

Preliminary Operations

Table A-3: Preliminary Operations

OK Parameter Specification Comments

� Shelf ID Dip Switches Per site equipage

� BBX Jumpers Verified per procedure

� Ethernet LAN verification Verified per procedure

Comments:_________________________________________________________
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Pre-Power  and Initial Power  Tests

Table A-4: Pre-power Checklist

OK Parameter Specification Comments

� Pre-power-up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications

�

�

�

�

�

�

�

�

Internal Cables:

ISB (all cages)

CSM (all cages)

Power (all cages)

Ethernet Connectors

LAN A ohms

LAN B ohms

LAN A shield

LAN B shield

Ethernet Boots

verified

verified

verified

verified

verified

isolated

isolated

installed

� Air Impedance Cage (single cage) installed

� Initial power-up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications:

Comments:_________________________________________________________
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General Optimization Checklist

Table A-5: Pre-power Checklist

OK Parameter Specification Comments

�

�

LEDs

Frame fans

illuminated

operational

�

�

�

�

�

�

LMF to BTS Connection

Preparing the LMF

Log into the LMF PC

Create site specific BTS directory

Create master-bts-cdma directory

Download device loads

Moving/Linking files

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

�

�

Ping LAN A

Ping LAN B

per procedure

per procedure

�

�

�

�

�

�

�

�

�

�

Download/Enable MGLIs

Download/Enable GLIs

Set Site Span Configuration

Download CSMs

Download

Enable CSMs

Download/Enable MCCs

Download BBXs

Download TSU (in RFDS)

Program TSU NAM

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

� Test Set Calibration per procedure

Comments:_________________________________________________________
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GPS Receiver Operation

Table A-6: GPS Receiver Operation

OK Parameter Specification Comments

� GPS Receiver Control Task State:

tracking satellites

Verify parameter

� Initial Position Accuracy: Verify Estimated
or Surveyed

� Current Position:
lat
lon
height

RECORD in ms
and cm also
convert to deg
min sec

� Current Position: satellites tracked

Estimated:

(>4) satellites tracked,(>4) satellites visible

Surveyed:

(>1) satellite tracked,(>4) satellites visible

Verify parameter
as appropriate:

� GPS Receiver Status:Current Dilution of
Precision 
(PDOP or HDOP): (<30)

Verify parameter

� Current reference source:
Number: 0; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LFR Receiver Operation

Table A-7: LFR Receiver Operation

OK Parameter Specification Comments

� Station call letters M X Y Z
assignment.

as specified in site
documentation

� SN ratio is > 8 dB

� LFR Task State: lfr

locked to station xxxx

Verify parameter

� Current reference source:

Number: 1; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LPA IM Reduction

Table A-8: LPA IM Reduction

Parameter Comments

CARRIER
OK LPA

# 4:1 & 2:1
3-Sector

2:1
6-Sector

Dual BP
3-Sector

Dual BP
6-Sector

Specification

� 1A C1 C1 C1 C1 No Alarms

� 1B C1 C1 C1 C1 No Alarms

� 1C C1 C1 C1 C1 No Alarms

� 1D C1 C1 C1 C1 No Alarms

� 2A C2 C2 C2 No Alarms

� 2B C2 C2 C2 No Alarms

� 2C C2 C2 C2 No Alarms

� 2D C2 C2 C2 No Alarms

� 3A C3 C1 C1 No Alarms

� 3B C3 C1 C1 No Alarms

� 3C C3 C1 C1 No Alarms

� 3D C3 C1 C1 No Alarms

� 4A C4 C2 No Alarms

� 4B C4 C2 No Alarms

� 4C C4 C2 No Alarms

� 4D C4 C2 No Alarms

Comments:_________________________________________________________

Cx - denotes physical carriers

For applied frequency requirements, see Appendix E.
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LPA Convergence

Table A-9: LPA Convergence

OK Parameter Specification Data

LPA # Converged

� 1A Verify per procedure & upload

� 1B
convergence data

� 1C

� 1D

� 2A Verify per procedure & upload

� 2B
convergence data

� 2C

� 2D

� 3A Verify per procedure & upload

� 3B
convergence data

� 3C

� 3D

� 4A Verify per procedure & upload

� 4B
convergence data

� 4C

� 4D
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TX BLO/Power Output Verification for 3-Sector Configurations
1-Carrier
2-Carrier  Non-adjacent Channels
4-Carrier Non-adjacent Channels

Table A-10: TX BLO Calibration (3-S: 1-C, and 2- and 4-C Non-adjacent Channels)

OK Parameter Specification Comments

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-4, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 3

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX-5, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-6, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-10, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 4

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX-1 1, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-12, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 1
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

. . . continued on next page
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Table A-10: TX BLO Calibration (3-S: 1-C, and 2- and 4-C Non-adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 2
BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-4, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-5, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 3
BBX-6, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-10, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-1 1, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 4
BBX-12, ANT-3 = dB

BBX-r , ANT-3 = dB

 

Comments:________________________________________________________

__________________________________________________________________

2-Carrier  Adjacent Channel

Table A-11: TX BLO Calibration (3-S: 2-C Adjacent Channels)

OK Parameter Specification Comments

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

. . . continued on next page
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Table A-11: TX BLO Calibration (3-S: 2-C Adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-7, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX-8, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-9, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 1
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-7, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-8, ANT-5 = dB

BBX-r , ANT-5 = dB

�

carrier 2
BBX-9, ANT-6 = dB

BBX-r , ANT-6 = dB

 

Comments:________________________________________________________

__________________________________________________________________

3-Carrier  Adjacent Channels
4-Carrier Adjacent Channels

Table A-12: TX BLO Calibration (3-S: 3- or 4-C Adjacent Channels)

OK Parameter Specification Comments

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

. . . continued on next page
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Table A-12: TX BLO Calibration (3-S: 3- or 4-C Adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-4, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibrate
carrier 3

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX-5, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-6, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-10, ANT-4 = dB

BBX-3, ANT-4 = dB

�
Calibrate
carrier 4

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX-1 1, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-12, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 1
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 2
BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

. . . continued on next page
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Table A-12: TX BLO Calibration (3-S: 3- or 4-C Adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-4, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-5, ANT-5 = dB

BBX-r , ANT-5 = dB

�

carrier 3
BBX-6, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-10, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-1 1, ANT-5 = dB

BBX-r , ANT-5 = dB

�

carrier 4
BBX-12, ANT-6 = dB

BBX-r , ANT-6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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TX BLO/Power Output Verification for 6-Sector Configurations
1-Carrier
2-Carrier  Non-adjacent Channels

Table A-13: TX BLO Calibration (6-S: 1-C, 2-C Non-adjacent Channels)

OK Parameter Specification Comments

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�

carrier 1 38 dB (minimum) prior to calibration BBX-4, ANT-4 = dB

BBX-r , ANT-4 = dB

�
BBX-5, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-6, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�

carrier 2 38 dB (minimum) prior to calibration BBX-10, ANT-4 = dB

BBX-3, ANT-4 = dB

�
BBX-1 1, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-12, ANT-6 = dB

BBX-r , ANT-5 = dB

. . . continued on next page
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Table A-13: TX BLO Calibration (6-S: 1-C, 2-C Non-adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

� Calibration 0 dB (+0.5 dB) for gain set resolution

BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�

Audit
carrier 1

post calibration BBX-4, ANT-4 = dB

BBX-r , ANT-4 = dB

�
BBX-5, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-6, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

� Calibration 0 dB (+0.5 dB) for gain set resolution

BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�

Audit
carrier 2

post calibration BBX-10, ANT-4 = dB

BBX-r , ANT-4 = dB

�
BBX-1 1, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-12, ANT-6 = dB

BBX-r , ANT-6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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BTS Redundancy/Alarm Tests

Table A-14: BTS Redundancy/Alarm Tests

OK Parameter Specification Data

� SIF: Misc. alarm tests Verify per procedure

� MGLI redundancy test Verify per procedure

� GLI redundancy test Verify per procedure

�
Power supply/converter
redundancy

Verify per procedure

� Misc. alarm tests Verify per procedure

�
CSM, GPS, & LFR
redundancy/alarm tests

Verify per procedure

� LPA redundancy test Verify per procedure

Comments:________________________________________________________

__________________________________________________________________

TX Antenna VSWR

Table A-15: TX Antenna VSWR

OK Parameter Specification Data

�
VSWR - 
Antenna 1

   < (1.5 : 1)

�
VSWR -
Antenna 2

   < (1.5 : 1)

�
VSWR -
Antenna 3

   < (1.5 : 1)

�
VSWR -
Antenna 4

   < (1.5 : 1)

�
VSWR -
Antenna 5

   < (1.5 : 1)

�
VSWR -
Antenna 6

   < (1.5 : 1)

Comments:________________________________________________________

__________________________________________________________________
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RX Antenna VSWR

Table A-16: RX Antenna VSWR

OK Parameter Specification Data

�
VSWR - 
Antenna 1

   < (1.5 : 1)

�
VSWR -
Antenna 2

   < (1.5 : 1)

�
VSWR -
Antenna 3

   < (1.5 : 1)

�
VSWR -
Antenna 4

   < (1.5 : 1)

�
VSWR -
Antenna 5

   < (1.5 : 1)

�
VSWR -
Antenna 6

   < (1.5 : 1)

Comments:_________________________________________________________

AMR Verification

Table A-17: AMR CDI Alarm Input Verification

OK Parameter Specification Data

�

Verify CDI alarm input
operation (“ALARM A”
(numbers 1 -18)

BTS Relay #XX -
Contact Alarm
Sets/Clears

�

Verify CDI alarm input
operation (“ALARM B” 
(numbers 19 -36)

BTS Relay #XX -
Contact Alarm
Sets/Clears

Comments:_________________________________________________________
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FIELD TRIAL
A-19

Site Serial Number Check List

Date Site

C-CCP  Shelf

Site I/O A & B
C-CCP Shelf
CSM-1

CSM-2

HSO

CCD-1

CCD-2
AMR-1

AMR-2

MPC-1

MPC-2

Fans 1-3 

GLI-1

GLI-2

BBX-1

BBX-2

BBX-3

BBX-4

BBX-5

BBX-6
BBX-7

BBX-8

BBX-9

BBX-10

BBX-1 1

BBX-12

BBX-r

MCC-1

MCC-2

MCC-3

MCC-4

MCC-5

MCC-6

MCC-7
MCC-8

MCC-9

A



Site Serial Number Check List 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

A-20

MCC-1-10

MCC-1 1

MCC-1-12

CIO
SWITCH

PS-1

PS-2

PS-3

LPAs

LPA 1A

LPA 1B

LPA 1C

LPA 1D

LPA 2A

LPA 2B

LPA 2C

LPA 2D

LPA 3A

LPA 3B

LPA 3C

LPA 3D

LPA 4A

LPA 4B

LPA 4C

LPA 4D

Power Conversion Shelf (-48 V BTS Only)

AMR

PS 4

PS 5

PS 6

PS 7

PS 8

PS 9

A



Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
B-1

Appendix B

PN Offset/I & Q Offset Register

Programming Information

B



PN Offset Programming Information 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

B-2

PN Offset Programming Information

PN Offset Background

All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 128 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Overall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBXs, where the corresponding
I & Q registers reside.

The PN offset values are determined on a per BTS/per sector(antenna)
basis as determined by the appropriate cdf file content. A breakdown of
this information is found in Table B-1.

PN Offset Usage

Only the 14-chip delay is currently in use. It is important to determine
the RF chip delay to be able to test the BTS functionality. This can be
done by ascertaining if the CDF file FineTxAdj  value was set to “on”
when the MCC was downloaded with “image data”. The FineTxAdj
value is used to compensate for the processing delay (approximately
20 �S) in the BTS using any type of mobile meeting IS-97
specifications.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 14 chip table.

NOTE CDF file I and Q values can be represented in DECIMAL or
HEX. If using HEX, add 0x before the HEX value. If necessary,
convert HEX values in Table B-1 to decimal before comparing
them to cdf file I & Q value assignments.

B



PN Offset Programming Information68P09255A61-4

Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
B-3

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

0 17523 23459 4473 5BA3

1 32292 32589 7E24 7F4D
2 4700 17398 125C 43F6

3 14406 26333 3846 66DD
4 14899 4011 3A33 0FAB

5 17025 2256 4281 08D0
6 14745 18651 3999 48DB

7 2783 1094 0ADF 0446
8 5832 21202 16C8 52D2

9 12407 13841 3077 3611
10 31295 31767 7A3F 7C17

11 7581 18890 1D9D 49CA
12 18523 30999 485B 7917

13 29920 22420 74E0 5794
14 25184 20168 6260 4EC8

15 26282 12354 66AA 3042
16 30623 11187 779F 2BB3

17 15540 11834 3CB4 2E3A
18 23026 10395 59F2 289B

19 20019 28035 4E33 6D83
20 4050 27399 0FD2 6B07

21 1557 22087 0615 5647
22 30262 2077 7636 081D

23 18000 13758 4650 35BE
24 20056 11778 4E58 2E02

25 12143 3543 2F6F 0DD7
26 17437 7184 441D 1C10

27 17438 2362 441E 093A
28 5102 25840 13EE 64F0

29 9302 12177 2456 2F91
30 17154 10402 4302 28A2

31 5198 1917 144E 077D
32 4606 17708 11FE 452C

33 24804 10630 60E4 2986
34 17180 6812 431C 1A9C

35 10507 14350 290B 380E
36 10157 10999 27AD 2AF7

37 23850 25003 5D2A 61AB
38 31425 2652 7AC1 0A5C

39 4075 19898 0FEB 4DBA
40 10030 2010 272E 07DA

41 16984 25936 4258 6550
42 14225 28531 3791 6F73

43 26519 11952 6797 2EB0
44 27775 31947 6C7F 7CCB

45 30100 25589 7594 63F5
46 7922 11345 1EF2 2C51

47 14199 28198 3777 6E26
48 17637 13947 44E5 367B

49 23081 8462 5A29 210E
50 5099 9595 13EB 257B

. . . continued on next page
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FIELD TRIAL

B-4

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

51 32743 4670 7FE7 123E

52 7114 14672 1BCA 3950
53 7699 29415 1E13 72E7

54 19339 20610 4B8B 5082
55 28212 6479 6E34 194F

56 29587 10957 7393 2ACD
57 19715 18426 4D03 47FA

58 14901 22726 3A35 58C6
59 20160 5247 4EC0 147F

60 22249 29953 56E9 7501
61 26582 5796 67D6 16A4

62 7153 16829 1BF1 41BD
63 15127 4528 3B17 11B0

64 15274 5415 3BAA 1527
65 23149 10294 5A6D 2836

66 16340 17046 3FD4 4296
67 27052 7846 69AC 1EA6

68 13519 10762 34CF 2A0A
69 10620 13814 297C 35F6

70 15978 16854 3E6A 41D6
71 27966 795 6D3E 031B

72 12479 9774 30BF 262E
73 1536 24291 0600 5EE3

74 3199 3172 0C7F 0C64
75 4549 2229 11C5 08B5

76 17888 21283 45E0 5323
77 13117 16905 333D 4209

78 7506 7062 1D52 1B96
79 27626 7532 6BEA 1D6C

80 31109 25575 7985 63E7
81 29755 14244 743B 37A4

82 26711 28053 6857 6D95
83 20397 30408 4FAD 76C8

84 18608 5094 48B0 13E6
85 7391 16222 1CDF 3F5E

86 23168 7159 5A80 1BF7
87 23466 174 5BAA 00AE

88 15932 25530 3E3C 63BA
89 25798 2320 64C6 0910

90 28134 23113 6DE6 5A49
91 28024 23985 6D78 5DB1

92 6335 2604 18BF 0A2C
93 21508 1826 5404 0722

94 26338 30853 66E2 7885
95 17186 15699 4322 3D53

96 22462 2589 57BE 0A1D
97 3908 25000 0F44 61A8

98 25390 18163 632E 46F3
99 27891 12555 6CF3 310B

100 9620 8670 2594 21DE

. . . continued on next page
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FIELD TRIAL
B-5

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

101 6491 1290 195B 050A

102 16876 4407 41EC 1137
103 17034 1163 428A 048B

104 32405 12215 7E95 2FB7
105 27417 7253 6B19 1C55

106 8382 8978 20BE 2312
107 5624 25547 15F8 63CB

108 1424 3130 0590 0C3A
109 13034 31406 32EA 7AAE

110 15682 6222 3D42 184E
111 27101 20340 69DD 4F74

112 8521 25094 2149 6206
113 30232 23380 7618 5B54

114 6429 10926 191D 2AAE
115 27116 22821 69EC 5925

116 4238 31634 108E 7B92
117 5128 4403 1408 1133

118 14846 689 39FE 02B1
119 13024 27045 32E0 69A5

120 10625 27557 2981 6BA5
121 31724 16307 7BEC 3FB3

122 13811 22338 35F3 5742
123 24915 27550 6153 6B9E

124 1213 22096 04BD 5650
125 2290 23136 08F2 5A60

126 31551 12199 7B3F 2FA7
127 12088 1213 2F38 04BD

128 7722 936 1E2A 03A8
129 27312 6272 6AB0 1880

130 23130 32446 5A5A 7EBE
131 594 13555 0252 34F3

132 25804 8789 64CC 2255
133 31013 24821 7925 60F5

134 32585 21068 7F49 524C
135 3077 31891 0C05 7C93

136 17231 5321 434F 14C9
137 31554 551 7B42 0227

138 8764 12115 223C 2F53
139 15375 4902 3C0F 1326

140 13428 1991 3474 07C7
141 17658 14404 44FA 3844

142 13475 17982 34A3 463E
143 22095 19566 564F 4C6E

144 24805 2970 60E5 0B9A
145 4307 23055 10D3 5A0F

146 23292 15158 5AFC 3B36
147 1377 29094 0561 71A6

148 28654 653 6FEE 028D
149 6350 19155 18CE 4AD3

150 16770 23588 4182 5C24

. . . continued on next page
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FIELD TRIAL

B-6

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

151 14726 10878 3986 2A7E

152 25685 31060 6455 7954
153 21356 30875 536C 789B

154 12149 11496 2F75 2CE8
155 28966 24545 7126 5FE1

156 22898 9586 5972 2572
157 1713 20984 06B1 51F8

158 30010 30389 753A 76B5
159 2365 7298 093D 1C82

160 27179 18934 6A2B 49F6
161 29740 23137 742C 5A61

162 5665 24597 1621 6015
163 23671 23301 5C77 5B05

164 1680 7764 0690 1E54
165 25861 14518 6505 38B6

166 25712 21634 6470 5482
167 19245 11546 4B2D 2D1A

168 26887 26454 6907 6756
169 30897 15938 78B1 3E42

170 11496 9050 2CE8 235A
171 1278 3103 04FE 0C1F

172 31555 758 7B43 02F6
173 29171 16528 71F3 4090

174 20472 20375 4FF8 4F97
175 5816 10208 16B8 27E0

176 30270 17698 763E 4522
177 22188 8405 56AC 20D5

178 6182 28634 1826 6FDA
179 32333 1951 7E4D 079F

180 14046 20344 36DE 4F78
181 15873 26696 3E01 6848

182 19843 3355 4D83 0D1B
183 29367 11975 72B7 2EC7

184 13352 31942 3428 7CC6
185 22977 9737 59C1 2609

186 31691 9638 7BCB 25A6
187 10637 30643 298D 77B3

188 25454 13230 636E 33AE
189 18610 22185 48B2 56A9

190 6368 2055 18E0 0807
191 7887 8767 1ECF 223F

192 7730 15852 1E32 3DEC
193 23476 16125 5BB4 3EFD

194 889 6074 0379 17BA
195 21141 31245 5295 7A0D

196 20520 15880 5028 3E08
197 21669 20371 54A5 4F93

198 15967 8666 3E5F 21DA
199 21639 816 5487 0330

200 31120 22309 7990 5725

. . . continued on next page
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FIELD TRIAL
B-7

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

201 3698 29563 0E72 737B

202 16322 13078 3FC2 3316
203 17429 10460 4415 28DC

204 21730 17590 54E2 44B6
205 17808 20277 4590 4F35

206 30068 19988 7574 4E14
207 12737 6781 31C1 1A7D

208 28241 32501 6E51 7EF5
209 20371 6024 4F93 1788

210 13829 20520 3605 5028
211 13366 31951 3436 7CCF

212 25732 26063 6484 65CF
213 19864 27203 4D98 6A43

214 5187 6614 1443 19D6
215 23219 10970 5AB3 2ADA

216 28242 5511 6E52 1587
217 6243 17119 1863 42DF

218 445 16064 01BD 3EC0
219 21346 31614 5362 7B7E

220 13256 4660 33C8 1234
221 18472 13881 4828 3639

222 25945 16819 6559 41B3
223 31051 6371 794B 18E3

224 1093 24673 0445 6061
225 5829 6055 16C5 17A7

226 31546 10009 7B3A 2719
227 29833 5957 7489 1745

228 18146 11597 46E2 2D4D
229 24813 22155 60ED 568B

230 47 15050 002F 3ACA
231 3202 16450 0C82 4042

232 21571 27899 5443 6CFB
233 7469 2016 1D2D 07E0

234 25297 17153 62D1 4301
235 8175 15849 1FEF 3DE9

236 28519 30581 6F67 7775
237 4991 3600 137F 0E10

238 7907 4097 1EE3 1001
239 17728 671 4540 029F

240 14415 20774 384F 5126
241 30976 24471 7900 5F97

242 26376 27341 6708 6ACD
243 19063 19388 4A77 4BBC

244 19160 25278 4AD8 62BE
245 3800 9505 0ED8 2521

246 8307 26143 2073 661F
247 12918 13359 3276 342F

248 19642 2154 4CBA 086A
249 24873 13747 6129 35B3

250 22071 27646 5637 6BFE

. . . continued on next page
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FIELD TRIAL

B-8

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

251 13904 1056 3650 0420

252 27198 1413 6A3E 0585
253 3685 3311 0E65 0CEF

254 16820 4951 41B4 1357
255 22479 749 57CF 02ED

256 6850 6307 1AC2 18A3
257 15434 961 3C4A 03C1

258 19332 2358 4B84 0936
259 8518 28350 2146 6EBE

260 14698 31198 396A 79DE
261 21476 11467 53E4 2CCB

262 30475 8862 770B 229E
263 23984 6327 5DB0 18B7

264 1912 7443 0778 1D13
265 26735 28574 686F 6F9E

266 15705 25093 3D59 6205
267 3881 6139 0F29 17FB

268 20434 22047 4FD2 561F
269 16779 32545 418B 7F21

270 31413 7112 7AB5 1BC8
271 16860 28535 41DC 6F77

272 8322 10378 2082 288A
273 28530 15065 6F72 3AD9

274 26934 5125 6936 1405
275 18806 12528 4976 30F0

276 20216 23215 4EF8 5AAF
277 9245 20959 241D 51DF

278 8271 3568 204F 0DF0
279 18684 26453 48FC 6755

280 8220 29421 201C 72ED
281 6837 24555 1AB5 5FEB

282 9613 10779 258D 2A1B
283 31632 25260 7B90 62AC

284 27448 16084 6B38 3ED4
285 12417 26028 3081 65AC

286 30901 29852 78B5 749C
287 9366 14978 2496 3A82

288 12225 12182 2FC1 2F96
289 21458 25143 53D2 6237

290 6466 15838 1942 3DDE
291 8999 5336 2327 14D8

292 26718 21885 685E 557D
293 3230 20561 0C9E 5051

294 27961 30097 6D39 7591
295 28465 21877 6F31 5575

296 6791 23589 1A87 5C25
297 17338 26060 43BA 65CC

298 11832 9964 2E38 26EC
299 11407 25959 2C8F 6567

300 15553 3294 3CC1 0CDE

. . . continued on next page
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FIELD TRIAL
B-9

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

301 17418 30173 440A 75DD

302 14952 15515 3A68 3C9B
303 52 5371 0034 14FB

304 27254 10242 6A76 2802
305 15064 28052 3AD8 6D94

306 10942 14714 2ABE 397A
307 377 19550 0179 4C5E

308 14303 8866 37DF 22A2
309 24427 15297 5F6B 3BC1

310 26629 10898 6805 2A92
311 20011 31315 4E2B 7A53

312 16086 19475 3ED6 4C13
313 24374 1278 5F36 04FE

314 9969 11431 26F1 2CA7
315 29364 31392 72B4 7AA0

316 25560 4381 63D8 111D
317 28281 14898 6E79 3A32

318 7327 23959 1C9F 5D97
319 32449 16091 7EC1 3EDB

320 26334 9037 66DE 234D
321 14760 24162 39A8 5E62

322 15128 6383 3B18 18EF
323 29912 27183 74D8 6A2F

324 4244 16872 1094 41E8
325 8499 9072 2133 2370

326 9362 12966 2492 32A6
327 10175 28886 27BF 70D6

328 30957 25118 78ED 621E
329 12755 20424 31D3 4FC8

330 19350 6729 4B96 1A49
331 1153 20983 0481 51F7

332 29304 12372 7278 3054
333 6041 13948 1799 367C

334 21668 27547 54A4 6B9B
335 28048 8152 6D90 1FD8

336 10096 17354 2770 43CA
337 23388 17835 5B5C 45AB

338 15542 14378 3CB6 382A
339 24013 7453 5DCD 1D1D

340 2684 26317 0A7C 66CD
341 19018 5955 4A4A 1743

342 25501 10346 639D 286A
343 4489 13200 1189 3390

344 31011 30402 7923 76C2
345 29448 7311 7308 1C8F

346 25461 3082 6375 0C0A
347 11846 21398 2E46 5396

348 30331 31104 767B 7980
349 10588 24272 295C 5ED0

350 32154 27123 7D9A 69F3

. . . continued on next page
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FIELD TRIAL

B-10

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

351 29572 5578 7384 15CA

352 13173 25731 3375 6483
353 10735 10662 29EF 29A6

354 224 11084 00E0 2B4C
355 12083 31098 2F33 797A

356 22822 16408 5926 4018
357 2934 6362 0B76 18DA

358 27692 2719 6C2C 0A9F
359 10205 14732 27DD 398C

360 7011 22744 1B63 58D8
361 22098 1476 5652 05C4

362 2640 8445 0A50 20FD
363 4408 21118 1138 527E

364 102 22198 0066 56B6
365 27632 22030 6BF0 560E

366 19646 10363 4CBE 287B
367 26967 25802 6957 64CA

368 32008 2496 7D08 09C0
369 7873 31288 1EC1 7A38

370 655 24248 028F 5EB8
371 25274 14327 62BA 37F7

372 16210 23154 3F52 5A72
373 11631 13394 2D6F 3452

374 8535 1806 2157 070E
375 19293 17179 4B5D 431B

376 12110 10856 2F4E 2A68
377 21538 25755 5422 649B

378 10579 15674 2953 3D3A
379 13032 7083 32E8 1BAB

380 14717 29096 397D 71A8
381 11666 3038 2D92 0BDE

382 25809 16277 64D1 3F95
383 5008 25525 1390 63B5

384 32418 20465 7EA2 4FF1
385 22175 28855 569F 70B7

386 11742 32732 2DDE 7FDC
387 22546 20373 5812 4F95

388 21413 9469 53A5 24FD
389 133 26155 0085 662B

390 4915 6957 1333 1B2D
391 8736 12214 2220 2FB6

392 1397 21479 0575 53E7
393 18024 31914 4668 7CAA

394 15532 32311 3CAC 7E37
395 26870 11276 68F6 2C0C

396 5904 20626 1710 5092
397 24341 423 5F15 01A7

398 13041 2679 32F1 0A77
399 23478 15537 5BB6 3CB1

400 1862 10818 0746 2A42

. . . continued on next page
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FIELD TRIAL
B-11

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

401 5850 23074 16DA 5A22

402 5552 20250 15B0 4F1A
403 12589 14629 312D 3925

404 23008 29175 59E0 71F7
405 27636 13943 6BF4 3677

406 17600 11072 44C0 2B40
407 17000 29492 4268 7334

408 21913 5719 5599 1657
409 30320 7347 7670 1CB3

410 28240 12156 6E50 2F7C
411 7260 25623 1C5C 6417

412 17906 27725 45F2 6C4D
413 5882 28870 16FA 70C6

414 22080 31478 5640 7AF6
415 12183 28530 2F97 6F72

416 23082 24834 5A2A 6102
417 17435 9075 441B 2373

418 18527 32265 485F 7E09
419 31902 3175 7C9E 0C67

420 18783 17434 495F 441A
421 20027 12178 4E3B 2F92

422 7982 25613 1F2E 640D
423 20587 31692 506B 7BCC

424 10004 25384 2714 6328
425 13459 18908 3493 49DC

426 13383 25816 3447 64D8
427 28930 4661 7102 1235

428 4860 31115 12FC 798B
429 13108 7691 3334 1E0B

430 24161 1311 5E61 051F
431 20067 16471 4E63 4057

432 2667 15771 0A6B 3D9B
433 13372 16112 343C 3EF0

434 28743 21062 7047 5246
435 24489 29690 5FA9 73FA

436 249 10141 00F9 279D
437 19960 19014 4DF8 4A46

438 29682 22141 73F2 567D
439 31101 11852 797D 2E4C

440 27148 26404 6A0C 6724
441 26706 30663 6852 77C7

442 5148 32524 141C 7F0C
443 4216 28644 1078 6FE4

444 5762 10228 1682 27F4
445 245 23536 00F5 5BF0

446 21882 18045 557A 467D
447 3763 25441 0EB3 6361

448 206 27066 00CE 69BA
449 28798 13740 707E 35AC

450 32402 13815 7E92 35F7

. . . continued on next page
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FIELD TRIAL

B-12

Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

451 13463 3684 3497 0E64

452 15417 23715 3C39 5CA3
453 23101 15314 5A3D 3BD2

454 14957 32469 3A6D 7ED5
455 23429 9816 5B85 2658

456 12990 4444 32BE 115C
457 12421 5664 3085 1620

458 28875 7358 70CB 1CBE
459 4009 27264 0FA9 6A80

460 1872 28128 0750 6DE0
461 15203 30168 3B63 75D8

462 30109 29971 759D 7513
463 24001 3409 5DC1 0D51

464 4862 16910 12FE 420E
465 14091 20739 370B 5103

466 6702 10191 1A2E 27CF
467 3067 12819 0BFB 3213

468 28643 19295 6FE3 4B5F
469 21379 10072 5383 2758

470 20276 15191 4F34 3B57
471 25337 27748 62F9 6C64

472 19683 720 4CE3 02D0
473 10147 29799 27A3 7467

474 16791 27640 4197 6BF8
475 17359 263 43CF 0107

476 13248 24734 33C0 609E
477 22740 16615 58D4 40E7

478 13095 20378 3327 4F9A
479 10345 25116 2869 621C

480 30342 19669 7686 4CD5
481 27866 14656 6CDA 3940

482 9559 27151 2557 6A0F
483 8808 28728 2268 7038

484 12744 25092 31C8 6204
485 11618 22601 2D62 5849

486 27162 2471 6A1A 09A7
487 17899 25309 45EB 62DD

488 29745 15358 7431 3BFE
489 31892 17739 7C94 454B

490 23964 12643 5D9C 3163
491 23562 32730 5C0A 7FDA

492 2964 19122 0B94 4AB2
493 18208 16870 4720 41E6

494 15028 10787 3AB4 2A23
495 21901 18400 558D 47E0

496 24566 20295 5FF6 4F47
497 18994 1937 4A32 0791

498 13608 17963 3528 462B
499 27492 7438 6B64 1D0E

500 11706 12938 2DBA 328A

. . . continued on next page
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Table B-1: PnMask I and PnMask Q Values for PilotPn

14-Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

501 14301 19272 37DD 4B48

502 23380 29989 5B54 7525
503 11338 8526 2C4A 214E

504 2995 18139 0BB3 46DB
505 23390 3247 5B5E 0CAF

506 14473 28919 3889 70F7
507 6530 7292 1982 1C7C

508 20452 20740 4FE4 5104
509 12226 27994 2FC2 6D5A

510 1058 2224 0422 08B0
511 12026 6827 2EFA 1AAB
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FRU Optimization/ATP Test Matrix
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FRU Optimization/ATP Test Matrix

Usage & Background

Periodic maintenance of a site may also may mandate re-optimization of
specific portions of the site. An outline of some basic guidelines is
included in the following tables.

NOTE Re-optimization steps listed for any assembly detailed in the
tables below must be performed anytime an RF cable associated
with it is replaced.

BTS Frame

Table C-1: When RF Optimization Is required on the BTS

Item Replaced Optimize:

C-CCP Shelf All sector TX and RX paths to all
Combined CDMA Channel Processor
(C-CCP) shelves.

Multicoupler/
Preselector Card

The three or six affected sector RX paths for
the C-CCP shelf in the BTS frames.

BBX board RX and TX paths of the affected C-CCP
shelf / BBX board.

CIO Card All RX and TX paths of the affected
CDMA carrier.

Any LPA Module The affected sector TX path.

LPA Backplane The affected sector TX path.

LPA Filter The affected sector TX path.

Ancillary Frame 

Item Replaced Optimize:

Directional Coupler All affected sector RX and TX paths to all
BTS frame shelves.

Site filter All affected RX sector paths in all shelves
in all BTS frames.

Any RFDS component
or TSU.

The RFDS calibration RX & TX paths
(MONFWD/GENFWD).
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Inter-frame Cabling

Optimization must be performed after the replacement of any RF cabling
between BTS frames.

Table C-2: When to Optimize Inter-frame Cabling

Item Replaced Optimize:

Ancillary frame to BTS
frame (RX) cables

The affected sector/antenna RX
paths.

BTS frame to ancillary frame
(TX) cables

The affected sector/antenna TX paths.

Detailed Optimization/ATP Test Matrix

Table C-3 outlines in more detail the tests that would need to be
performed if one of the BTS components were to fail and be replaced. It
is also assumes that all modules are placed OOS-ROM via the LMF
until full redundancy of all applicable modules is implemented.

The following guidelines should also be noted when using this table.

NOTE Not every procedure required to bring the site back on line is
indicated in Table C-3. It is meant to be used as a guideline
ONLY. The table assumes that the user is familiar enough with
the BTS Optimization/ATP procedure to understand which test
equipment set ups, calibrations, and BTS site preparation will be
required before performing the Table # procedures referenced.

Various passive BTS components (such as the TX and RX directional
couplers, Preselector IO, CIO; etc.) only call for a TX or RX calibration
audit to be performed in lieu of a full path calibration. If the RX or TX
path calibration audit fails, the entire RF path calibration will need to be
repeated. If the RF path calibration fails, further troubleshooting is
warranted.

Whenever any C-CCP BACKPLANE is replaced, it is assumed that
only power to the C-CCP shelf being replaced is turned off via the
breaker supplying that shelf.

Whenever any DISTRIBUTION BACKPLANE is replaced it is assumed
that the power to the entire RFM frame is removed and the Preselector
I/O is replaced. The modem frame should be brought up as if it were a
new installation.

NOTE If any significant change in signal level results from any
component being replaced in the RX or TX signal flow paths, it
would be identified by re-running the RX and TX calibration
audit command.

When the CIO is replaced, the C-CCP shelf remains powered up. The
BBX boards may need to be removed, then re-installed into their
original slots, and re-downloaded (code and BLO data). RX and TX
calibration audits should then be performed.
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Table C-3: SC 4812T BTS Optimization and ATP Test Matrix
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Table 2-1 2-3
Initial Boards/Modules Install,
Preliminary Operations, CDF
Site Equipage; etc.

� � � � � � � � � � � � � � � � � � � �

Table 2-2
Table 2-5

2-6
2-14

DC Power Pre-Test Physical
Inspect

� �

Table 2-7 2-15 Initial Power-up � � � � �

Table 3-6 3-14 Ping the Processors � � � � � �

Table 3-12 3-26 Download/Enable MGLIs � � �

Table 3-12 3-26 Download/Enable GLIs � � �

Table 3-13 3-27 Download CSMs � � � �

Table 3-13 3-27 Download MCCs � � � �

Table 3-13 3-27 Download BBXs � � �

Table 3-15 3-29 Enable CSMs � �

Table 3-16 3-30 Enable MCCs � �

Table 3-19 3-36 GPS Initialization / Verification � � �

Table 3-20 3-40 LFR Initialization / Verification � �

Table 3-21 3-42 HSO Initialization/Verification � �

Table 3-36 3-74 TX Path Calibration 4 4 4 1 1 4 * 3 3 4 7

Table 3-37 3-76 Download Offsets to BBX 4 4 1 4 *

Table 3-38 3-77 TX Path Calibration Audit 4 4 4 1 1 4 * 3 3 4 7

Table 3-46 3-88 RFDS Calibration Procedure 6 6 5 4 5 1 1 6 * 3 3 4 6

Table 4-1 4-5 Spectral Purity TX Mask ATP 4 4 1 4 * * * * *

Table 4-1 4-5 Waveform Quality (rho) ATP 4 4 * 1 4 * * * * * *

Table 4-1 4-5 Pilot Time Offset ATP 4 4 * 1 4 * * * * * *

Table 4-1 4-5 Code Domain Power / Noise
Floor

4 4 1 4 8 8 8 8 * * * *

Table 4-1 4-5 FER Test 5 5 5 5 2 2 5 8 8 8 8 * 7
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Table C-3: SC 4812T BTS Optimization and ATP Test Matrix
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Description
page

OPTIMIZATION AND TEST LEGEND

� Required

* Perform if necessary for additional fault isolation, repair assurance, or site certification.

**
Replace power converters one card at a time so that power to the C-CCP or LPA shelf is not lost. If
power to the C-CCP shelf is lost, all cards in the shelf must be downloaded again.

1 Perform on all carrier and sector TX paths to the C-CCP cage.

2 Perform on all carrier and sector RX paths to the C-CCP cage.

3 Perform on all primary and redundant TX paths of the affected carrier.

4 Perform on the affected carrier and sector TX paths. (BBXR replacement affects all carrier and
sector TX paths.)

5 Perform on the affected carrier and sector RX paths. (BBXR replacement affects all carrier and
sector RX paths.)

6 Perform on all RF paths of the affected carrier and sector (RFDS replacement affects all carriers.)

7 Perform with redundant BBX for all sectors on all carriers.

8 Verify performance by performing on one sector of one carrier only.
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BBX Gain Set Point vs. BTS Output
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BBX Gain Set Point vs. BTS Output Considerations

Usage & Background

Table D-1 outlines the relationship between the total of all code domain
channel element gain settings (digital root sum of the squares) and the
BBX Gain Set Point between 33.0 dBm and 44.0 dBm. The resultant RF
output (as measured at the top of the BTS in dBm) is shown in the table.
The table assumes that the BBX Bay Level Offset (BLO) values have
been calculated.

As an illustration, consider a BBX keyed up to produce a CDMA carrier
with only the Pilot channel (no MCCs forward link enabled). Pilot gain
is set to 262. In this case, the BBX Gain Set Point is shown to correlate
exactly to the actual RF output anywhere in the 33 to 44 dBm output
range. (This is the level used to calibrate the BTS).

Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

dBm�

Gain�
44 43 42 41 40 39 38 37 36 35 34 33

541 - - - - - - - 43.3 42.3 41.3 40.3 39.3

533 - - - - - - - 43.2 42.2 41.2 40.2 39.2

525 - - - - - - 44 43 42 41 40 39

517 - - - - - - 43.9 42.9 41.9 40.9 39.9 38.9

509 - - - - - - 43.8 42.8 41.8 40.8 39.8 38.8

501 - - - - - - 43.6 42.6 41.6 40.6 39.6 38.6

493 - - - - - - 43.5 42.5 41.5 40.5 39.5 38.5

485 - - - - - - 43.4 42.4 41.4 40.4 39.4 38.4

477 - - - - - - 43.2 42.2 41.2 40.2 39.2 38.2

469 - - - - - - 43.1 42.1 41.1 40.1 39.1 38.1

461 - - - - - 43.9 42.9 41.9 40.9 39.9 38.9 37.9

453 - - - - - 43.8 42.8 41.8 40.8 39.8 38.8 37.8

445 - - - - - 43.6 42.6 41.6 40.6 39.6 38.6 37.6

437 - - - - - 43.4 42.4 41.4 40.4 39.4 38.4 37.4

429 - - - - - 43.3 42.3 41.3 40.3 39.3 38.3 37.3

421 - - - - - 43.1 42.1 41.1 40.1 39.1 38.1 37.1

413 - - - - 44 43 42 41 40 39 38 37

405 - - - - 43.8 42.8 41.8 40.8 39.8 38.8 37.8 36.8

397 - - - - 43.6 42.6 41.6 40.6 39.6 38.6 37.6 36.6

389 - - - - 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4

 . . . continued on next page
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Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

dBm�

Gain�
333435363738394041424344

381 - - - - 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3

374 - - - - 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1

366 - - - 43.9 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9

358 - - - 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7

350 - - - 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5

342 - - - 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3

334 - - - 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1 35.1

326 - - 43.9 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9

318 - - 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7

310 - - 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5

302 - - 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2

294 - 44 43 42 41 40 39 38 37 36 35 34

286 - 43.8 42.8 41.8 40.8 39.8 38.8 37.8 36.8 35.8 34.8 33.8

278 - 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5 33.5

270 - 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3 34.3 33.3

262 44 43 42 41 40 39 38 37 36 35 34 33

254 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7 33.7 -

246 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4 35.4 34.4 33.4 -

238 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 -

230 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9 33.9 - -

222 42.6 41.6 40.6 39.6 38.6 37.6 36.6 35.6 34.6 33.6 - -

214 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 - -
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Operating Frequency - North American PCS Bands

Introduction

Programming of each of the BTS BBX synthesizers is performed by the
BTS GLIs via the CHI bus. This programming data determines the
transmit and receive transceiver operating frequencies (channels) for
each BBX.

1900 MHz PCS Channels

Figure E-1 shows the valid channels for the North American PCS
1900 MHz frequency spectrum. There are 10 CDMA wireline or
non-wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-1: North American PCS 1900 MHz Frequency Spectrum
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 . . . continued on next page
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Calculating 1900 MHz Center Frequencies
Table E-1 shows selected 1900 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� TX = 1930 + 0.05 * Channel#
Example: Channel 262
TX = 1930 + 0.05*262 = 1943.10 MHz

� RX = TX - 80
Example: Channel 262
RX = 1943.10 - 80 = 1863.10 MHz

Actual frequencies used depend on customer CDMA system frequency
plan.

Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard band on
both sides of the carrier.

Minimum frequency separation required between any CDMA carrier and
the nearest NAMPS/AMPS carrier is 900 kHz (center-to-center).

Table E-1: 1900 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1931.25 1851.25

50 0032 1932.50 1852.50

75 004B 1933.75 1853.75

100 0064 1935.00 1855.00

125 007D 1936.25 1856.25

150 0096 1937.50 1857.50

175 00AF 1938.75 1858.75

200 00C8 1940.00 1860.00

225 00E1 1941.25 1861.25

250 00FA 1942.50 1862.50

275 0113 1943.75 1863.75

300 012C 1945.00 1865.00

325 0145 1946.25 1866.25

350 015E 1947.50 1867.50

375 0177 1948.75 1868.75

400 0190 1950.00 1870.00

425 01A9 1951.25 1871.25

450 01C2 1952.50 1872.50

475 01DB 1953.75 1873.75

500 01F4 1955.00 1875.00

525 020D 1956.25 1876.25

550 0226 1957.50 1877.50

575 023F 1958.75 1878.75
. . . continued on next page

E



Operating Frequency - North American PCS Bands 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

E-4

Table E-1: 1900 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal       Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

600 0258 1960.00 1880.00

625 0271 1961.25 1881.25

650 028A 1962.50 1882.50

675 02A3 1963.75 1883.75

700 02BC 1965.00 1885.00

725 02D5 1966.25 1886.25

750 02EE 1967.50 1887.50

775 0307 1968.75 1888.75

800 0320 1970.00 1890.00

825 0339 1971.25 1891.25

850 0352 1972.50 1892.50

875 036B 1973.75 1893.75

900 0384 1975.00 1895.00

925 039D 1976.25 1896.25

950 03B6 1977.50 1897.50

975 03CF 1978.75 1898.75

1000 03E8 1980.00 1900.00

1025 0401 1981.25 1901.25

1050 041A 1982.50 1902.50

1075 0433 1983.75 1903.75

1100 044C 1985.00 1905.00

1125 0465 1986.25 1906.25

1150 047E 1987.50 1807.50

1175 0497 1988.75 1908.75
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800 MHz CDMA Channels

Figure E-2 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non-wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-2: North American Cellular Telephone System Frequency Spectrum
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Calculating 800 MHz Center Frequencies

Table E-2 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� Channels 1-777
TX = 870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03*262 = 877.86 MHz

� Channels 1013-1023
TX = 870 + 0.03 * (Channel# - 1023)
Example: Channel 1015
TX = 870 +0.03 *(1015 - 1023) = 869.76 MHz

� RX = TX - 45 MHz
Example: Channel 262
RX = 877.86 -45 = 832.86 MHz

Table E-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

1 0001 870.0300 825.0300

25 0019 870.7500 825.7500

50 0032 871.5000 826.5000
. . . continued on next page
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Table E-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

75 004B 872.2500 827.2500

100 0064 873.0000 828.0000

125 007D 873.7500 828.7500

150 0096 874.5000 829.5000

175 00AF 875.2500 830.2500

200 00C8 876.0000 831.0000

225 00E1 876.7500 831.7500

250 00FA 877.5000 832.5000

275 0113 878.2500 833.2500

300 012C 879.0000 834.0000

325 0145 879.7500 834.7500

350 015E 880.5000 835.5000

375 0177 881.2500 836.2500

400 0190 882.0000 837.0000

425 01A9 882.7500 837.7500

450 01C2 883.5000 838.5000

475 01DB 884.2500 839.2500

500 01F4 885.0000 840.0000

525 020D 885.7500 840.7500

550 0226 886.5000 841.5000

575 023F 887.2500 842.2500

600 0258 888.0000 843.0000

625 0271 888.7500 843.7500

650 028A 889.5000 844.5000

675 02A3 890.2500 845.2500

700 02BC 891.0000 846.0000

725 02D5 891.7500 846.7500

750 02EE 892.5000 847.5000

775 0307 893.2500 848.2500

NOTE
Channel numbers 778 through 1012 are not used.

1013 03F5 869.7000 824.7000

1023 03FF 870.0000 825.0000
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Operating Frequency - Korean Bands

1700 MHz PCS Channels

Figure E-3 shows the valid channels for the 1700 MHz PCS frequency
spectrum. The CDMA channels are spaced in increments of 25 (25, 50,
75, . . . 575) across the CDMA band.

Figure E-3: 1700 MHz PCS Frequency Spectrum

 FREQ (MHz)
RX              TX

575

CHANNEL
1751.2525

1778.75

1841.25

1868.75
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Calculating 1700 MHz Center Frequencies
Center frequency for channels may be calculated as follows:

Direction Formula Example

TX 1840 + (0.05 * Channel#) Channel: 1840 + (0.05 + 25) = 1841.25

RX 1750 + (0.05 * Channel#) Channel: 1750 + (0.05 + 25) = 1751.25

- Actual frequencies used depend on customer CDMA system
frequency plan.

- Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard
band on both sides of the carrier

- Minimum frequency separation required between any CDMA
carrier and the nearest NAMPS/AMPS carrier is 900 kHz (center to
center).

Table E-3: 1700 MHz TX and RX Frequency vs. Channel (Korean Bands)

Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1841.25 1751.25

50 0032 1842.50 1752.50

75 004B 1843.75 1753.75

100 0064 1845.00 1755.00

125 007D 1846.25 1756.25

150 0096 1847.50 1757.50

175 00AF 1848.75 1758.75

200 00C8 1850.00 1760.00

225 00E1 1851.25 1761.25

250 00FA 1852.50 1762.50

275 0113 1853.75 1763.75

300 012C 1855.00 1765.00

325 0145 1856.25 1766.25

350 015E 1857.50 1767.50

375 0177 1858.75 1768.75

400 0190 1860.00 1770.00

425 01A9 1861.25 1771.25

450 01C2 1862.50 1772.50

475 01DB 1863.75 1773.75

500 01F4 1865.00 1775.00

525 020D 1866.25 1776.25

550 0226 1867.50 1777.50

575 023F 1868.75 1778.75

E



Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
F-1

Appendix F

PCS Interface Setup for Manual

Testing
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Test Equipment Set-up

Purpose

This section covers other test equipment and peripherals not covered in
Chapter 3. Procedures for the manual testing are covered here, along
with procedures to calibrate the TX and RX cables using the signal
generator and spectrum analyzer.

Equipment Warm up

NOTE Warm-up BTS equipment for a minimum of 60 minutes prior to
performing the BTS optimization procedure. This assures BTS
site stability and contributes to optimization accuracy. (Time
spent running initial power-up, hardware/
firmware audit, and BTS download counts as warm-up time.)

CAUTION If any piece of test equipment (i.e., test cable, RF adapter) has
been replaced, re-calibration must be performed. Failure to do so
could introduce measurement errors, resulting in incorrect
measurements and degradation to system performance.

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment  after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

Prerequisites

Prior to performing any of these procedures, all preparations for
preparing the LMF, updating LMF files, and any other pre-calibration
procedures, as stated in Chapter 3, must have been completed.
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HP8921A System Connectivity Test

Follow the steps in Table F-1 to verify that the connections between the
PCS Interface and the HP8921A are correct, and cables are intact. The
software also performs basic functionality checks of each instrument.

NOTE Disconnect other GPIB devices, especially system controllers,
from the system before running the connectivity software.

Table F-1: System Connectivity

Step Action

NOTE
- Perform this procedure after test equipment has been allowed to warm-up and stabilize for a

minimum of 60 minutes.

1 Insert HP 83236A Manual Control/System card into memory card slot.

2 Press the [PRESET] pushbutton.

3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.

4 Position the cursor at Select Procedure Location and select by pressing the cursor control knob.

In the Choices selection box, select Card.

5 Position the cursor at Select Procedure Filename and select by pressing the cursor control knob.

In the Choices selection box, select SYS_CONN.

6 Position the cursor at RUN TEST and select it.

The software will prompt you through the connectivity setup.

7 When the test is complete, position the cursor on STOP TEST and select it; OR press the [K5]
pushbutton.

8 To return to the main menu, press the [K5] pushbutton.
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Manual Cable Calibration using HP8921 with HP PCS  Interface (HP83236)

Perform the procedure in Table F-2 to calibrate the test equipment using
the HP8921 Cellular Communications Analyzer equipped with the
HP83236 PCS Interface.

NOTE
This calibration method must be executed with great care. Some
losses are measured close to the minimum limit of the power
meter sensor (-30 dBm).

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for cable
calibration.

� Test equipment has been selected and calibrated.

Refer to Figure F-1 for location of the components on the PCS Interface
and Communications Test Set.

Table F-2: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

NOTE
Verify that GPIB controller is turned off.

1 Insert HP 83236A Manual Control System card into memory card slot (see Figure F-1).

2 Press the Preset pushbutton.

3 Under Screen Controls, press the TESTS pushbutton to display the TESTS (Main Menu) screen.

4 Position the cursor at Select Procedure Location and select it. In the Choices selection box, select
CARD.

5 Position the cursor at Select Procedure Filename and select it. In the Choices selection box, select
MANUAL.

6 Position the cursor at RUN TEST and select it. HP must be in Control Mode Select YES.

7 If using HP 83236A:
Set channel number=<chan#>:

- Position cursor at Channel
Number and select it.

- Enter the chan# using the numeric
keypad; press [Enter] and the
screen will go blank.

- When the screen reappears, the
chan# will be displayed on the
channel number line.

If using HP 83236B:
Set channel frequency:

- Position cursor at Frequency Band and press Enter.

- Select User Defined Frequency.

- Go Back to Previous Menu.

- Position the cursor to 83236 generator frequency and
enter actual RX frequency.

- Position the cursor to 83236 analyzer frequency and
enter actual TX frequency.

8 Set RF Generator level:

- Position the cursor at RF Generator Level and select it.

- Enter -10  using the numeric keypad; press [Enter] and the screen will go blank.

- When the screen reappears, the value -10 dBm will be displayed on the RF Generator Level line.

. . . continued on next page
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Table F-2: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

9 Set the user fixed Attenuation Setting to 0 dBm:

- Position cursor at Analyzer Attenuation and select it
- Position cursor at User Fixed Atten Settings and select it.

- Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Record the HP83236 Generator Frequency Level:

Record the HP83236B Generator Frequency Level:

- Position cursor at Show Frequency and Level Details and select it.
- Under HP83236 Frequencies and Levels, record the Generator Level.
- Under HP83236B Frequencies and Levels, record the Generator Frequency Level

(1850 - 1910 MHz for 1.9 GHz or 1750 - 1780 for 1.7 GHz).

- Position cursor at Prev Menu and select it.

12 Click on Pause for Manual Measurement.

13 Connect the power sensor directly to the RF OUT ONLY port of the PCS Interface.

14 On the HP8921A, under To Screen, select CDMA GEN.

15 Move the cursor to the Amplitude field and click on the Amplitude value.

16 Increase the Amplitude value until the power meter reads 0 dBm ±0.2 dB.

NOTE
The Amplitude value can be increased coarsely until 0 dBM is reached; then fine tune the amplitude
by adjusting the Increment Set to 0.1 dBm and targeting in on 0 dBm.

17 Disconnect the power sensor from the RF OUT ONLY port of the PCS Interface.

NOTE
The Power Meter sensor’s lower limit is -30 dBm. Thus, only components having losses ≤30 dB
should be measured using this method. For further accuracy, always re-zero the power meter
before connecting the power sensor to the component being calibrated. After connecting the
power sensor to the component, record the calibrated loss immediately.

18 Disconnect all components in the test setup and calibrate each one separately by connecting each
component, one-at-a-time, between the RF OUT ONLY PORT and the power sensor (see Figure F-1,
Setups A, B, or C). Record the calibrated loss value displayed on the power meter.

� Example: (A) Test Cable(s) = -1.4 dB
(B) 20 dB Attenuator = -20.1 dB
(B) Directional Coupler = -29.8 dB

19 After all components are calibrated, reassemble all components together and calculate the total test
setup loss by adding up all the individual losses:
� Example: Total test setup loss = -1.4 -29.8 -20.1 = -51.3 dB.

This calculated value will be used in the next series of tests.

20 Under Screen Controls press the TESTS button to display the TESTS (Main Menu) screen.

21 Select Continue (K2).

22 Select RF Generator Level and set to -119 dBm.

. . . continued on next page
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Table F-2: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

23 Click on Pause for Manual Measurement.

24 Verify the HP8921A Communication Analyzer/83203A CDMA interface setup is as follows (fields
not indicated remain at default):

� Verify the GPIB (HP-IB) address:

- under To Screen, select More

- select IO CONFIG

- Set HP-IB Adrs to 18

- set Mode to Talk&Lstn

� Verify the HP8921A is displaying frequency (instead of RF channel)

- Press the blue [SHIFT] button, then press the Screen Control [DUPLEX] button; this switches to
the CONFIG (CONFIGURE) screen.

- Use the cursor control to set RF Display to Freq

25 Refer to Table 3-31 for assistance in manually setting the cable loss values into the LMF.
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Figure F-1: Calibrating Test Setup Components
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HP PCS Interface Test Equipment Setup for Manual Testing

Follow the procedure in Table F-3 to setup the HP PCS Interface Box for
manual testing.

Table F-3: HP PCS Interface Test Equipment Setup for Manual Testing

� Step Action

NOTE
Verify GPIB controller is turned off.

1 Insert HP83236B Manual Control/System card into the memory card slot.

2 Under Screen Controls, press the [TESTS] push-button to display the TESTS (Main Menu)
screen.

3 Position the cursor at Select Procedure Location and select. In the Choices selection box, select
CARD.

4 Position the cursor at Select Procedure Filename and select. In the Choices selection box, select
MANUAL.

5 Position the cursor at RUN TEST and select OR press the K1 push-button.

6 Set channel number=<chan#>:

- Position cursor at Channel Number and select.

- Enter the chan# using the numeric keypad and then press [Enter] (the screen will blank).

- When the screen reappears, the chan# will be displayed on the channel number line.

NOTE
If using a TMPC with Tower Top Amplifier (TTA) skip Step 7.

7 � Set RF Generator level= -119 dBm + Cal factor

Example: -119 dBm + 2 dB = -117 dBm

� Continue with Step 9 (skip Step 8).

8 Set RF Generator level= -116 dBm + Cal factor.

Example: -116 dBm + 2 dB = -114 dBm

9 Set the user fixed Attenuation Setting to 0 dB:

- Position cursor at RF Generator Level and select.

- Position  cursor at User Fixed Atten Settings and select.

- Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Select Quit, then select Yes.
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Calibrating Test Cable Setup using Advantest R3465

NOTE Be sure the GPIB Interface is OFF for this procedure.

Perform the procedure in Table F-4 to calibrate the test cable setup using
the Advantest R3465. Advantest R3465 Manual Test setup and
calibration must be performed at both the TX and RX frequencies.

Table F-4: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

NOTE
- This procedure can only be performed after test equipment has been allowed to warm-up and

stabilize for a minimum of 60 minutes.

1 Press the SHIFT and the PRESET keys located below the display.

2 Press the ADVANCE key in the MEASUREMENT area of the control panel.

3 Select the CDMA Sig CRT menu key.

4 Select the Setup CRT menu key.

5 Using the vernier knob and the cursor keys set the following parameters:

NOTE
Fields not listed remain at default.

Generator Mode: SIGNAL

Link: FORWARD

Level Unit: dBm

CalCorrection: ON

Level Offset: OFF

6 Select the return CRT menu key.

7 Press FREQ key in the ENTRY area.

8 Set the frequency to the desired value using the keypad entry keys.

9 Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.

10 Verify that the Output CRT menu key is highlighting OFF; if not, press the Output key to toggle it
OFF.

11 Press the LEVEL key in the ENTRY area.

12 Set the LEVEL to 0 dBm using the key pad entry keys.

13 Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.

14 Press the Output CRT menu key to toggle Output to ON.

15 Record the power meter reading  ________________________

16 Disconnect the power meter sensor from the R3561L RF OUT jack.

. . . continued on next page
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Table F-4: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

NOTE
The Power Meter sensor lower limit is -30 dBm. Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re-zero the power meter before
connecting the power sensor to the component being calibrated.  Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 Disconnect all components in the the test setup and calibrate each one separately.  Connect each
component one-at-a-time between the “RF OUT” port and the power sensor (see Figure F-2, “Setups
A, B, and C”). Record the calibrated loss value displayed on the power meter for each connection.

Example: (A) 1st Test Cable =  -0.5 dB
(B) 2nd Test Cable =  -1.4 dB
(C) 20 dB Attenuator =  -20.1 dB
(D) 30 dB Directional Coupler =  -29.8 dB

18 Press the Output CRT menu key to toggle Output OFF.

19 Calculate the total test setup loss by adding up all the individual losses:

Example: Total test setup loss  =  0.5 + 1.4 + 20.1 + 29.8  =  51.8 dB

This calculated value will be used in the next series of tests.

20 Press the FREQ key in the ENTRY area.

21 Using the keypad entry keys, set the test frequency to the RX frequency.

22 Repeat steps 9 through 19 for the RX frequency.

23 Refer to Table 3-31 for assistance in manually setting the cable loss values into the LMF.
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Figure F-2: Cable Calibration using Advantest R3465
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Notes
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Appendix G

VSWR
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Transmit & Receive Antenna VSWR

Purpose

The following procedures will verify that the Voltage Standing Wave
Ratio (VSWR) of all antennas and associated feed lines fall within
acceptable limits. The tests will be performed on all antennas in a
sequential manner (i.e., ANT 1, then ANT 2) until all antennas/feedlines
have been verified.

These procedures should be performed periodically by measuring each
respective antenna’s VSWR (reflected power) to verify that the antenna
system is within acceptable limits. This will ensure continued peak
system performance.

The antenna VSWR will be calculated at the CDMA carrier frequency
assigned to each antenna. Record and verify that they meet the test
specification of less than or equal to 1.5:1.

NOTE Motorola  recommends that the installer be familiar with the
following procedure in its entirety before beginning the actual
procedure. Ensure that the entire site is currently not in service.

This test is used to test RX antennas by substituting RX
frequencies for TX frequencies.

Study the site engineering documents and perform the following tests
only after first verifying that the RF cabling configuration required to
interconnect the BTS frames and antennas meet requirements called out
in the BTS Installation Manual.

Test equipment

The following pieces of test equipment will be required to perform this
test:

� LMF

� Directional coupler

� Communications test set

WARNING Prior to performing antenna tests, insure that no CDMA BBX
channels are keyed. Failure to do so could result in personal
injury or serious equipment damage.
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Equipment Setup - HP Test Set 

Follow the procedure in Table G-1 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table G-1: VSWR Measurement Procedure - HP Test Set

Step Action HP TEST SET

1 If you have not already done so, refer to the procedure in Table 3-2 on page 3-6 to set up test
equipment & interface the LMF computer to the BTS.

2 For manual VSWR testing, using external directional coupler, refer to Figure G-1 (1700/1900 MHz)
or Figure G-2 (800 MHz).

- Connect the communications test set RF OUT ONLY port to the INPUT port of the directional
coupler.

- Connect the RF IN/OUT port of the communication test set to the reverse (RVS) port on the
directional coupler. Terminate the forward port with a 50 ohm load.

- Install the antenna feed line to the output port on the directional coupler.

NOTE
Manual Communications Analyzer test setup (fields not indicated remain at default):

� Set screen to RF GEN.

- For 1900 MHz systems, set the RF Gen Freq to center frequency of actual CDMA carrier
between 1930-1990 MHz for TX and 1850-1910 MHz for RX. For 800 MHz systems, set the
RF Gen Freq to center frequency of actual CDMA carrier between 869-894 MHz for TX and
824-849 MHz for RX. For 1700 MHz systems, set the RF Gen Freq to center frequency of
actual CDMA carrier between 1840-1870 MHz for TX and 1750-1780 MHz for RX.

- Set Amplitude to -30 dBm.

- Set Output Port to RF OUT.

- Set AFGen1 & AFGen2 to OFF.

3 Remove the antenna feed line and install an “RF short” onto the directional coupler output port.

NOTE
Set-up communication test set as follows (fields not indicated remain at default):

� Set  screen to SPEC ANL.

- Under Controls, set input port to ANT.

- Set Ref Level to -40 dBm.

- Under Controls, select Main, select Auxiliary.

- Under Controls, select AVG. Set Avg = 20.

4 - Record the reference level on the communications analyzer and Note as PS for reference. 

- Replace the short with the antenna feedline. Record the reference level on the communications
analyzer and Note for as PA reference.

- Record the difference of the two readings in dB.

. . . continued on next page
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Table G-1: VSWR Measurement Procedure - HP Test Set

Step HP TEST SETAction

5 Calculate the VSWR per the equation shown to the right.
Where:

RL(dB) = PA(dBm) - PS(dBm) 
PA = Power reflected from antenna
PS = Power reflected from short

A calculated value of  -13.98 dB equates to VSWR of better than 1.5:1.

VSWR ���
�

�

1 � 10
RL
20

1 – 10
RL

20

��
�

�

6 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in-line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

7 Repeat steps 2 through 6 for all remaining TX sectors/antennas.

8 Repeat steps 2 through 6 for all remaining RX sectors/antennas.

 

Figure G-1: Manual VSWR Test Setup Using HP8921 Test Set (1700/1900 MHz)
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Figure G-2: Manual VSWR Test Setup Using HP8921 Test Set (800 MHz)
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Equipment Setup - Advantest  Test Set

Follow the steps in Table G-2 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table G-2: VSWR Measurement Procedure - Advantest Test Set

Step Action ADVANTEST

1 If you have not already done so, refer to the procedure in Table 3-2 on page 3-6 to set up test
equipment and interface the LMF computer to the BTS.

2 For manual VSWR testing using external directional coupler, refer to Figure G-3.

- Connect the communications test set RF OUT port to the input port of the directional coupler.

- Connect the INPUT port of the communication test set to the forward port on the directional
coupler. Terminate the forward port with a 50 Ohm load.

- Connect the RF short to the directional coupler output port.

. . . continued on next page
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Table G-2: VSWR Measurement Procedure - Advantest Test Set

Step ADVANTESTAction

3 Preform the following to instruct the calibrated test set to generate a CDMA RF carrier (RVL call)
with all zero longcode at the assigned RX frequency at -10 dBm:

� Push the ADVANCE Measurement key.

� Push the CDMA Sig CRT menu key.

� Push the FREQ Entry key:

- For 1900 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
1930-1990 MHz for  TX and 1850-1910 MHz for RX.

- For 800 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
869-894 MHz for  TX and 824-849 MHz for RX.

- For 1700 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
1840-1870 MHz for  TX and 1750-1780 MHz for RX.

� Push the LEVEL Entry key; set to 0 dBm (by entering 0 and pushing the -dBm key).

� Verify  that ON is active in the Output CRT menu key.

� Verify  that OFF is active in the Mod CRT menu key.

� Push the CW Measurement key.

� Push the FREQ Entry key.

- Push the more 1/2 CRT menu key.

- Set Preselect CRT menu key to 3.0G.

� Push the Transient Measurement key.

- Push the Tx Power CRT menu key.

- Push the LEVEL entry key (set to 7 dBm by entering 7 and pushing the the dBm key).

- Set Avg Times CRT menu key to ON. Set to 20 (by entering 20 and pushing the Hz ENTER
key).

� Push the REPEAT Start key to take the measurement.

4 Record the Burst Power display on the communications analyzer and Note as PS for reference.

5 Install the antenna feedline to the output port of the directional coupler.

6 � Push the Auto Level Set CRT menu key.

� Push the REPEAT Start key to take the measurement.

7 Record the Burst Power on the communications analyzer and Note as PA level for reference.

Record the difference of the two readings in dBm.

8 Calculate the VSWR per the equation shown to the right.
Where:

RL(dB) = PA(dBm) - PS(dBm) 
PA = Power reflected from antenna
PS = Power reflected from short

A calculated value of  -13.98 dB equates to VSWR of better than 1.5:1.

VSWR ���
�

�

1 � 10
RL
20

1 – 10
RL

20

��
�

�

. . . continued on next page
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Table G-2: VSWR Measurement Procedure - Advantest Test Set

Step ADVANTESTAction

9 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in-line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

10 Repeat steps 2 through 9 for all remaining TX sectors/antennas.

11 Repeat steps 2 through 9 for all remaining RX sectors/antennas.

 

Figure G-3: Manual VSWR Test Setup Using Advantest R3465
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Download ROM Code

Download ROM Code
ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to
OOS_ROM (blue) and remains OOS_ROM (blue). The same R-level
RAM code must then be downloaded to the device. This procedure
includes steps for both the ROM code download and the RAM code
download.

ROM code files cannot be selected automatically. The ROM code file
must be selected manually. Follow the procedure in Table H-1 to
download ROM code.

Prerequisite
� ROM and RAM code files exist for the device to be downloaded.

CAUTION The R-level of the ROM code to be downloaded must be the
same as the R-level of the ROM code for other devices in the
BTS. Code must not be mixed in a BTS. This procedure should
only be used to upgrade replacement devices for a BTS and it
should not be used to upgrade all devices in a BTS. If a BTS is
to be upgraded from one R-level to another, the optimization
and ATP procedures must first be performed with the BTS in the
original configuration. The upgrade should then be done by the
CBSC.

Table H-1: Download ROM Code

Step Action

1 Click on the device to be downloaded.

NOTE
More than one device of the same type can be selected for download by either clicking on each one to
be downloaded or from the BTS menu bar Select pull-down menu, select the device item that applies.

Where:  device  =  the type of device to be loaded (BBX, CSM, GLI, MCC)

2 Click on the Device menu.

3 Click on the Status menu item.

A status report window appears.

4 Make a note of the number in the HW Bin Type column.

NOTE
“HW Bin Type” is the Hardware Binary Type for the device. This code is used as the last four digits in
the filename of a device’s binary ROM code file. Using this part of the filename, the ROM code file
can be matched to the device in which it is to be loaded.

5 Click on the OK button to dismiss the status report window.

NOTE
ROM code is automatically selected for download from the <x>:\<lmf home
directory>\version folder>\<code folder> specified by the NextLoad property in
the bts-#.cdf file. To check the value of the NextLoad property, click on Util > Examine >
Display Nextload. A pop-up message will show the value of the NextLoad.

. . . continued on next page
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Table H-1: Download ROM Code

Step Action

6 From the BTS menu bar Device pull-down menus, select Download > ROM.

- If the file matching the Hardware Binary Type of the device is found in the code folder, a status
report shows the result of the download. Proceed to Step 12.

- If a file selection window appears, select the ROM code file manually.

7 Double-click on the version folder that contains the desired ROM code file.

8 Double-click on the Code folder.

A list of ROM and RAM code files is displayed.

! CAUTION
A ROM code file having the correct hardware binary type (HW Bin Type) needs to be chosen. The
hardware binary type (last four digits in the file name) was determined in step 4. Unpredictable results
can happen and the device may be damaged (may have to be replaced) if a ROM code file with wrong
binary type is downloaded.

9 Choose a ROM code file having the correct hardware binary type (HW Bin Type).
The hardware binary type (last four digits in the file name) was determined in step 4.

10 Click on the ROM code file that matches the device type and HW Bin Type (e.g., bbx_rom.bin.0604
for a BBX having a HW Bin Type of 0604).

The file should be highlighted.

11 Click on the Load button.

A status report window displays the result of the download.

NOTE
If the ROM load failed for some devices, load them individually by clicking on one device, perform
steps 6 through 11 for it, and repeat the process for each remaining device.

12 Click on the Ok button to close the status report window.

13 Click on the Util menu.

14 Select the Tools menu item.

15 Click on the Update NextLoad>CDMA menu item.

16 Select the version number of the folder that was used for the ROM code download.

17 Click on the Save button.

A pop-up message indicates that the CDF file has been updated.

18 Click on the OK button to dismiss the pop-up message.

19 Click on the device that was downloaded with ROM code.

20 Click on the Device menu.

21 Click on the Download Code menu item to download RAM code.

A status report window displays the result of the download.

NOTE
Data is automatically downloaded to GLI devices when the RAM code is downloaded. Use the
Download Data procedure to download data to other device types after they have been upgraded.

22 Click on the Ok button to close the status report window.

The downloaded device should be OOS_RAM (yellow) unless it is a GLI in which case it should be
INS (green).

. . . continued on next page
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Table H-1: Download ROM Code

Step Action

23 Click on the device that was downloaded.

24 Click on the Device menu.

25 Click on the Status menu item.

Verify that the status report window displays the correct ROM and RAM version numbers.

26 Click on the Ok button to close the status report window.
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Introduction

Purpose

This procedure is a guide to expanding your system with multiple
carriers while the system remains in service. This procedure also allows
you to perform on site maintenance (replace defective boards and
recalibrate) while the remainder of the site stays in service.

Motorola recommends that you perform this procedure during a
maintenance window.

This procedure cannot be performed on BTSs with 4-to-1 combiners.
The procedure can only be performed on one side of the BTS at one
time. That is, LPAs 1, 2 ,3, 7, 8, 9 (feed antennas 1, 2, 3) can be
calibrated while LPAs 6, 7, 8, 10, 11, 12 (feed antennas 4, 5, 6) remain
in service and vice versa.

Equipment Warm up

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment  after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

CAUTION If any piece of test equipment (i.e., test cable, RF adapter) has
been replaced, re-calibration must be performed. Failure to do so
could introduce measurement errors, causing incorrect
measurements and degradation to system performance.
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Power Delta Calibration

Power Delta Calibration Introduction
The In-service calibration procedure has several differences from a
normal calibration procedure. One of these is the use of a spectrum
analyzer instead of a power meter to measure power. Power meters are
broadband measurement devices and cannot be used to measure power
during In-service Calibration since other carriers are operating. A
spectrum analyzer can be used because it measures power at a given
frequency. However, measuring power using a spectrum analyzer is less
accurate than using a power meter. Therefore, you must compensate for
the difference (delta) between the power meter and the spectrum
analyzer.

HP8921A Power Delta Calibration
Use the HP8921A Spectrum Analyzer to measure power during
In-Service Calibration for 800 MHz systems. After the offset value has
been calculated, add it to the TX cable loss value.

Follow the procedure in Table I-1 to perform the HP8921A Power Delta
Calibration procedure.

NOTE This procedure requires two HP8921As.

Table I-1: HP8921A Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8921A Duplex Out port and the HP437B power sensor (see
Figure I-1).

2 Set the HP8921A signal source as follows:

- Measure mode to CDMA Generator
- Frequency to the CDMA Calibration target frequency

- CW RF Path to IQ

- Output Port to Dupl

- Data Source to Random

- Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

5 Turn off the source HP8921A signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8921A for convenience in the following steps.

6 Connect the short RF cable between the source HP8921A Duplex Out port and the measuring
HP8921A RF-IN  port (see Figure I-2).

. . . continued on next page
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Table I-1: HP8921A Power Delta Calibration Procedure

Step Action

7 Ensure that the source HP8921A settings are the same as in Step 2.

8 Set the measuring HP8921A as follows:

- Measure mode to CDMA Anl
- Frequency to the CDMA calibration target frequency

- Input Attenuation to 0 dB

- Input port to RF-IN

- Gain to Auto

- Analyzer Direction to Fwd

9 Turn on the source HP8921A signal output.

10 Measure and record the channel power reading on the measuring HP8921A as result
B ________________________.

11 Turn off the source HP8921A signal output and disconnect the equipment.

12 Compute the delta between HP437B and HP8921A using the following formula:

Delta = A - B
Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see Step 4 in
Table I-5).

 

Figure I-1: Delta Calibration Setup - HP8921A to HP437B
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Figure I-2: Delta Calibration Setup - HP8921A to HP8921A
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Advantest R3465 Power Delta Calibration

Follow the procedure in Table I-2 to perform the Advantest R3465
Power Delta Calibration procedure.

Table I-2: Advantest Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

On the Advantest R3465:

1 Press the SHIFT and the PRESET keys located below the CRT display.

2 Press the ADVANCE key in the Measurement area of the control panel.

3 Press the CDMA Sig CRT menu key.

4 Press the FREQ key in the Entry area of the control panel.

5 Set the frequency to the desired value using the keypad entry keys.

6 Press the LEVEL key in the Entry area of the control panel.

7 Set the LEVEL to 0 dBm using the keypad entry keys.

8 Verify the Mod CRT menu key is highlighting OFF, if not press the Mod key to toggle it OFF.

9 Verify the Output CRT menu key is highlighting OFF. If not, press the Output key to toggle it OFF.

On the HP 437 Power Meter:

10 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

11 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the power sensor
(see Figure I-3).

12 Press the Output CRT menu key to toggle the Output to ON.

. . . continued on next page
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Table I-2: Advantest Power Delta Calibration Procedure

Step Action

13 Record the Power Meter reading as result A ________________________.

14 Press the Output CRT menu key to toggle the Output to OFF.

15 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the Spectrum
Analyzer INPUT Port (see Figure I-4).

16 Press the Output CRT menu key to change the Output to ON.

17 Press the CW key in the Measurement area of the control panel.

18 Press the LEVEL key in the Entry area of the control panel.

19 Set the REF LEVEL to 10 dBm using the keypad entry keys.

20 Press the dB/div CRT menu key.

21 Press the 10 dB/div CRT menu key.

22 Press the FREQ key in Entry area of the control panel.

23 Set the frequency to the desired value using the keypad entry keys.

24 Press the more 1/2 CRT menu key.

25 Press the Preselector CRT menu key to highlight 3.0G.

26 Press the FORMAT key in the Display Control area of the control panel.

27 Press the TRACE CRT menu key.

28 Press the AVG A CRT menu key.

29 Set AVG to 20 using keypad entry keys.

30 Press the return CRT menu key.

31 Press the SPAN key in the Entry area of the control panel.

32 Press the Zero Span CRT menu key.

33 Press the BW key in the Entry area of the control panel.

34 Press the RBW CRT menu key to highlight MNL.

35 Set RBW to 30 kHz using keypad entry keys.

36 Press the VBW CRT menu key to highlight MNL.

37 Set VBW to 1 MHz using keypad entry keys.

38 Press the Marker ON key in the Display Control area of the control panel.

39 Record the Marker Level reading as result B ________________________.

. . . continued on next page
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Table I-2: Advantest Power Delta Calibration Procedure

Step Action

40 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see Step 4 in
Table I-5).

 

Figure I-3: Delta Calibration Setup - R3561L to HP437B
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Figure I-4: Delta Calibration Setup - R3561L to R3465
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HP8935 Power Delta Calibration

Follow the procedure in Table I-3 to perform the HP8935 Power Delta
Calibration procedure.

Table I-3: HP8935 Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8935 Duplex Out port and the HP437B power sensor (see
Figure I-5).

2 Set the HP8935 signal source as follows:

- Measure mode to CDMA Gen
- Frequency to the CDMA Calibration target frequency

- CW RF Path to IQ

- Output Port to Dupl

- Data Source to Random

- Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

5 Turn off the source HP8935 signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8935 for convenience in the following steps.

6 Connect the short RF cable between the source HP8935 Duplex Out port and the RF-IN/OUT  port
(see Figure I-6).

7 Ensure that the source HP8935 settings are the same as in Step 2.

8 Set the measuring HP8935 as follows:

- Measure mode to CDMA Anl
- Frequency to the CDMA calibration target frequency

- Input Attenuation to 0 dB

- Input port to RF-IN

- Gain to Auto

- Anl Dir to Fwd

9 Turn on the source HP8935 signal output.

10 Set the Chn Pwr Cal to Calibrate and select to calibrate.

11 Measure and record the channel power reading on the measuring HP8935 as result
B ________________________.

12 Turn off the source HP8935 signal output and disconnect the equipment.

. . . continued on next page
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Table I-3: HP8935 Power Delta Calibration Procedure

Step Action

13 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see Step 4 in
Table I-5).

 

Figure I-5: Delta Calibration Setup - HP8935 to HP437B
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Figure I-6: Delta Calibration Setup - HP8935 to HP8935
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Agilent E4406A Power Delta Calibration

The Agilent E4406A transmitter tester and E4432B signal generator test
equipment combination can be used for ISC of IS-2000 CDMA 1X as
well as IS-95A/B operation modes. The power delta calibration is
performed on the E4406A, but the E4432B is required to generate the
reference signal used to calculate the power delta offset. After the offset
value has been calculated, add it to the TX cable loss value in the LMF.

Follow the procedure in Table I-4 to perform the Agilent E4406A Power
Delta Calibration procedure.

Table I-4: Agilent E4406A Power Delta Calibration Procedure

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of the Optimization/Calibration chapter in the SC 4812T
Optimization/ATP manual.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

NOTE
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

2 Connect a short RF cable from the E4432B RF OUTPUT connector the HP437 power meter power
sensor (see Figure I-7).

3 Set the E4432B signal generator as follows:

- Press Preset to exit any modes for which the signal generator is configured.

- Press Frequency and enter the frequency of the channel to be calibrated using the numeric
keypad.

- Using the soft keys to the right of the screen, select the frequency range to be measured (for
example, MHz).

- Press Amplitude and, using the numeric keypad, set signal amplitude to 0 (zero).

- Using the soft keys, set the measurement type to dBm.

4 On the E4432B, press RF On/Off to toggle the RF output to RF ON.

- Note that the RF On/Off status in the screen display changes.

5 Measure and record the value reading on the HP437 power meter as result A____________________.

6 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

- Note that the RF On/Off status in the screen display changes.

7 Disconnect the short RF cable from the HP437 power meter power sensor, and connect it to the
RF INPUT connector on the E4406A transmitter tester (see Figure I-8).

. . . continued on next pageI
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Table I-4: Agilent E4406A Power Delta Calibration Procedure

Step Action

NOTE
Do not change the frequency and amplitude settings on the E4432B when performing the following
steps.

8 Set the E4406A as follows:

- Press Preset to exit any modes for which the transmitter tester is configured.

- Press MODE and, using the soft keys to the right of the screen, select cdmaOne.

- Press MEASURE and, using the soft keys, select spectrum.

- Press Frequency and, using the soft keys, select Center Frequency.

- Using the numeric keypad. enter the frequency of the channel to be calibrated.

- Using the soft keys, select the frequency range to be measured (for example, MHz).

- Press Input/Output and, using the soft keys, select Input Atten.

- Using the numeric keypad, set Input Atten to 0 (zero) and, using the soft keys, select dB.

- Using the soft keys, select External Atten and then select Mobile.

- Using the numeric keypad, set Mobile to 0 (zero) and, using the soft keys, select dB.

- Using the soft keys, select Base.

- Using the numeric keypad, set Base to 0 (zero) and, using the soft keys, select dB.

- Press MEASURE and, using the soft keys, select Channel Power.

9 On the E4432B signal generator, press RF On/Off to toggle the RF output to RF ON.

- Note that the RF On/Off status in the screen display changes.

10 Read the measured Channel Power from the E4406A screen display and record it as 
result B____________________.

11 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

- Note that the RF On/Off status in the screen display changes.

12 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Agilent measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration (see step 4 in
Table I-5).
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Figure I-7: Delta Calibration Setup - Agilent E4432B to HP437
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Figure I-8: Delta Calibration Setup - Agilent E4432B to Agilent E4406A
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In-Service  Calibration
CAUTION This feature does NOT have fault tolerance at this time. The

system has no safe-guards to stop you from doing something
that will take the BTS out of service. If possible, perform this
procedure during a maintenance window.

Follow the procedures in this section precisely, otherwise the
entire BTS will most likely go OUT OF SERVICE.

At the CBSC, only perform operations on expansion hardware
when it is in the OOS_MANUAL state.

The operator must be trained in the LMF operation prior to
performing this procedure.

Prerequisites
� Expansion hardware has been added in the CBSC database, and the

CDF file has been generated.

� The expansion devices have been inserted into the C-CCP cage and
are in the OOS_MANUAL state at the CBSC.

� The site specific cdf (with the expansion hardware) and cal files have
been loaded onto the LMF.

� The LMF has the same code and dds files as the CBSC to download.

CAUTION Do not download code or data to any cards other than those you
are working on. Downloading code or data to other cards will
take the site OUT OF SERVICE.

The code file version numbers must match the version numbers
on the other cards in the frame. If the numbers do not match, the
site may go OUT OF SERVICE.

The BTS-#.cdf, CBSC-#.cdf, and CAL files for this BTS must
have come from the CBSC.

� Test equipment has been configured per Figure I-9 and Figure I-10.

� An RFDS (or at a minimum a directional coupler), whose loss is
already known, must be in line to perform the in-service calibration.

� Test equipment has been calibrated after 1 hour warm up.

� A short RF cable and two BNC-N adapters are available to perform
Cable Calibration.

� The Power Delta Calibration has been performed (see Table I-1,
Table I-2, or Table I-3).
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Figure I-9: Optimization/ATP Test Setup Using RFDS

TX
TEST

CABLE
ÁÁÁÁÁÁÁÁ
ÁÁ
ÁÁÁÁÁÁ
ÁÁÁ

Hewlett-Packard Model HP 8935

DUPLEX OUT

TEST SETS Optimization/ATP SET UP

RF IN/OUT

HP-IB
TO GPIB
BOX

RX ANTENNA
PORT

TX ANTENNA
PORT

RS232-GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

RX
TEST
CABLE

COMMUNICATIONS
TEST SET

IEEE 488
GPIB BUS

IN

TEST SET
INPUT/

OUTPUT
PORTS

OUT

NOTE:  IF BTS RX/TX SIGNALS ARE
DUPLEXED: BOTH THE TX AND RX TEST
CABLES CONNECT TO THE DUPLEXED
ANTENNA GROUP.

ANTENNA

RFDS
DUPLEXER

DIRECTIONAL
COUPLER

EVEN
SECOND/
SYNC IN

EXT
REF

 IN

FREQ
MONITOR

SYNC
MONITOR

CSM

REF FW00759

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

RX
TEST

CABLE

FWD
COUPLED
PORT

20 DB PAD
(FOR 1.7/1.9 GHZ)
10 DB PAD
(FOR 800 MHZ)

20 DB PAD
(FOR 1.7/1.9 GHZ)
10 DB PAD
(FOR 800 MHZ)

I



In-Service  Calibration68P09255A61-4

Aug 2002 1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
I-15

Figure I-10: IS-95 A/B/C Optimization/ATP Test Setup Using RFDS
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Follow the procedure in Table I-5 to perform the In-Service Calibration.

Table I-5: In-Service Calibration

Step Action

NOTE
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

1 Set up the LMF for In-Service Calibration:

- Start the LMF by double-clicking the LMF icon on the Windows desktop.

- Click Tools>Options from the menu bar at the login screen.

- Check the applicable spectrum analyzer check box and the signal generator check box on the Test
Equipment tab.
Ensure that the GPIB address is 18 for the CDMA analyzer and 1 for the signal generator.

- Uncheck any other other equipment that is selected.

- Click the Apply button.

- Select the BTS Options tab in the LMF Option window.

- Check the In-Service Calibration check box.

- Click the Apply button.

- Click the Dismiss button to close the LMF Option window.

2 Login to the target BTS:

- Select the target BTS icon.

- Click the Login button at the login screen.

3 Measure the Cable Loss using the Cable Calibration function:

- Click Util>Cable Calibration from the menu bar at the main window.

- Set the desired channel(s) and select TX and RX CABLE CAL at the cable calibration pop up
window.

- Click the OK button to perform cable calibration.

- Follow the on-screen instructions to complete the cable loss measurement.

NOTE
- The measured value is input automatically to the cable loss file.

- To view the cable loss file, click Util>Examine>Cable Loss>TX or RX.

4 Add the spectrum analyzer power delta to the Cable Loss.

- To view the cable loss file, click Util>Examine>Cable Loss>TX or RX.

- Add the value computed in Table I-1, Table I-2, or Table I-3 to the TX Cable Loss.

NOTE
Be sure to include the sign of the value. The following examples are included to show the mathematics
and do not represent actual readings:

- Example: 5.65 dBm + 0.55 dBm = 6.20 dBm

- Example: 5.65 dBm + (-0.29 dBm) = 5.36 dBm

- Example: -5.65 dBm + 0.55 dBm = -5.10 dBm

- Example: -5.65 dBm + (-0.29 dBm) = -5.94 dBm

. . . continued on next page
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Table I-5: In-Service Calibration

Step Action

5 Input the Coupler Loss for the TX and RX tests:

- Click Util>Edit>Coupler Loss>TX or RX from the menu bar at the main window.

- Input the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

- Click the Save button.

- Click the Dismiss button to close the window.

- To view the coupler loss file, click Util>Examine>Coupler Loss>TX or RX.

6 Have the CBSC operator put the redundant BBX OOS_MANUAL.

! CAUTION
Be sure to download OOS devices only. Loading in-service devices takes them OUT OF SERVICE
and can result in dropped calls.

The code file version numbers must match the version numbers on the other cards in the frame. If the
numbers do not match, the site may go OUT OF SERVICE.

NOTE
Be sure to include the redundant BBX in steps 7, 8, and 9.

7 Download code and data to the target devices:

- Click Tools>Update NextLoad>CDMA to set the code version that will be downloaded.

- Select the BTS(s) you need, check the appropriate code version in the pop up window, and click
the Save button to close.

- Select the target BBX(s) on the C-CCP cage picture.

- Click Device>Download>Code/Data to start downloading code.

- Select the target BBX(s) on the C-CCP cage picture.

- Click Device>Download>Data to start downloading data.

. . . continued on next page
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Table I-5: In-Service Calibration

Step Action

! CAUTION
Perform the In-service Calibration procedure on OOS devices only.

8 Select the desired test:

- Select the target BBX(s) on the C-CCP cage picture.

- Click Tests>[desired test] from the menu bar at the main window.

- Select the target carrier and confirm the channel number in the pop up window.

- Leave the Verify BLO check box checked.

- From the Test Pattern pick list, select a test pattern.

- Click the OK button to start calibration.

- Follow the on-screen instructions, except, do not connect to the BTS antenna port, connect to the
directional coupler (fwd) port associated with the on screen prompt antenna port.

NOTE
� Selecting Pilot (default) performs tests using a pilot signal only.

� Selecting Standard performs tests using pilot, synch, paging and six traffic channels. This requires
an MCC to be selected.

� Selecting CDFPilot performs tests using a pilot signal, however, the gain for the channel elements
is specified in the CDF file.

� Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the gain
for the channel elements is specified in the CDF file.

9 Save the result and download the BLO data to the target BBX(s):

- Click the Save Result button on the result screen.
The window closes automatically.

10 Logout from the BTS and close the LMF session:

- Click BTS>Logout to close the BTS connection.

- Close the LMF window.

11 Restore the new “bts-*.cal” file to the CBSC.

12 Enable the target device(s) from the CBSC.
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GPIB Addresses

Introduction

Use the procedures in this appendix to verify and/or change the GPIB
addresses of the applicable test equipment.

HP437 Power Meter GPIB Address

Follow the steps in Table J-1 to verify and, if necessary, change the
HP437 GPIB address.

NOTE
This procedure assumes that the test equipment is set up and
ready for testing.

Table J-1: Verify and/or Change HP437 Power Meter GPIB Address

Step Action

1 Press Shift and PRESET (see Figure J-1).

2 Use the 	 arrow  key to navigate to HP-IB ADRS and press ENTER.

The HP-IB address is displayed.

NOTE
HP-IB is the same as GPIB.

3 If the current GPIB address is not set to 13, perform the following to change it:

- Use the 	 � arrow keys to change the HP-IB ADRS to 13.

- Press ENTER to set the address.

4 Press Shift and ENTER to return to a standard configuration.

 

Figure J-1: HP437 Power Meter

ENTER

PRESETSHIFT (BLUE) PUSHBUTTON -
ACCESSES FUNCTION AND
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WITH LIGHT BLUE TEXT ON
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Gigatronics 8541C Power Meter GPIB Address

Follow the steps in Table J-2 to verify and, if necessary, change the
Gigatronics 8541C power meter GPIB address.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table J-2: Verify and/or Change Gigatronics 8541C Power Meter GPIB Address

Step Action

! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

1 Press MENU (see Figure J-2).

2 Use the � arrow key to select CONFIG MENU and press ENTER.

3 Use the � arrow key to select GPIB and press ENTER.

The current Mode and GPIB Address are displayed.

4 If the Mode is not set to 8541C, perform the following to change it:

Use the 
 � arrow keys as required to select MODE.

Use the �	 arrow keys as required to set MODE to 8541C.

5 If the GPIB address is not set to 13, perform the following to change it:

Use the � arrow key to select ADDRESS.

Use the �	 arrow keys as required to set the GPIB address to 13.

6 Press ENTER to return to normal operation.

Figure J-2: Gigatronics 8541C Power Meter Detail

MENU ENTER ARROW
KEYS

REF FW00564

1
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Motorola CyberTest GPIB Address

Follow the steps in Table J-3 to verify and, if necessary, change the
GPIB address on the Motorola CyberTest. Changing the GPIB address
requires the following items:

� Motorola CyberTest communications analyzer

� Computer running Windows 98SE or Windows 2000

� Motorola CyberTAME software program “TAME”

� Parallel printer port cable (shipped with CyberTest)

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table J-3: Verify and/or Change Motorola CyberTest GPIB Address

Step Action

1 On the LMF desktop, locate the CyberTAME icon. Double click on the icon to run the CyberTAME
application.

2 In the CyberTAME window taskbar, under Special, select IEEE.488.2.

3 CyberTAME software will query the CyberTest Analyzer for its current GPIB address. It then will
open the IEEE 488.2 dialog box. If the current GPIB address is not 18, perform the following
procedure to change it:

- Use the up or down increment arrows, or double-click in the field and type the number.

- Click on the OK button.
The new address will be written to the CyberTest via the parallel port and saved.

NOTE
Verify that the address has been set by repeating steps 2 and 3. The new address should now appear in
the IEEE 488.2 dialog box Address field.
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HP8935 Test Set GPIB Address

Follow the procedure in Table J-4 to verify and, if necessary, change the
HP8935 GPIB address.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table J-4: Verify and/or Change HP8935 GPIB Address

Step Action

* IMPORTANT
The HP I/O configuration MUST be set to Talk & Listen, or NO device on the GPIB bus will be
accessible. (Consult test equipment OEM documentation for additional information as required.)

1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP8935 (see
Figure J-3). The current HP-IB address is displayed at the top of the screen.

NOTE
HP-IB is the same as GPIB.

2 If the current GPIB address is not set to 18, perform the following to change it:

- Press Shift and Inst Config.

- Turn the Cursor Control knob to move the cursor to the HP-IB Adrs field.

- Press the Cursor Control knob to select the field.

- Turn the Cursor Control knob as required to change the address to 18.

- Press the Cursor Control knob to set the address.

3 � Press Preset to return to normal operation.

Figure J-3: HP8935 Test Set
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Preset

Cursor ControlShift

Inst Config

Local

J



GPIB Addresses 68P09255A61-4

Aug 20021X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x
FIELD TRIAL

J-6

Setting HP8921A and HP83236A/B GPIB Address

Follow the procedure in Table J-5 to verify and, if necessary, change the
HP8921A HP83236A GPIB addresses.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table J-5: Verify and/or Change HP8921A and HP83236A GPIB Addresses

Step Action

1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP8921A (see
Figure J-4). The current HP-IB address is displayed at the top of the screen.

NOTE
HP-IB is the same as GPIB.

2 If the current HP-IB address is not set to 18, perform the following to change it:

- Turn the Cursor Control knob to move the cursor to More and press the knob to select the field.

- Turn the Cursor Control knob to move the cursor to I/O Config and press the knob to select the
field.

- Turn the Cursor Control knob to move the cursor to Adrs and press the knob to select the field.

- Turn the Cursor Control knob to change the HP-IB address to 18 and press the knob to set the
address.

- Press Shift and Preset to return to normal operation.

3 To set the HP83236A (or B) PCS Interface GPIB address=19, set the dip switches as follows:

- A1=1, A2=1, A3=0, A4=0, A5=1, HP-IB/Ser = 1
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Figure J-4: HP8921A and HP83236A/B
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Advantest R3465 GPIB Address

Table J-6 describes the steps to verify and, if necessary, change the GPIB
address for the Advantest R3465.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table J-6: Verify and/or Change Advantest R3465 GPIB Address

Step Action

1 To verify that the GPIB address is set correctly, perform the following procedure:

- Press SHIFT then PRESET (see Figure J-5).

- Press LCL.

- Press the GPIB and Others CRT menu key to view the current address.

2 If the current GPIB address is not set to 18, perform the following to change it:

- Turn the vernier knob as required to select 18.

- Press the vernier knob to set the address.

3 To return to normal operation, press Shift and Preset.

Figure J-5: R3465 Communications Test Set
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RS232 GPIB Interface Box

Ensure that the RS232 GPIB interface box dip switches are set as shown
in Figure J-6.

Figure J-6: RS232 GPIB Interface Box
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CDMA 2000 Test Equipment Preparation

Advantest R3267 Spectrum Analyzer GPIB Address

Perform the procedure in Table J-7 and refer to Figure J-7 to verify and,
if necessary, change the Advantest R3267 spectrum analyzer GPIB
address.

Table J-7: Verify and Change Advantest R3267 GPIB Address

Step Action

1 If the REMOTE LED is lighted, press the LCL key.

- The LED extinguishes.

2 Press the CONFIG key.

- The CONFIG softkey labels will appear in the softkey label display area of the instrument
display.

- The current GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 18, perform the following to change it:

3a - Press the GPIB Address softkey.
-- A GPIB Address entry window will open in the instrument display showing the current

GPIB address.

3b - Enter 18 on the keypad in the ENTRY section of the instrument front panel.
-- Characters typed on the keypad will replace the address displayed in the GPIB Address

entry window.

NOTE
To correct an entry, press the BS (backspace) key at the lower right of the keypad to delete one
character at a time.

3c - Press the ENTER key to the lower right of the keypad to enter the address.
-- The GPIB Address entry window closes.
-- The new address is displayed in the bottom portion of the GPIB Address softkey label.
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Figure J-7: Setting Advantest R3267 GPIB Address
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Advantest R3562 Signal Generator GPIB Address

Set the GP-IB ADDRESS switch on the rear of the Advantest R3562
signal generator to address 1 as shown in Figure J-8.

Figure J-8: Advantest R3562 GPIB Address Switch Setting

1 2 3 4 5 6 7 8

5 4 3 2 1

GP-IP  ADDRESS

1

0

GPIB Address set to “1”
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Agilent E4406A Transmitter Tester GPIB Address

 Follow the procedure in Table J-8 and refer to Figure J-9 to verify and,
if necessary, change the Agilent E4406A GPIB address.

Table J-8: Verify and Change Agilent E4406A GPIB Address

Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.

- The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Config I/O softkey button to the right of the instrument screen.

- The softkey labels will change.

- The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 18, perform the following to change it:

3a - Press the GPIB Address softkey button.
-- In the on-screen Active Function Area, GPIB Address will be displayed followed by the

current GPIB address.

3b - On the front panel Data Entry keypad, enter the communications system analyzer GPIB address of
18.

-- The GPIB Address label will change to Enter.
-- Digits entered with the keypad will replace the current GPIB address in the display.

NOTE
To correct an entry, press the Bk Sp key at the upper right of the keypad to delete one character at a
time.

3c - Press the Enter softkey button or the keypad Enter key to set the new GPIB address.
-- The Config I/O softkey labels will reappear.
-- The new GPIB address will be displayed under the GPIB Address softkey label.
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Figure J-9: Setting Agilent E4406A GPIB Address
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Agilent E4432B Signal Generator GPIB Address

Follow the procedure in Table J-9 and refer to Figure J-10 to verify and,
if necessary, change the Agilent E4432B GPIB address.

Table J-9: Verify and Change Agilent E4432B GPIB Address

Step Action

1 In the MENUS section of the instrument front panel, press the Utility key.

- The softkey labels displayed on the right side of the instrument screen will change.

2 Press the GPIB/RS232 softkey button to the right of the instrument screen.

- The softkey labels will change.

- The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 1, perform the following to change it:

3a - Press the GPIB Address softkey button.
-- The GPIB Address label and current GPIB address will change to boldface.
-- In the on-screen Active Entry Area, Address: will be displayed followed by the current

GPIB address.

. . . continued on next page
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Table J-9: Verify and Change Agilent E4432B GPIB Address

Step Action

3b - On the front panel Numeric keypad, enter the signal generator GPIB address of 1.
-- The GPIB Address label will change to Enter.
-- Digits entered with the keypad will replace the current GPIB address in the Active Entry

display.

NOTE
To correct an entry, press the backspace key at the lower right of the keypad to delete one character at
a time.

3c - Press the Entr softkey button to set the new GPIB address.
-- The new GPIB address will be displayed under the GPIB Address softkey label.

 

Figure J-10: Setting Agilent E4432B GPIB Address
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Numbers
10BaseT/10Base2 Converter, 1-10

LMF to BTS connection, 3-5

1700 MHz Center Frequencies, Calculating, E-7

1700 MHz PCS Channels, E-6

1900 MHz Center Frequencies, Calculating, E-2

1900 MHz PCS Channels, E-1

2-way Splitter, 1-13

3C-PC-COMBO CBL, 1-10

800 MHz CDMA Channels, E-4

800 MHz Center Frequencies, Calculating, E-4

A
Abbreviations and Acronyms, 1-6

ACTIVE LED
GLI2, 6-22
MCC, 6-26

Advantest R3465, 3-43
Calibrating Test Cable, F-8
GPIB, J-7

Agilent E4406A, calibration, 3-61

Alarm Connector Location/Pin Numbering SC
4850/4850E, 3-100

ALARM LED, GLI2, 6-22

Alarm Monitor window, 3-99

alarm redundancy tests, BBX2, 3-93

Alarm Reporting Display, 3-99

Alarm tests, redundancy, 3-88

Alarm/Redundancy Tests, Distribution Shelf, 3-91

All Cal/Audit Test, 3-77, 3-78

All RX, 4-2

All TX, 4-2

All TX/RX, 4-2

AMR, No control, 6-16

AMR CDI Alarm Input Verification, test data sheets,
A-17

Ancillary Equipment Frame identification, 1-15

Ancillary frame, when to optimize, C-1

Antenna Map, 3-84

ATP, 4-1
Code Domain Power, 4-11
Frame Error Rate (FER), 4-13
generate report, 4-14
Pilot Time Offset, 4-10
Report, 4-14
Spectral Purity Transmit Mask, 4-7
test matrix/detailed optimization, C-2
Test Prerequisites, 4-3
Test Procedure, 4-4
testing options, 4-4
Waveform Quality (rho), 4-9

Automated Acceptance Test Procedure, 4-1

B
Backplane DIP switch settings, 2-3

Bay Level Offset calibration failure, 6-6

BBX2
alarm redundancy tests, 3-93
Connector, 6-14
gain set point vs BTS output considerations, D-1
No control in the shelf, 6-16

BLO
Calibration, 3-68
Calibration Audit, 3-76
calibration data file, 3-69
Calibration Failure, 6-6
Download, 3-75

BTS
Ethernet LAN interconnect diagram, 3-13
LMF connection, 3-5
system software download, 3-3
test data sheets, redundancy/alarm tests, A-16
when to optimize, C-1

BTS frame
DC Distribution Pre-test, 2-9
DC Power Pre-test, 2-7
initial power-up, 2-14

Create CAL File, 3-79

C
C-CCP Backplane, Troubleshooting, 6-13, 6-14
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C-CCP Shelf, 1-21
Site Serial Number Check List, A-18

Cable
GPIB, 1-11
LAN Cable, 1-12
Calibrating, 3-47, 3-62
Null Modem, 3-33
Setting Loss Values, 3-66
Timimg Reference, 1-11

Cable Calibration
HP8921 with HP PCS Interface (HP83236), F-3
Manual, F-3

CAL File, 3-79

Calculating Center Frequencies
1700 MHz, E-7
1900 MHz, E-2
800 MHz, E-4

Calibrating
Cables, 3-62

RX, 3-64
TX, 3-63

Test Equipment, 3-60

Calibrating Test Cable, Advantest R3465, F-8

Calibration
BLO, 3-68
Cable, 1-8
data file, BLO, 3-69
In-Service, I-15
RF Path, Test Equipment Setup, 3-72
RFDS, 3-86
Test Equipment, 1-8
TX Path, 3-69, 3-72

Test Cable Calibration, 1-8

Test Equipment Calibration, 1-8

Calibration Audit Failure, Troubleshooting, 6-7

Cannot communicate to Communications Analyzer,
6-3

Cannot communicate to Power Meter, 6-2

Cannot download CODE to any device card, 6-4

Cannot Download DATA to any device card, 6-4

Cannot ENABLE device, 6-5

Cannot load BLO, 6-7

Cannot Log into cell-site, 6-2

Cannot perform carrier measurement, 6-9

Cannot perform Code Domain Noise Power
measurement, 6-9

Cannot perform Rho or pilot time offset
measurement, 6-8

Cannot perform Txmask measurement, 6-8

Carrier Measurement Failure, Troubleshooting, 6-9

CDF
site configuration, 3-2
site equipage verification, 3-3
site type and equipage data information, 2-1

CDF Files, Copy from CBSC, 3-8

CDI Alarm
with Alarms Test Box, 3-101
without Alarms Test Box, 3-103

CDMA LMF, Product Description, 1-3

Cell Site
equipage verification, 2-1
preliminary operations, 2-1
types, 3-2

Cell Site Data File. See CDF

Channel elements, No or missing, 6-17

Channels
1700 MHz, E-6
1900 MHz, E-1
800 MHz, E-4

Checksum Failure, 6-11

CIO, Connectors, 6-14

CLI, 1-3, 3-17
Command Line Interface, 3-16
Format Conventions, 3-17
Logging Out, 3-22

Cobra RFDS
external housing, 1-35
RF connector panel detail, 1-35

Code Domain Power, 4-6
ATP, 4-11

Code Domain Power and Noise Floor Measurement
Failure, Troubleshooting, 6-9

Code Domain Power Test, 4-11

Code Download Failure, Troubleshooting, 6-4

Command Line Interface, 1-3, 3-17

Common power supply verification, 2-13

Communications Analyzer Communication Failure,
Troubleshooting, 6-3



Index 68P09255A61-4

1X SC� 4812T BTS Optimization/ATP Software Release 2.16.1.x

FIELD TRIAL
Aug 2002Index-4

Communications System Analyzer, 1-11
Advantest, 1-11
HP8921A/600, 1-11
CyberTest, 1-11

Connector Functionality, Backplane,
Troubleshooting, 6-13

Copy CAL files from CDMA LMF to the CBSC, 5-7

Copy CAL Files From Diskette to the CBSC, 5-8

Copy CDF Files from CBSC, 3-8

Copy Files to a Diskette, 5-7

Copy CAL files to the CBSC, 5-8

Coupler, Setting Loss Value, 3-67

CSM
Clock Source, 3-27
Enable, 3-28
frequency verification, 3-33
functions, 3-31
LEDs, 3-32
MMI terminal connection, illustration, 3-34
redundancy/alarm tests, 3-94
Reference Source Configuration Error, 6-11
Troubleshooting, 6-11, 6-12

CyberTest, 3-43

D
Data Download Failure, Troubleshooting, 6-4

DC Power Pre-test
+27 V BTS frame detail, 2-7
-48 V BTS frame detail, 2-9
BTS Frame, 2-5
RFDS, 2-11
RFDS detail, 2-11

DC Power Problems, 6-18

DC/DC Converter, LED Status Combinations, 6-20

Device Enable (INS) Failure, Troubleshooting, 6-5

Digital Control Problems, C-CCP Backplane
Troubleshooting, 6-15

Digital Multimeter, 1-11

Directional Coupler, 1-12

Distribution shelf, alarm/redundancy tests, 3-91

Download
BLO, 3-75
BTS, 3-24
BTS system software, 3-3
MGLI, 3-25
Non-MGLI2 Devices, 3-26
ROM Code, H-1

E
E1, isolate BTS from the E1 spans, 3-4

E4406A, calibration, 3-61

Enable
CSMs, 3-28
MCCs, 3-30
Redundant GLIs, 3-30

Enabling Devices, 5-2

Equipment setup, VSWR, HP Test Set, G-2

Ethernet LAN
interconnect diagram, 3-13
Transceiver, 1-9

Ethernet maintenance connector interface, illustration,
3-6

F
FER test, 4-13

Folder Structure Overview, 3-12

Foreword, xvi

Frame Error Rate, 4-6
ATP, 4-13

FREQ Monitor Connector, CSM, 6-22

Frequency counter, optional test equipment, 1-12

Frequency Spectrum
Korean PCS (1700 MHz), E-6
North American Cellular Telephone System (800

MHz), E-4
North American PCS (1900 MHz), E-1

Full Optimization, 4-2

G
Gain set point, BBX, D-1

General Safety, xix

Generating an ATP Report, 4-14

General optimization checklist, test data sheets, A-4

Gigatronics 8542B power meter, illustration, J-2
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Gigatronics Power Meter, 3-43

GLI. See Master (MGLI2) and Slave (SGLI2) Group
Line Interface

GLI2
Connector, 6-14
Ethernet Connections, 6-14
LED Status, 6-22
No Control through span line connection, 6-15
No Control via LMF, 6-15

GPIB
Advantest R3465, J-7
HP83236A/B, J-5
HP8921A, J-5
HP8935, J-4
power meter

Gigatronics 8542B, J-2
HP437B, J-1

set address, Motorola CyberTest, J-3

GPIB Cable, 1-11

GPS
Initialization/Verification, 3-35
receiver operation, test data sheets, A-5
redundancy alarm tests, 3-94
satellite system, 3-29
Test Equipment Setup, 3-33

GPS Bad RX Message Type, 6-11

Graphical User Interface, 1-3, 3-16

GUI, 1-3, 3-16
Graphical User Interface, 3-16
Logging Out, 3-21

H
LMF Hardware Requirements, 1-9

High Stability 10 MHz Rubidium Standard, 1-13

High Stability Oscillator, 3-32

High-impedance Conductive Wrist Strap, 1-12

HP 437B, 3-43

HP 83236 A, F-3

HP 83236A, F-2

HP 8921, 3-43

HP 8921A, System Connectivity Test, F-2

HP 8935, 3-43

HP PCS Interface Test Equipment Setup for Manual
Testing, F-7

HP Test Set, VSWR, G-2

HP83236A/B, GPIB, J-5

HP8921A, GPIB, J-5

HP8935, GPIB, J-4

HSO
Initialization/Verification, 3-41
redundancy/alarm tests, 3-94

HyperTerminal Connection, Creating, 3-10

I
I and Q values, B-1

In-Service Calibration, I-15

Initial Installation of Boards/Modules, preliminary
operations, 2-2

Initial power tests, test data sheets, A-3

Initial power-up
BTS frame, 2-14
RFDS, 2-14

Initialization/Verification
GPS, 3-35
HSO, 3-41
LFR, 3-39

Intended reader profile, 1-14

Inter-frame cabling, when to optimize, C-2

IS-97 specification, B-1

ISB connectors, 6-13

Isolation, T1/E1 Span, 3-4

Itasca Alarms Test Box, 1-13

L
LAN

BTS frame interconnect, illustration, 3-13
Tester, 1-12

LAN Connectors, GLI2, 6-23

LED, CSM, 3-32
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LED Status, 6-20
BBX2, 6-26
CSM, 6-21
DC/DC Converter, 6-20
GLI2, 6-22
LPA, 6-27
MCC, 6-26

LFR
Initialization / Verification, 3-39
receiver operation, test data sheets, A-6
redundancy/alarm tests, 3-94

LFR/HSO, Test Equipment Setup, 3-33

Line Build Out parameters
configure, 5-5
verify, 5-4

LMF, 1-8, 3-7
Ethernet maintenance connector interface detail,

illustration, 3-6
Installation and Update Procedures, 3-8
Termination and Removal, 5-8
to BTS connection, 3-5

LMF Operation, 3-16

LMF Removal, 5-8

Loading Code, 3-24

Logging In to a BTS, 3-18

Logging Out, 3-21
CLI, 3-22
GUI, 3-21

Logical BTS, 1-15
Numbering, 1-16

Login
CLI, 3-20
GUI, 3-18

Login Failure, Troubleshooting, 6-2

Low Frequency Receiver, 3-32

LPA
redundancy test, 3-97
test data sheets

convergence, A-8
IM Reduction, A-7

LPA Module LED, 6-27

LPAs, Site Serial Number Check List, A-19

M
Manual

layout, 1-1
overview, 1-2

MASTER LED, GLI2, 6-22

MCC, Enable, 3-30

MGLI, redundancy test RFM frame, 3-98

MGLI2
board detail, MMI port connections, 5-5
Download, 3-25

Miscellaneous errors, Troubleshooting, 6-5

MMI Connection, 3-23

MMI Connector
CSM, 6-22
GLI2, 6-23
MCC, 6-26

MMI equipment setup, 3-23

 MMI Interface Kit, 1-10

Module status indicators, 6-20

Multi-FER test Failure, Troubleshooting, 6-10

N
NAM, Valid Ranges, 3-84

No DC input voltage to  Power Supply Module, 6-18

No DC voltage +5 +65 or +15 Volts to a specific
GLI2 BBX2 or Switch board, 6-19

No GPS Reference Source, 6-11

Non-MGLI2, Download, 3-26

Null Modem Cable, 3-33

O
Online Help, 1-3

Optimization
Process, 3-1
purpose, 1-4
When, 1-5

Optional Test Equipment, 1-12
frequency counter, 1-12

Oscilloscope, 1-13

P
PA Shelves, 1-22
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Patent Notification, xxii

path
RX, 1-4
TX, 1-5

PCMCIA, Ethernet adapter, LMF to BTS connection,
3-5

Pilot Gain, 4-9, 4-10, 4-11, 4-13

Pilot Offset Acceptance test, 4-10

Pilot Time Offset, 4-6, 4-10

Pin/Signal Information for ARM A Cable, 3-104

Ping, 3-13

PN Offset
programming information, B-1
usage, B-1

PnMask, I and PnMask Q Values, B-2

Power Conversion Shelf (-48 V BTS Only), Site
Serial Number Check List, A-19

Power Delta Calibration
Advantest, I-4
HP8921A, I-2
HP8935, I-7

Power Input, 6-13

Power Meter, 1-11
illustration, J-1

Power meter
GPIB

Gigatronics 8542B, J-2
HP437B, J-1

illustration, Gigatronics 8542B, J-2

Power Meter Communication Failure,
Troubleshooting, 6-2

Power supply, converter redundancy, 3-89

Power Supply Module Interface, 6-14

power supply/converter redundancy, 3-89

Pre-power tests, test data sheets, A-3

Preliminary operations
cell Site types, 2-1
test data sheets, A-2

Prepare to Leave the Site
external test equipment removal, 5-1
LMF Removal, 5-8
re-connect BTS IFM connector, 5-3
re-connect BTS T1 spans, 5-3
Reestablish OMC-R control, 5-9
Verify T1/E1, 5-9

Pushbuttons and Connectors, GLI2, 6-23

PWR/ALM LED
BBX2, 6-26
CSM, 6-21
DC/DC Converter, 6-20
generic, 6-20
MCC, 6-26

R
RDM, 6-13

Re-connect BTS IFM connector, 5-3

Re-connect BTS T1 Spans, 5-3

Reduced ATP, 4-2, 6-8

redundancy/alarm tests, 3-88

Redundant GLIs, Enable, 3-30

Reestablish OMC-R control, 5-9

Reference Distribution Module, 6-13

Required documents, 1-14

RESET Pushbutton, GLI2, 6-23

Resetting BTS modules, 5-2

Revision History, xxi

RF
Adapters, 1-12
Attenuators, 1-12
Load, 1-12

RF Path Calibration, 3-72

RFDS
Calibration, 3-86
DC Power Pre-test, 2-11
Description, 3-80
initial power-up, 2-14
Layout, 1-35
Parameter Settings, 3-81
Set Configuration Data, 3-85

rho, 4-6
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rho test, 4-9

ROM Code, Download, H-1

RS-232 to GPIB Interface, 1-10

RX, antenna VSWR, test data sheets, A-17

RX Acceptance Tests, Frame Error Rate, 4-6

RX path, 1-4

S
Sector Configuration, 1-30

Set Antenna Map Data, 3-84

Set Span Parameter Configuration, procedure, 5-5

Setting Cable Loss Values, 3-66

Setting TX Coupler Loss Value, 3-67

SGLI2, board detail, MMI port connections, 5-5

Shelf Configuration Switch, 2-3

Signal Generator, 3-63, 3-64

Site, equipage verification, 3-3

Site checklist, data sheets, A-2

Site equipage, CDF file, 3-2

Site I/O board, T1 span cable connection, 5-3

Site Serial Number Check List, A-18

Span Framing Format
configure, 5-5
verify, 5-4

Span I/O board
E1 span isolation, illustration, 3-5
T1 span isolation, illustration, 3-5

Span Line
connector , 6-13
T1/E1 Verification Equipment, 1-13

Span line, troubleshooting, 6-28

Span line configuration, troubleshooting, 6-30

Span line traffic, No or missing, 6-16

Span Parameter Configuration
set, procedure, 5-5
verification, procedure, 5-4

SPANS LED, GLI2, 6-23

Spectral Purity Transmit Mask ATP, 4-7

Spectral Purity TX Mask, 4-6

Spectrum Analyzer, 1-12, 3-63, 3-64

Spectrum Analyzer , HP8594E, 3-44

STATUS LED, GLI2, 6-23

SYNC Monitor Connector, CSM, 6-22

System Connectivity Test, HP8921A, F-2

T
T1

isolate BTS from the T1 spans, 3-4
span connection, 5-3

Test data sheets
AMR CDI Alarm Input Verification, A-17
BTS redundancy/alarm tests, A-16
general optimization checklist, A-4
GPS receiver operation, A-5
initial power tests, A-3
LFR receiver operation, A-6
LPA

convergence, A-8
IM Reduction, A-7

pre-power tests, A-3
preliminary operations, A-2
RX antenna VSWR, A-17
site checklist, A-2
TX antenna VSWR, A-16
TX BLO

Offset/Power Output Verification, A-9
Power Output Verification, A-14

Test Equipment
Automatically Selecting, 3-59
Calibrating, 3-60
Connecting test equipment to the BTS, 3-43
Manually Selecting, 3-58
Reference Chart, 3-45
Selecting, 3-57
verification data sheets, A-1
VSWR, G-1

Test Equipment Setup, 3-43
GPS & LFR/HSO, 3-33
HP PCS Interface, F-7
RF path  calibration, 3-72

Test Matrix, C-3
ATP optimization, C-2

Test Set, Calibration, 3-57

Timing Reference Cables, 1-11

Top Interconnect Plate, 1-21
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Troubleshooting
BBX2 Control Good - No (or Missing) Span Line

Traffic, 6-16
BLO Calibration Failure, 6-6
C-CCP Backplane, 6-13, 6-14
Calibration Audit Failure, 6-7
Code Domain Power and Noise Floor Measurement

Failure, 6-9
Code Download Failure, 6-4
Communications Analyzer Communication Failure,

6-3
CSM Checklist, 6-11
Data Download Failure, 6-4
DC Power Problems, 6-18
Device Enable (INS) Failure, 6-5
Login Failure, 6-2
MGLI2 Control Good - No Control over AMR,

6-16
MGLI2 Control Good - No Control over

Co-located GLI2, 6-15
Miscellaneous Failures, 6-5
Multi-FER Failure, 6-10
No BBX2 Control in the Shelf - No Control over

Co-located GLI2s, 6-16
No DC Input Voltage to any C-CCP Shelf Module,

6-19
No DC Input Voltage to Power Supply Module,

6-18
No GLI2 Control through Span Line Connection,

6-15
No GLI2 Control via LMF, 6-15
No MCC24 Channel Elements, 6-17
Power Meter Communication Failure, 6-2
Rho and Pilot Time Offset Measurement Failure,

6-8
Set span configuration, 6-30
span problems, 6-28
TX and RX Signal Routing, 6-19
TX Mask Measurement Failure, 6-8

TSU NAM
Parameters, 3-83
Program, 3-87

TX, antenna VSWR, test data sheets, A-16

TX & RX Path Calibration, 3-68

TX and RX Frequency vs Channel
1700 MHz, E-7
1900 MHz, E-2
800 MHz, E-4

TX and RX Signal Routing, C-CCP Backplane
Troubleshooting, 6-19

TX Audit Test, 3-76

TX BLO, test data sheets
Offset/Power Output Verification, A-9
Power Output Verification, A-14

TX Mask test, 4-7

TX Mask Verification, spectrum analyzer display,
illustration, 4-8

TX OUT connection, 4-3

TX Output Acceptance Tests
Code domain power, 4-6, 4-11
introduction, 4-6
Pilot Time Offset, 4-6, 4-10
Spectral purity TX mask, 4-6
Waveform quality (rho), 4-6, 4-9

TX Path, calibration, 3-69

TX path, 1-5
audit, 3-76
calibration, 3-72

U
Updating LMF Files, 5-7

UTP, LMF to BTS connection, 3-5

V
Verification of Test Equipment, data sheets, A-1

Verify Span Parameter Configuration, procedure, 5-4

Voltage Standing Wave Ratio. See VSWR

VSWR
Advantest Test Set, G-4
Calculation, G-3, G-5
Equation, G-3, G-5
manual test setup detail

Advantest illustration, G-6
HP illustration, G-3, G-4

required test equipment, G-1
transmit and receive antenna, G-1

W
Walsh channels, 4-11
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Warm-up,  1-8

Waveform Quality (rho), 4-6

Waveform Quality (rho) ATP, 4-9

When to optimize
Ancillary - table, C-1
BTS, C-1
inter-frame cabling, C-2

X
Xircom Model PE3-10B2, LMF to BTS connection,

3-5
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